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This document is provided by AOL for your information only. It may help you 
take certain steps to protect the privacy and security of your personal information 
on the Internet. This document does not, however, address all online privacy and 
security issues, nor does it represent a recommendation by AOL about what 
constitutes adequate privacy and security protection on the Internet.
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Chapter 1X

What Is AOL® Communicator?

AOL® Communicator is a set of advanced communications applications that make 
it easy to 

• Manage all your email and instant messaging easily and conveniently.

• Tune in to your favorite Radio@AOL stations and share them with your 
buddies.

• Quickly check the news, weather, and financial information that you’ve 
personalized with My AOL.

Instant Messenger™ for AOL® Communicator (page 2) 
AOL® Communicator Mail (page 3) 
AOL® Communicator Address Book (page 4) 
Radio@AOL for AOL® Communicator (page 5) 
My AOL Today for AOL® Communicator (page 5) 

If you need help with any aspect of AOL Communicator, see Getting Help With 
AOL® Communicator (page 53). 
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Instant Messenger™ for AOL® Communicator
AOL Communicator combines the AOL® Instant Messenger™ software and email 
software for added convenience. 

Your Buddy List® window shows you that new mail is waiting and links you 
directly to email messages from your friends, families, and colleagues:

Go to Mail, IM,
Address Book, Radio,

Friendly Name

Read mail from

online buddy

Read mail from

offline buddy

summarizes

unread mail

Ticker 

My AOL, My AOL Today
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There's no need to leave your Buddy List window to check for new mail. 

Note that most of the buddies are displayed by Friendly Name—that is, their first 
and last names rather than their screen names. Your Buddy List window gets this 
information from your AOL Communicator Address Book.

For example, when your AOL Communicator Address Book has an entry with the 
screen name “mr1smth”, the first and last names “John Smith”, and the email 
address “mr1smth@aol.com,” you can view that buddy by Friendly Name and 
monitor his email messages from your Buddy List window.

Your AOL Communicator Address Book is automatically synchronized with your 
AOL Address book when you first set up your AOL account. If your buddies’ 
names and email addresses are already available in your online AOL® Address 
Book, your Buddy List window will display both their Friendly Names and 
information about recently received email messages.

• Double-click the envelope icon beside a name in your Buddy List window to 
read the most recent email from that person. 

• To send email to one or more buddies, Ctrl-click their names and click the 
Email icon near the bottom of the window. 

• To list a buddy by Friendly Name and track his or her email messages from 
your Buddy List window, right click the buddy’s screen name and choose Add 
to Address Book. 

Related topics:

Installing and Setting Up AOL Communicator (page 7) 
Using Instant Messenger for AOL Communicator (page 127) 

AOL® Communicator Mail
AOL Communicator Mail lets you organize your email messages the way you 
want:

• Manage messages from all your AOL, POP, or IMAP email accounts in a single 
window. No more logging in to multiple accounts and email applications to 
check various mail accounts. 
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• Browse easily through email messages, with the ability to see text from 
individual messages displayed right alongside your message list using a 
flexible three-pane window design.

• Use state-of-the-art spam filtering to automatically sort out unwanted mail, 
displaying spam messages in a separate color for quick review and one-click 
delete. As you “train” AOL Communicator Mail regarding what you consider 
to be spam, the spam filter gets even better.

• View or save attachments you receive from others easily by clicking links or 
icons within a message. It's also easy to add attachments right inside your 
message.

• Set up filters to separate out messages from a specific sender. 

• Store messages into folders to keep them organized.

Related topics:

Getting Started With Mail (page 39) 
Using AOL Communicator Mail (page 57) 

AOL® Communicator Address Book
Keep your contact information up-to-date and at your fingertips with AOL 
Communicator Address Book integrated address book.

• Manages all your buddy info for both email and instant messaging.

• Synchronizes your contact information with your online AOL Address Book.

• Works with online directories.

Related topics:

Getting Started With Address Book (page 47) 
Using AOL Communicator Address Book (page 165) 
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Radio@AOL for AOL® Communicator 
Radio@AOL for AOL Communicator is a great new way to listen to music, no 
matter what kind of Internet connection you have. Highlights include:

• See what's playing now or what's coming soon on your favorite stations.

• Get more than 125 originally programmed AOL® stations

• CD quality sound (for broadband connections only, 128Kbps).

• Share the station you’re playing with your buddies.

Radio@AOL for AOL Communicator places today's stars and your favorite music 
styles right at your fingertips—including rock, pop, hip-hop, classical, jazz, 
country, inspirational, world music and more.

Related topic:

Using Radio@AOL for AOL Communicator (page 181) 

My AOL Today for AOL® Communicator
My AOL Today for AOL Communicator gives you two quick ways to access your 
customized My AOL information:

• My AOL Today is a screen saver that displays dynamic, full-screen, interactive 
content. You can click streaming images at any time to display more details.

• My AOL Today Ticker provides a continuous stream of up-to-date 
information across the top of your screen. You can click streaming headlines at 
any time to view the whole story.

Related topic: 

My AOL Today for AOL Communicator (page 191) 



6 AOL Communicator Help • 25 July 2003



7

Chapter 2

Installing and Setting Up AOL®

Communicator

Before you start using AOL® Communicator, you need to download the software, 
install it, and set it up:

Installing AOL Communicator (page 8) 
Setting Up Mail Accounts (page 11) 
Buddy List® Basics (page 25)
Setting Up AOL Communicator Address Book (page 29) 

Connect to the Internet first: 
AOL Communicator does not automatically connect your computer to the Internet. 
Before you install or run the program, use your AOL® client software or connection 
method provided by your Internet service provider to connect to the Internet.
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Installing AOL Communicator
Running the Setup Program (page 8) 
Documentation (page 9) 
Sharing AOL Communicator With Other Users (page 10) 
Upgrade Notifications (page 11) 

Running the Setup Program
Before you begin, make sure your computer meets the minimum system 
requirements described at AOL Keyword: AOL Communicator

To download and install AOL Communicator:

1. Log onto your current AOL client software, go to AOL Keyword AOL 
Communicator and click the button labeled Click to Download Now! 

2. Save the file ac_install.exe to any convenient location on your hard disk where 
you can find it again.

3. Double-click ac_install.exe. 

If you are installing AOL Communicator for the first time, you'll see the AOL 
Communicator Setup screens described in the steps that follow.

If an earlier version of AOL Communicator is still installed on your hard disk, 
you will first be asked if you want to upgrade it. 

4. License Agreement. Click I Agree if you agree with the terms of the license.

5. Installation Options. Leave all items selected and click Next.

6. Installation Directory. If the default location is OK with you, click Install to 
continue with the installation. 

If you want to specify a different location, click Browse, choose the location 
where you want to install AOL Communicator, click OK, and then click Install.

The Installing Files screen displays the progress of the setup program as it 
installs Communicator.
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Note: If AOL client software (such as AOL® 9.0 Optimized) is running, you 
may see a window titled “Viewpoint Media Player Uninstallation” stating that 
the installer needs to close the application waol.exe. 

If you see this message, switch to the AOL client software, open the File menu, 
and choose Exit. Wait a moment, then click Retry in the Viewpoint Media 
Player Uninstallation window. (If you have already cancelled the installation, 
run ac_install.exe again as described above starting with Step 2.)

7. Completed. If this is the first time you have installed AOL Communicator, the 
setup program closes and the Account Wizard opens. See “Setting Up Mail 
Accounts” (page 11) for instructions on what to do next.

If you are asked to restart your computer, click OK. In this case, launch AOL 
Communicator after restarting. If no accounts have been set up yet, the 
Account Setup Wizard appears when the program launches.

Related topics:

Location of Installed Files (page 259) 

Documentation
To view AOL Communicator Help while using AOL Communicator, open the Help 
menu and choose Contents & Index . 

You can also click Help buttons in any AOL Communicator window to open Help 
to relevant information.

PDF Available: To print AOL Communicator Help, follow these steps:

1. Go to AOL Keyword: AOL Communicator 

2. Click Frequently Asked Questions, then click the PDF icon labeled AOL 
Communicator Guide to download the guide.

3. Locate the PDF file that you downloaded to your hard disk.

4. Open the PDF file and print it.

Release Notes: For late-breaking information and a detailed list of known issues, 
open the Help menu and choose Release Notes.

Tutorial Movies: Open the Help menu and choose Tutorial Movies to see a list of 
tutorials. Click the icon beside each title to see step-by-step instructions on how to 
perform that task. 
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For additional information, including a FAQ, demo, and tutorials, go to AOL 
Keyword: AOL Communicator 

Sharing AOL Communicator With Other Users
When you’re using most versions of AOL software, you can sign on with only one 
screen name at a time from a single application running on one computer. In a 
family, for example, each parent and child might have a different screen name and 
log onto AOL separately to read mail and use other AOL® services.

AOL Communicator works differently. It allows you to set up multiple email 
accounts or send instant messages using any screen name. Anybody who can sit 
down at your computer and launch AOL Communicator may be able to access all 
the mail accounts that you have configured using the Account Setup Wizard, or 
use any of the Instant Messenger™ screen names for which you have saved a 
password.

Support for Multiuser Operating Systems

Like most other software programs, AOL Communicator supports the multiuser 
capabilities built into many operating systems. 

For example, if several people share a single Windows computer that is set up for 
multiple profiles, each person can maintain separate AOL Communicator 
preferences and other settings, just as for any other programs on that computer. 
Each system profile requires its own user name and password, and multiple users 
in the same family can each log on to a single computer separately.

If your computer is configured for only one systemwide profile, or if it doesn’t 
permit the use of more than one profile, then you will be able to maintain only one 
set of AOL Communicator preferences on that machine. 

Using a Master Password

You can set a Master Password that must be entered when you first launch AOL 
Communicator. For details, see “Turning on Your Master Password” (page 214). 

You can also provide limited protection for an individual account within AOL 
Communicator by turning off the “Remember password” option for that account. 
For details, see “Controlling Your Passwords” on page 217. 
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Upgrade Notifications
When a major new release of AOL Communicator is available, you’ll see an 
upgrade notice when you first launch the program.

If this happens, just click Upgrade Now to initiate the download. If you decide not 
to upgrade right away, you can change your mind and upgrade manually at any 
time. 

To upgrade manually, open the Help menu and choose Upgrade AOL 
Communicator. If the command is dimmed, so that you can’t choose it, you are 
running the most recent version available.

Setting Up Mail Accounts
The Account Setup Wizard collects the information required for a new mail 
account. It runs automatically the first time you install AOL Communicator. You 
can run it again at any time to add additional accounts.

Before You Begin (page 11)
Types of Accounts (page 12)
Starting the Account Setup Wizard (page 14) 
Setting Up an AOL Account (page 15) 
Setting Up an ISP Email Account (page 19) 

Related topics:

What to Do If You Forget Your Master Password (page 221) 

Before You Begin
Before you begin using the Account Setup Wizard, make sure you have the 
information required for the type of account you want to set up. (If you’re not sure 
what type of account to set up, see the next section, “Types of Accounts.”)

You must set up an AOL® member account before you set up any other accounts. 
To set up an AOL account, you just need your screen name and password.
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If you’re setting up a POP or IMAP account, you need more information. If 
necessary, ask your internet service provider (ISP) or your system administrator (if 
your account is provided by an organization) for the following information:

• Your user name

• Your email address

• Inbound and outbound mail server host names and passwords

You must have the above information for each ISP account you want to use with 
AOL Communicator.

Organizations with online directories: If you are setting up an account provided 
by a large organization such as a university or a corporation, ask your system 
administrator if an online directory is available. 

If a directory is available, ask the system administrator for this optional 
information, which you can specify during account setup to simplify addressing 
mail messages:

• directory server name

• directory server port number

• directory search root

Types of Accounts
AOL Communicator Mail supports three types of accounts. You should know 
which kind you want to set up before you run the Account Setup Wizard:

• AOL member account: A special type of IMAP account provided for all AOL 
members. You must have at least one AOL member account to use AOL 
Communicator.

Every AOL® screen name has a corresponding AOL® mail account. AOL 
members can have more than one AOL screen name. 

Advantages of AOL Accounts:

AOL mail accounts have advantages similar to those of IMAP accounts. 
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Because AOL mail accounts are integrated with the AOL service, they have 
special capabilities that aren’t available for other types of accounts. These 
include 

❍ The ability to check the status of a message to see whether the recipient has 
read it yet.

❍ The ability to “unsend” a message before a recipient reads it (if the 
recipient is also an AOL member)

❍ The ability to set a “Mail Away” message that’s sent automatically in 
response to messages you receive while you’re away.

• IMAP account: Allows you to store all or some of your messages on the server 
rather than your computer. 

Advantages of IMAP Accounts:

Your messages and any changes to them stay on your server, saving local disk 
space.

You always have access to an updated mailbox, and you can get your mail 
from multiple locations. 

Performance on a modem is faster, since you initially download message 
headers only.

Disadvantages of IMAP Accounts: Not all mail servers support IMAP.

• POP account: Messages must be downloaded to your computer.

Advantages of POP Accounts: 

Your messages are downloaded to your local computer all at once.

You can also specify whether to keep copies of the messages on the server and 
delete messages on the server when they are deleted locally. 

Most mail servers currently support POP.

Disadvantages of POP Accounts:

If you use more than one computer, messages might reside on one or the other, 
but not both. 

You can't access all your mail folders from multiple locations.
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Starting the Account Setup Wizard
The Account Setup Wizard launches automatically when you install AOL 
Communicator for the first time. It takes you through the consecutive windows or 
“screens” described in the sections that follow. 

After you’ve used the wizard to set up your initial account, you can run it again to 
set up additional accounts. To do so, open the Edit menu and click New Account.

Click the Next button to continue from one screen to the next.

Welcome

Use this screen to indicate whether you want to set up an AOL Member account or 
an ISP account:

• AOL Member account. AOL member accounts are provided to AOL members 
only. You must set up at least one AOL member account before you can start 
using AOL Communicator. 

Before you can set up your AOL account, you must know your AOL screen 
name and password. If you don’t, see “Contacting AOL Customer Service” 
(page 55).

If you leave this option selected and click Next, you’ll see a screen titled AOL 
Account Setup - Step 1.

• Email account with an Internet Service Provider (ISP). This option includes 
email accounts provided by an organization, an ISP, or any other email hosting 
services besides AOL. 

Before you can set up an ISP account, you should have all the information 
described in “Before You Begin” (page 11), and you must have previously set 
up an AOL member account.

If you select this option and click Next, you’ll see a screen titled ISP Email 
Account - Step 1 of 5.

For more information, see “Types of Accounts” (page 12). 

If you don’t have an AOL account or an AOL screen name, you can get one right 
away by clicking the links provided:

• Sign up with AOL! Click this to sign up for an AOL member account with full 
access to membership services, including AOL® Instant Messenger™ (AIM®) 
services. You must have at least one AOL member account before you can start 
using AOL Communicator.
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• Get a Instant Messenger screen name: Click this to sign up for an Instant 
Messenger screen name that you can use from any AIM client. As long as you 
set up at least one regular AOL member account in AOL Communicator Mail, 
you can use one or more Internet screen names with Instant Messenger™ for 
AOL® Communicator. 

Different kinds of screen names: Screen names for AOL member accounts are 
different from AIM (“Internet”) screen names:

• AOL Member: AOL member accounts have access to the entire AOL service, 
including all its features.

• AIM service: AIM screen names can be used with the AIM service, but not to 
sign onto the AOL service.

Setting Up an AOL Account
After you select AOL Member Account on the first Account Setup screen, follow 
these steps in the remaining screens to set up your AOL account.

AOL Account Setup - Step 1 (page 15) 
AOL Account Setup - Step 2 (page 16) 
Launch Options - Step 3 (page 17) 
Confirm Settings (page 18) 

Related topics:

Before You Begin (page 11) 
Starting the Account Setup Wizard (page 14) 

AOL Account Setup - Step 1

This screen collects the basic information about your account:

• Account Description: The description you want to use to identify this account, 
such as My AOL Account 

This description can be anything you want—it identifies the account in the 
main Mail window. If you leave this field blank, your screen name will be used 
to identify the account.



Setting Up Mail Accounts

16 AOL Communicator Help • 25 July 2003

• Your Name: The name you want to associate with this account. 

The name you type here will show up as the sender’s name in email messages 
you send.

• Organization/Institution: An appropriate organization name, if any, for this 
account (optional).

• Screen Name: Your AOL screen name. Type it carefully. You must type a valid 
name and password to proceed to the next screen.

If you don’t know your AOL screen name or password, see “Contacting AOL 
Customer Service” (page 55).

• Password: Your AOL password. Type it carefully. 

• Remember password. Leave this option selected if you don’t want to be 
prompted for your password every time you launch AOL Communicator.

Note: If you leave this option selected, other people with physical access to 
your computer may be able to access your AOL account.

When you click Next, the Account Setup Wizard verifies that the screen name and 
password you typed are valid. 

If you typed a valid screen name but the wrong password, you’ll see a message 
asking you to type the correct password.

If the screen name you typed doesn’t correspond to an active AOL member 
account, you’ll see a message telling you so. In this case, type your screen name 
and password again, or ask AOL Customer Service to check the status of your 
account.  

AOL Account Setup - Step 2

This screen lets you select performance-related options:

AOL Account Options:

• Make my mail in this account available offline. By default, AOL stores your 
messages on the server. If you select this option, AOL Communicator also 
stores a copy of your messages on your computer, so you can read them when 
you’re offline.

If you have a slow connection and a lot of messages stored on the server, the 
initial copying process may take a long time.
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• Check for Spam messages in this account. When this option is turned on, 
Communicator Mail downloads the content of each message to determine 
whether the message is spam. 

After a short period during which you teach Communicator Mail which 
messages it correctly marks as spam and which messages it incorrectly marks, 
the program automatically marks and sorts your spam messages for you. 

This feature is useful if you get a lot of spam messages. However, it can also 
make collecting mail noticeably slower over a slow connection.

The slowdown is proportional to the number of messages in your Inbox—the 
more you have, the longer spam filtering takes. If you typically have fewer 
than a hundred or so messages in your Inbox at a time, you probably won’t 
notice any slowdown if you select this option.

Click Next to continue.

Launch Options - Step 3

This screen appears only when you set up your first AOL member account. It 
allows you to choose which applications you want to launch automatically 
whenever you launch AOL Communicator.

Select the applications you expect to use every time:

• Mail: Organize your email accounts and messages the way you want.

• Instant Messenger: Communicate with online-buddies and check your new 
mail messages at the same time.

• My AOL: Launch your customized My AOL web page.

• Address Book: Keep your contact information up-to-date and at your 
fingertips.

• Radio: Listen to and keep track of your favorite music on Radio@AOL.

• My AOL Today Ticker: Stream your customized My AOL headlines across the 
top of your screen.

You can change these settings later if you want—just click the AOL icon in your 
system tray and choose Launch Options.

Click Next to continue.
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Confirm Settings

This screen summarizes the information that the wizard has collected about your 
new account. 

Check the summary field on the right to make sure you entered all the information 
correctly. If anything needs to be fixed, click the Back button to return to the screen 
where you entered it and make any necessary corrections.

When you are sure that everything is correct, click Complete Setup. 

AOL Communicator automatically synchronizes your new AOL Communicator 
Address Book with your AOL Address Book and collects messages for your AOL 
member account.

AOL Communicator Mail then opens, displaying the account you just created in 
the left pane. Instant Messenger for AOL Communicator also opens and attempts 
to sign on with the screen name and password you specified for your AOL account. 

AOL Communicator Mail also asks if you want to set up another account. Click Yes 
if you want to do so right away. 

You can wait if you prefer. It’s possible to add a new account at any time. To do so, 
open the Edit menu and choose New Account.

Connect to the Internet first: 
AOL Communicator does not automatically connect your computer to the Internet. 
Before you attempt to use the program, use your AOL client software or connection 
method provided by your Internet service provider to connect to the Internet.

If you can’t sign onto the AIM service: If you’ve never used AIM software before, 
or if for some reason your AIM password is not the same as your AOL member 
password, you may not be able to sign on successfully using Instant Messenger for 
AOL Communicator.

If this is the case, go to AOL Keyword: AIM Password and reset your password. 
You should then be able to sign on using the new password.
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Setting Up an ISP Email Account
After you’ve set up at least one AOL member account, you can set up mail 
accounts you may have with ISPs, institutions, and so on. To begin setting up a 
new account, follow the instructions at “Starting the Account Setup Wizard” 
(page 14). 

After you select “Email account with an Internet Service Provider” on the first 
Account Setup screen, click Next to proceed through the rest of the screens.

• These screens collect information about your ISP that you should have already 
gathered, including the names of the incoming server (for mail you receive) 
and outgoing server (for mail you send). 

• For a complete description of the information you need, see “Before You 
Begin” (page 11). If you don’t have this information, ask your ISP or check the 
ISP’s web site before attempting to set up the new account.

To finish setting up an ISP account, follow these steps in the remaining screens:

ISP Email Account - Step 1 of 5 (page 19) 
ISP Email Account - Step 2 of 5 (page 20) 
ISP Email Account- Step 3 of 5 (page 21) 
ISP Email Account - Step 4 of 5 (page 23) 
Confirm Settings - Step 5 of 5 (page 24) 

Related topics:

Importing Local Mail from Netscape® 7.0 (page 60) 
Importing Contact Information (page 165) 

ISP Email Account - Step 1 of 5

Fill in the following information:

• Account Description: The description you want to use to identify this account, 
such as Personal Account. 

This description identifies the account in the main Mail window. If you leave 
this field blank, your email address will be used to identify the account.

• Your Name: The name you want to associate with this account. 

The name you type here shows up in the list of accounts you can choose from 
when you send a mail message.
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• Email Address: The email address you use with this account. Example: 
jnm@example.net 

• Organization/Institution: An appropriate organization name, if any, for this 
account (optional).

Click Next to continue.

ISP Email Account - Step 2 of 5

Fill in the following information about the ISP server from which you collect mail: 

• Account type: Make sure the type of account you select is available from your 
mail server. For information on the differences between IMAP and POP 
accounts, see “Types of Accounts” (page 12).

ISPs almost always support POP, but not all ISPs support IMAP. If you’re not 
sure which type of account your ISP uses, check with your Internet service 
provider or system administrator.

• Inbound Host Name. The name of the server that your ISP provides to collect 
messages for this account. 

The host name must be spelled correctly or you will not be able to collect any 
messages. 

Example: pop.isp-name.net 

To specify a nonstandard port number (required by some ISPs), type a colon 
after the host name, followed by the number:

Example: pop.isp-name.net:123 

• User Name. Typically, everything to the left of the “@” sign in your email 
address. 

For example, if your email address is jnm@example.net, your user name could 
be jnm or jnm@example.net

• Password. The password for the user name specified above. Type it 
carefully—if you make a mistake, you won’t be able to collect your mail from 
this account.

• Remember password. Leave this option selected if you don’t want to be 
prompted for your password every time you launch AOL Communicator. 

Note: If you leave this option selected, other people with physical access to 
your computer may be able to access your ISP account.
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• Filter Spam: This option is on by default for POP accounts only. Leaving it on 
for a POP account does not affect performance. 

When you select this option for an IMAP account, AOL Communicator Mail 
downloads the content of each message to determine whether the message is 
spam. This is very useful if you get a lot of spam messages. However, it can 
also make collecting mail from IMAP accounts noticeably slower over a slow 
connection.

The slowdown is proportional to the number and size of messages in your 
Inbox—the more you have, the longer spam filtering takes. If you have fewer 
than a hundred or so messages in your IMAP Inbox at any given time, you 
probably won’t notice any slowdown if you select this option.

• Use a secure connection (SSL) for this mailbox (IMAP Only): A secure 
connection means that all communication between your computer and the 
mail server is encrypted. A secure connection does not protect messages sent to 
you before they reach the server. 

Not all mail servers support SSL. If you’re not sure, check with your service 
provider.

• Make my mail available offline (IMAP only): IMAP servers store your 
messages and folders on the server. If you select this option, Communicator 
also stores a copy of all your folders and messages on your computer, so you 
can read them when you’re offline.

If you have a slow connection and more than a hundred messages stored on 
the server, the initial copying process can take a long time.

Click Next to continue.

ISP Email Account- Step 3 of 5

Fill in the following information about the ISP server that sends your outgoing 
mail: 

• Outbound Host Name: The name of the server to which your outgoing 
messages will be sent. 

The host name must be spelled correctly or you will not be able to send any 
messages.

Example: smtp.isp-name.net
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To specify a nonstandard port number (required by some ISPs), type a colon 
after the host name, followed by the number:

Example: pop.isp-name.net:123 

• Use authentication when sending mail. Select this checkbox if the outbound 
host server requires name and password authentication each time you send 
mail. 

If you’re not sure, check with your ISP or system administrator.

• SMTP User: This field is required only if you select “Use authentication when 
sending mail” above.

Your SMTP user name is typically identical to the user name you specified in 
ISP Email Account - Step 2 of 5 (page 20). 

For example, if your email address is jnm@example.net, your SMTP user name 
could be jnm or jnm@example.net

• SMTP Password: The password for the SMTP user name specified above. Type 
it carefully.

If the SMTP user name is the same as the user name you specified in the ISP 
Email Account - Step 2 of 5 screen, the password will also be the same as the 
password you specified there.

• Remember SMTP password. Leave this option selected if you don’t want to be 
prompted for it. 

Note: If you leave this option selected, other people with physical access to 
your computer may be able to access your ISP account.

If you deselect this option and you selected “Use authentication when sending 
mail” above, you will be prompted for the password the first time you send 
mail after launching AOL Communicator.

• Use secure connection (SSL) when sending mail: Choose the secure 
connection (SSL) option you want from the drop-down list.

A secure connection means that all communication between your computer 
and the mail server is encrypted. A secure connection does not protect your 
outgoing messages after the server directs them to their recipients. 

Not all mail servers support secure connections. If you choose Always and the 
server doesn’t support SSL, you will not be able to send mail. If you’re not sure, 
check with your Internet service provider or system administrator, or choose 
When Available.
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Click Next to continue.

ISP Email Account - Step 4 of 5

You can use this optional screen to set up your organization's directory for use with 
this account.

If you don't want to set up a directory right now, click Next to continue. You’ll see 
the screen titled Confirm Settings - Step 5 of 5 (page 24).

If you want to set up a directory and you have your organization’s directory 
information available, read the instructions that follow.

When configured for use with an LDAP directory, AOL Communicator can fill in 
names and addresses automatically when you address a message, and you can use 
Instant Messenger software to monitor mail from anyone listed in the directory.

• For this account, use a directory for type down addressing: If your 
organization has an LDAP directory, select this option.

If you have previously configured any directories, you can select the one you 
want from the drop-down list. 

To configure a new directory, click New Directory and fill in the New Directory 
dialog box. If you aren’t sure what values to provide, check with your system 
administrator:

• Directory Name: The name you want to assign this directory in your Address 
Book. For example: Corporate Directory 

LDAP Server: The name of the server for this directory.

Port: For most directories you can leave the default value of 389. 

If you select “Use a secure connection (SSL)” below, the default value changes 
to 636.

Search Root: This important information is directory-specific. Example: 
dc=com 

Maximum Results: This setting controls the maximum number of matching 
addresses that will be displayed. 

Typing delay: This setting determines the delay between keystrokes (while 
you are addressing a message) before Mail starts looking for matches in the 
configured directory. Some people prefer a shorter delay, such as 100.
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• Use a secure connection (SSL): Select this option if you want communication 
between your computer and the directory to be encrypted. 

Not all directory servers support secure connection. If you select this option 
and the server doesn’t support SSL, you will not be able to use the directory. If 
you’re not sure, check with your system administrator.

Depending on the size of the directory involved, replication can take a long 
time.

When you have filled in the requested information, click OK. Verify that the 
directory you want to use with this account is selected from the drop down-list.

Confirm Settings - Step 5 of 5 

This screen summarizes the information that the Account Setup Wizard has 
collected about your new account. 

Check the scrolling summary field on the right to make sure you entered all the 
information correctly. If anything needs to be fixed, click the Back button to return 
to the screen where you entered it and make any necessary corrections.

When you are sure that everything is correct, click Complete Setup. 

The Mail window then appears, with the account you just created in the left pane 
(along with other accounts you have previously created). 

Connect to the Internet first: 
AOL Communicator does not automatically connect your computer to the Internet. 
Before you attempt to use the program, use your AOL client software or connection 
method provided by your Internet service provider to connect to the Internet.
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Buddy List® Basics
After you set up your first account as described in the preceding section, “Setting 
Up Mail Accounts,” the main Mail window and Instant Messenger for AOL 
Communicator open by default. (If you changed the default Launch Options, only 
the applications you selected will open.)

The instructions that follow assume that you already have an AIM screen name or 
an ICQ® number and that you’re familiar with instant messaging software:

Signing On for the First Time (page 25)
HOW IT WORKS: Friendly Names & Screen Names (page 27)
Checking Mail from Your Buddy List Window (page 28)

For information about registration, adding buddies, and other Instant Messenger 
details, see “Using Instant Messenger for AOL Communicator” (page 127).

Signing On for the First Time
By default, Instant Messenger for AOL Communicator opens and signs you on 
automatically after you finish setting up your first AOL member account.

If Instant Messenger for AOL Communicator isn’t already open, follow these steps 
from the Mail window:

1. Open the Window menu and choose Instant Messenger.

2. Enter your AIM screen name and password. (If you have an ICQ number, you 
can enter it and your ICQ password here instead.)

3. Click Sign On.

Your Buddy List window opens. 

If you can’t sign onto the AIM service: If you’ve never used Instant Messenger 
software before, or if for some reason your AIM password is not the same as your 
AOL member password, you may not be able to sign on successfully using Instant 
Messenger for AOL Communicator. 

If this is the case, go to AOL Keyword: AIM Password and reset your password. 
You should then be able to sign on using the new password.
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To sign on with a different screen name: Open the My IM menu and choose Sign 
On As a Different user.

You can use any valid screen name with Instant Messenger for AOL 
Communicator, including both AOL member screen names and Internet screen 
names, for example from the AIM service. 

Look at your Buddy List window: If you’ve used Instant Messenger software with 
this screen name before, you’ll see your current buddies listed. (If you’ve never 
used Instant Messenger software before, see “Using Instant Messenger for AOL 
Communicator” (page 127).

Some of your buddies who are listed in your AOL Address Book may already be 
listed by first and last name—or Friendly Name—since AOL Communicator 
automatically populates the AOL Communicator Address Book with the contacts 
from your AOL Address Book when you set up your first AOL account.

By default, buddies are listed by Friendly Name. If no Address Book entry is 
available, the buddy is listed by screen name. 

If a buddy’s Address Book entry includes both a Friendly Name and an email 
address, the buddy will be listed by Friendly Name and you can track their email 
messages from your Buddy List window. 

To add or edit Address Book information for an existing buddy, right-click the 
buddy name and choose Add to Address Book or Edit Contact Info

For more information on Address Book, see “Setting Up AOL Communicator 
Address Book” (page 29). 
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HOW IT WORKS: Friendly Names & Screen Names 

To display a buddy’s Friendly Name and email status in the Buddy List window, 
AOL Communicator needs to have that buddy’s name, screen name, and email 
address available in the same Address Book entry.

For example, when your AOL Communicator Address Book has an entry with 
the screen name “mr1smth”, the first and last names “John Smith”, and the email 
address “mr1smth@aol.com,” you can view that buddy by first and last name 
(“Friendly Name”) and track new messages from him in your Buddy List 
window.

Your AOL Communicator Address Book is automatically synchronized with 
your AOL Address book when you first set up your AOL account. If your 
buddies’ names and email addresses are already available in your online AOL 
Address book, your Buddy List window will display both their Friendly Names 
and information about recently received email messages.

You can easily add information for existing buddies who aren’t yet listed in your 
Address Book. Just right-click the buddy name and choose Add to Address Book.

If you set up an online directory for use from your Address Book, AOL 
Communicator can also use entries in the directory to associate information 
about a buddy’s name, screen name, and email address.
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Checking Mail from Your Buddy List Window
If any of your AOL Communicator Mail inboxes contain unread mail from buddies 
whose Friendly Names are displayed in your Buddy List window, you’ll also 
notice a small envelope icon beside those names—even if they happen to be offline: 

Offline buddies from whom you have unread mail are elevated to their normal 
place in the Buddy List window, but remain dimmed and italicized. Offline 
buddies return to the Offline list after you read their mail.

You can also Ctrl-click to select multiple buddies, then right-click to read or send 
mail and send instant messages or files to the selected buddies.

You may notice that at least some buddies are still listed by screen name. These are 
buddies that aren’t listed in AOL Communicator Address Book (including any 
corporate or institutional LDAP directory that you may have set up), or whose 
entries in Address Book don’t include the screen names in your Buddy List 
window. 

To display these buddies by Friendly Name and enable the Mail icon to show up 
beside their names when you receive mail from them, right-click each buddy name 
and choose Add to Address Book.

Double-click icon to read

Offline buddy

Send messages
to selected 

who has sent
you mail

new mail from buddy

buddies



Setting Up AOL Communicator Address Book

Chapter 2 Installing and Setting Up AOL® Communicator 29

For more information on Address Book, see “Setting Up AOL Communicator 
Address Book” (page 29). 

Setting Up AOL Communicator Address Book
To notify you when mail from your buddies arrives, AOL Communicator needs 
each buddy’s screen name, Friendly Name, and email address. 

Much of this information may be provided automatically, since AOL 
Communicator Address Book is populated with the contents of your AOL Address 
Book when you first install the program. You can also provide the information 
manually by creating Address Book entries for your buddies.

• Synchronization with the AOL Address Book (page 30). AOL Communicator 
Address Book continuously synchronizes stored contact information with the 
AOL Address Book for your screen name.

• Adding a Buddy’s Friendly Name and Email Address (page 31). If after 
synchronizing address books you still have some buddies without 
corresponding AOL Communicator Address Book entries, you can easily add 
entries for them.

• Adding a New Buddy (page 32). When you add a new buddy to your Buddy 
List window and include information about the buddy’s first and last names, 
category, and email, an Address Book entry for the buddy is automatically 
created at the same time.

You can also configure a corporate or institutional LDAP directory (for example, 
when you run the Account Wizard) to provide your buddies’ names and email 
addresses automatically. 

Related topics:

Setting Up a New Directory (page 177)
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Synchronization with the AOL Address Book
By default, AOL Communicator Address Book continuously synchronizes stored 
contact information with the AOL Address Book for your screen name. The screen 
name used for this purpose is the one you specify for the first AOL account you set 
up in AOL Communicator. 

What Address Book Synchronization Does

AOL Address Book synchronization ensures that whenever you are online and 
using AOL Communicator, the changes you make in the AOL Communicator 
Address Book are immediately copied to the AOL Address Book.

Synchronization also ensures that you can use your Buddy List window to monitor 
email messages from any of your buddies whose entries in your AOL Address 
Book include both a screen name and an email address.

Synchronization occurs when you first install AOL Communicator and every time 
you launch it. Synchronization also occurs whenever you are online and you make 
any change to your AOL Communicator Address Book, such as adding a contact or 
a group or editing an existing entry.

Your Screen Name and AOL Communicator Address Book

By default, the screen name used for synchronizing your AOL Communicator 
Address Book is the same as the screen name used for the first AOL member 
account that you set up. 

Unless you have specialized needs, you should not change the screen name used 
by AOL Communicator Address Book. 

The screen name and password specified for synchronizing your AOL 
Communicator Address Book is also used when you sign on to Radio@AOL and 
My AOL Today.

Where Synchronized Entries Are Stored

If you have been using the AOL Address Book available in some versions of AOL 
client software, the synchronized entries in your AOL Communicator Address 
Book appear in the same categories as in AOL client software (such as AOL® 9.0 
Optimized or later versions).

If AOL Communicator can’t determine which categories to use for synchronized 
entries, it places them in a category at the bottom of the list called General. To move 
such entries, simply drag and drop them over the name of the category where you 
would prefer to keep them.
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Changing Your Synchronization Settings

You can turn address book synchronization off and on. For details, see “AOL 
Synchronization Settings” (page 174). 

Adding a Buddy’s Friendly Name and Email 
Address
If a buddy’s screen name has no corresponding entry in Address Book, that buddy 
can’t be displayed by Friendly Name and you won’t be able to monitor mail from 
that buddy while you’re using your Instant Messenger software. 

To add a buddy to the Address Book from your Buddy List window:

1. Open the MyIM menu and choose “View my buddies by”.

2. Make sure Friendly Name has a checkmark beside it in the submenu. If it 
doesn’t, select it to add the checkmark.

3. Look at your Buddy List window and identify a buddy who is still listed by 
screen name rather than Friendly Name.

4. Right-click on the buddy’s name.

5. Choose “Add to Address Book”.

6. Fill in the following information:

First Name: Enter the first name that you want to be displayed in AIM as part 
of this buddy’s Friendly Name. Example: John 

Last Name: Enter the last name that you want to be displayed in AIM as part of 
this buddy’s Friendly Name. Example: Chapman 

Email: Enter the buddy’s email address. Example: jnm@example.net 

Category: Select the category from the drop down list where you want this 
information to be stored in your Address Book.

7. Click OK.

The buddy should now be listed by Friendly Name. The entry you just created 
shows up in Address Book under the category you specified. The default 
category is General.
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Adding a New Buddy
To add a buddy to your Buddy List window and AOL Communicator Address 
Book at the same time, follow these steps:

1. From the Buddy List window, open the Actions menu and choose Add Buddy.

2. Provide the following required information:

Screen Name: Enter the buddy’s screen name.

Group: From the drop-down list, select the group to which you want to add 
the buddy. If the group you want to use doesn’t exist yet, click New Group and 
type the name of the group.

3. To display the buddy’s Friendly Name and email status, provide the following 
optional Address Book information:

First Name: Enter the first name that you want to be displayed in AIM as part 
of this buddy’s Friendly Name. Example: John

Last Name: Enter the last name that you want to be displayed in AIM as part of 
this buddy’s Friendly Name. Example: Chapman

Email: Enter the buddy’s email address. Example: jnm@example.net

Category: Enter the name of the category under which you want this contact 
information to be stored in your Address Book.

4. Click OK.

The new buddy appears in the Buddy List® group that you selected (or under 
Offline if the buddy isn’t currently online). If you filled in the buddy’s name and 
email address, the buddy is listed by Friendly Name, and you can check your 
Buddy List window for recent mail from that person.

At the same time, new contact information for the buddy appears under the 
Address Book category you specified. The default category is General.

To set start taking advantage of some of Communicator’s other features, see 
“Getting Started With AOL Communicator” (page 33). 
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Chapter 3

Getting Started With AOL®

Communicator

If you followed the instructions in “Installing and Setting Up AOL® 
Communicator” (page 7), Instant Messenger™ for AOL Communicator should 
already be running. 

These sections introduce the other AOL Communicator applications and 
information about working offline:

Getting Around in AOL Communicator (page 34)
Getting Started With Mail (page 39)
Getting Started With Address Book (page 47)
Using AOL Communicator Offline (page 49)

For further assistance with Instant Messenger software, see “Using Instant 
Messenger™ for AOL® Communicator” (page 127).
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Getting Around in AOL Communicator
From the Desktop (page 34) 
From the Window Menu (page 35) 
From the Taskbar and System Tray (page 36) 
Buddy List® Mail Tracking (page 37) 
AOL Services (page 37) 

Settings & Preferences:

AOL Communicator Launch Options (page 38) 

From the Desktop
After installation, a shortcut to AOL Communicator is displayed on your desktop. 
Double-click it to open the AOL Communicator applications that are set to open 
automatically on launch: 

You can also open the Start menu, choose Programs, choose AOL Communicator, 
and select the individual AOL Communicator application you want to open.

Related topic:

AOL Communicator Launch Options (page 38) 
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From the Window Menu
Each AOL Communicator application has a Window menu to help you navigate 
within and among applications. If you have more than one window open within a 
given application, each window is listed at the bottom of the Window menu. 

For example, you can open any of the AOL Communicator applications (or your 
My AOL web page) from this Window menu in AOL Communicator Mail: 

In the middle portion of the menu, Launch Options lets you set which AOL 
Communicator applications you want to open by default, and Go to AOL 
Keyword lets you open the AOL client software on your computer (if it’s not 
already open) and go to a keyword you type.

The three items at the bottom show the currently open Mail windows. The 
checkmark indicates the currently active window.
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From the Taskbar and System Tray 
After you launch AOL Communicator, you can get to any other AOL 
Communicator application from the taskbar in the bottom left corner of your 
screen:

Click the icons to move between these AOL Communicator applications (left to 
right):

• AOL Communicator Mail

• Instant Messenger for AOL Communicator

• AOL Communicator Address Book

• Radio@AOL for AOL Communicator

• My AOL web page (displayed in your default browser)

• My AOL Today

You can select the same applications from the AOL Communicator System Tray 
icon near the bottom-right corner of your screen.

If the icon includes an envelope, as shown here, you have new mail. Click the icon 
to see the menu:

You can use the AOL Communicator System Tray icon to launch any of the 
applications listed above, plus Launch Options. 

Click this icon to open

AOL Communicator menu
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Buddy List® Mail Tracking
While you’re using Instant Messenger for AOL Communicator, you can jump 
directly to the most recently unopened message for a buddy, or select a buddy and 
open a new Write Mail window so you can send an email message to that person. 

For details, see “Checking Mail from Your Buddy List Window” (page 28).

AOL Services
If AOL software such as AOL 8.0 (or a later version) is available on your computer, 
you can open it directly from AOL Communicator. 

For example, in addition to the AOL Keyword icon described above, you can open 
the Help menu in any AOL Communicator application and choose AOL Keyword 
Services, then perform these actions from the submenu:

• KW: AOL Communicator: Choose this to go to the AOL Keyword area for 
AOL Communicator.

• KW: Voicemail: Choose this to go to the AOL Keyword area for AOL® 
Voicemail.

• Subscribe to AOL® Newsletters: Choose this to subscribe to AOL Newsletters 
that may interest you.

You can also access these AOL services from within AOL Communicator:

• Parental Controls: Parental Controls help you set limits on what your children 
can see and do while they are online, including whom your children can 
communicate with in e-mail and whether or not they can send and receive 
instant messages.

To view or change your Parental Controls from AOL Communicator Mail: 
Open the Tools menu and choose Parental Controls. 

If you have AOL software available on your computer, this will open it to your 
Parental Controls window.

• Mail Away Message: If you know you can’t answer your AOL mail messages 
for a period of time, you can set a Mail Away message that will automatically 
be sent once to each person who sends mail to your AOL account.

To set a Mail Away message for the currently selected AOL account:
Open the Tools menu and choose Set Mail Away Message. 
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If you have AOL software available on your computer, it opens to your Mail 
Away window.

• AOL Alerts: AOL® Alerts keep you instantly informed of important events 
that you specify. You can access your AOL Alerts from Instant Messenger for 
AOL Communicator:

To view your AOL Alerts: Open the MyIM menu and choose View My AOL 
Alerts. 

A window opens that allow you to view your alerts.

To manage your AOL Alerts: Open the MyIM menu and choose Manage My 
AOL Alerts.

Your default browser opens to the AOL Alerts and Reminders page. 

AOL Communicator Launch Options
AOL Communicator Launch Options control the way that AOL Communicator 
launches and whether the My AOL Today screen saver is enabled.

If you’re not already viewing the Launch Options window, right-click the AOL 
Communicator icon in the system tray and choose Launch Options.

Auto-launch applications

Select the applications you use regularly:

• Mail: Organize your email accounts and messages the way you want.

• Instant Messenger: Communicate with online-buddies and check your new 
mail messages at the same time.

• Address Book: Keep your contact information up-to-date and at your 
fingertips.

• Radio: Listen to and keep track of your favorite music on Radio@AOL.

• My AOL: Launch your customized My AOL page.

• My AOL Today Ticker: Stream your customized My AOL headlines across the 
top of your screen.
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My AOL Today

• Make My AOL Today my default system screen saver: Stream interactive, 
customized My AOL information across your screen when you’re not using it. 

Click Preview to see My AOL Today in action.

Click OK to confirm your selections.

Getting Started With Mail
These sections introduce some of the most useful features of AOL Communicator 
Mail:

Viewing Your Messages (page 39)
Reading and Organizing Mail (page 40)
Addressing and Sending Mail (page 41)
Training Your Spam Filter (page 42)
Setting Up Message Filters (page 45) 
Searching Messages (page 46) 
Using Multiple Accounts (page 46) 

Viewing Your Messages
If you’re not already viewing the AOL Communicator Mail window, open the 
Window menu from within any other AOL Communicator application and choose 
Mail. 

At least one account is listed at the upper left of the Mail window. Click the arrow 
beside the account name, if necessary, so it points down and you can see its folders.

When you click the Inbox or any other folder, you see the messages it contains 
displayed in the right column. When you click a message, its content is displayed 
in the bottom portion of the screen.

Layout Styles: If your ISP account has a lot of folders and you want more room to 
display them, open the View menu, choose Layout Styles, and choose Narrow 
Preview from the submenu.

Text Size: To increase or decrease the size in which message text is displayed, open 
the View menu, choose Text Size, and choose the size you want.
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Reading and Organizing Mail

Reading Mail
To read mail in the Mail window:

1. Locate the account whose mail you want to read in the left column. 

2. If no folders show up under the account name, click the triangle beside the 
name so it points downward, then click the folder whose messages you want to 
view. 

The messages in the selected folder are listed on the right side of the window. 

By default, Communicator Mail retrieves mail for all your accounts every ten 
minutes. For information on changing this and related options, see “Adjusting 
Check for New Mail Settings” (page 67). 

Unless you are using mail filters, new mail shows up in the Inbox for each account 
(or in New Mail for AOL accounts). Click the Read button (near the top-left corner 
of the Mail window) at any time to check mail immediately for the currently 
selected account. 

To increase or decrease the size in which message text is displayed, open the View 
menu, choose Text Size, and choose the size you want.

To print a message, select it, then click the Print icon near the top-right corner of the 
window.

Organizing Mail
It’s often convenient to organize the mail you receive into different folders.

To create a new folder:

1. Open the File menu and choose New.

2. Choose Folder from the submenu.

The New Folder dialog box appears.

3. Type the name of the folder, then use the drop-down list to specify the account 
or folder in which you want to place the new folder. Click OK to confirm your 
settings.

Note: You cannot create new folders for AOL accounts.
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To move mail in your Inbox into different folders:

• Select the messages you want to move, then drag them to the folder where you 
want to keep them.

• Select the messages you want to move, click the Move icon near the top-right of 
the Mail window, and select the folder to which you want to move them.

Related topics:

Training Your Spam Filter (page 42) 
Setting Up Message Filters (page 45)

Addressing and Sending Mail
To compose a new message, follow these steps:

1. Click the Write button near the top-left corner of the Mail window.

You’ll see an empty Write Mail window. Notice the From: field near the top of 
the window. If you have set up more than one account, select the one you want 
to send this message from by selecting it from the drop-down list.

2. Start typing a name in the To: or Cc: field. 

If you have any relevant entries in your AOL Communicator Address Book, 
you’ll see “type-down addressing” in action. 

When you stop typing for a brief interval, a list of matching names and email 
addresses appears just below the field.

3. To choose the name and address you want, click it; or use the up and down 
arrow keys to select it, then press Enter.

4. To enter more than one recipient in the To: or Cc: fields, repeat Steps 2 and 3 
above. You can use the tab key to move between fields. (Note that recipients 
listed in the same field must be separated by commas, which are inserted 
automatically.)

5. Enter any recipients whose addresses you want to keep private in the Bcc: 
(blind carbon copy) field.

6. Enter a subject and the text of your message.

7. When you’re ready to send your message, click Send.
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In addition to using type-down addressing to enter addresses for people in the 
corporate directory, you can also look up addresses in any of the other address 
books you have set up in Address Book. To do so, follow these steps:

1. Click the Address button near the top of the Write Mail window.

The Address Book opens.

2. In the left column, click the name of the category you want to search. 

To search all contacts in all categories at once, click All Contacts

3. Click in the field labeled Name or Email Contains (near the top of the window) 
and start typing the name of the person whose address you want to find.

As you type, the most closely matching names are highlighted in the right 
column.

4. When you locate the name and address you want, select it (or Ctrl-click to 
select multiple addresses) and drag it into the To or Cc field of the Write Mail 
window.

Related topics:

Changing Plain Text Settings (page 62) 
General Mail Preferences (page 74) 

Training Your Spam Filter
Many email users are frustrated by the increasing number of spam messages they 
receive—unsolicited messages that clutter their inboxes with unwanted 
advertising. 

AOL Communicator Mail automatically detects messages that appear to be spam 
so you can move them out of the way and delete them at your convenience. 

Spam filtering is turned on by default for POP accounts, and you can choose to 
turn it on while you are setting up AOL or IMAP accounts. To make sure spam 
filtering is turned on for a given account, see “Turning On Spam Filtering in AOL 
Communicator” (page 93). 
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When spam filtering is turned on, AOL Communicator Mail marks the messages it 
identifies as spam in each inbox like this:

At first, the spam filter may make some mistakes, identifying messages you want 
to keep as spam, and not marking real spam messages. 

To improve your filter’s accuracy, train it as you observe it in action: 

• One message at a time: Right-click on any message whose spam marking is 
currently wrong, and choose either Mark as Spam or Mark as Not Spam.

• Multiple messages at a time: Ctrl-click to select the messages, right-click the 
selection, and choose either Mark as Spam or Mark as Not Spam. 

To train the filter while reading a message: 

• If the message is marked as spam but shouldn’t be: Open the Spam menu and 
choose Mark as Not Spam; or click the This Is Not Spam button at the top of the 
message.

• If a message isn’t marked as spam but should be: Open the Spam menu and 
choose Mark as Not Spam; or select the message and click the Spam button 
near the top of the window: 

If you have a slow connection: When spam filtering is turned on for an AOL or 
IMAP account, AOL Communicator Mail downloads the content of each message 
in your New Mail folder (or Inbox) to determine whether the message is spam. If 
you are using a slow dialup connection, this may cause mail retrieval to seem a bit 
slow the first time.
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The slowdown is proportional to the number of messages in your Inbox—the more 
you have, the longer spam filtering takes. If you have fewer than a hundred or so 
messages in your Inbox at any given time, you probably won’t notice any 
slowdown due to spam filtering.

Related topics:

For information on turning off spam filtering for individual accounts, see “Turning 
Off Spam Filtering in AOL Communicator” (page 95). 

If you use both AOL Communicator and AOL client software (such as AOL® 9.0 
Optimized or later) to read email messages, see “Host-Based Versus Local Spam 
Filtering” (page 91). 

Viewing Spam
Messages marked as spam are marked with a special icon and color, as described in 
the preceding section. 

In addition, the special Mail Views category at the bottom of your list of accounts 
in the main Mail window lists all spam messages by account. 

When you’re viewing messages in any regular account folder, you can take these 
actions:

• To show or hide spam messages in the selected account folder: Open the 
Spam menu and select Show Spam Messages. This menu item toggles on or off 
each time you select it.

• To group all spam messages together in the folder: Click this column icon:

You may have to scroll up or down to see the spam messages grouped 
together.

Deleting Spam
Once you delete spam messages, you can’t get them back. Therefore, make sure 
messages marked as spam really are spam before deleting them. For information 
on viewing spam messages, see the preceding section.

To delete mail marked as spam from the selected folder: Open the Spam menu 
and choose Delete Spam From This Folder.
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The special Mail Views category at the bottom of your list of accounts in the main 
Mail window lists all spam messages by account. When you delete spam messages 
in one of these spam folders, the same spam messages are deleted in the 
corresponding account, and vice versa.

Setting Up Message Filters
If you get a lot of email, AOL Communicator Mail can help you keep it organized 
by automatically moving, deleting, or marking messages according to your 
message filters.

To create a simple message filter based on an email address:

1. Right-click any email address in any mail message header and choose “Create 
Filter from Message” from the pop-up menu.

2. Use the drop-down lists beside the label Perform the following action to 
choose the account and folder to which you want to move filtered messages. 
(The first drop-down list allows you to select some other action, such as 
deleting the message.)

3. Click OK.

From now on, AOL Communicator Mail automatically sorts all incoming messages 
from that email address according to the filter specifications.

To examine your existing message filters and create new ones: 

1. Starting from the AOL Communicator Mail window, open the Tools menu and 
choose Custom Message Filters, then Setup.

The Setup Custom Message Filters window appears.

From the drop-down list labeled Filters for messages on, choose the account 
that you want the filter to apply to.

2. Click New Filter.

The Custom Message Filter window appears. You can use it to name a new 
filter and construct rules for it to use:

The first row of drop-down lists specify the action the filter should take when 
the conditions specified below apply to an incoming message.

The remaining options determine the conditions that a message must meet for 
the filter to perform the specified action.
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The Add and Remove buttons add a rule to the list of conditions or delete the 
bottommost rule.

3. Click OK to confirm your new filter settings.

4. Click OK to close the list of filters.

Related topic:

Using Message Filters (page 98) 

Searching Messages
To find a message in a folder quickly: 

1. Select the folder you want to search.

2. Click in the field at the top of the Mail window labeled “Subject or Sender 
contains:”

3. Type the first few letters of the sender’s name or the subject line.

As you type, only the messages that match what you have typed so far are 
displayed.

Related topics:

Advanced Search (page 79)

Using Multiple Accounts
You must set up at least one AOL member mail account to start using AOL 
Communicator. 

To set up another account:

1. Open the Edit menu in AOL Communicator Mail.

2. Choose New Account.

The first screen of the Account Setup Wizard appears.

3. Click Next as you complete the information requested on each screen.

Repeat this process for as many accounts as you like. 
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Related topic: 

Make sure you type the information correctly for each new account. For 
background information, see “Setting Up Mail Accounts” (page 11).

Getting Started With Address Book
Before you do anything else with AOL Communicator Address Book, make sure it 
includes the Friendly Name, email address, and screen name for each of your 
buddies. This ensures that your Buddy List window can notify you when you 
receive mail from any of them. 

For details, see “Setting Up AOL Communicator Address Book” (page 29). 

The sections that follow introduce some useful Address Book features:

Working With Your Address Book (page 47)
Addressing Mail from Address Book (page 49)

Related topic: 

Using AOL Communicator Address Book (page 165) 

Working With Your Address Book
After you install AOL Communicator, the left pane of AOL Communicator 
Address Book includes these primary headings:

• All Contacts: Displays an alphabetical list of all contacts listed under different 
Categories (see below). This view of your contacts provides an easy way to see 
or search all the contacts in all your Categories at the same time.

• Categories: When you first install AOL Communicator, these standard contact 
categories are created by default (and can’t be deleted or renamed):

Friends, Family, and Co-Workers are standard categories created for your 
convenience. You can use them to keep track of addresses of buddies in the 
corresponding Instant Messenger buddy groups.

Auto-Added are addresses that Address Book adds automatically from the 
recipient list whenever you send an email.
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General is the category for contacts added during synchronization with the 
AOL Address Book that didn’t fit anywhere else.

• Groups: A group is a logical grouping of contacts. There are no default groups. 
Only groups that you create will be listed here.

• Directories: Any online directories you may have configured, such as a 
corporate phonebook, appear under this heading. Directories are an optional 
convenience. You don’t need to configure any directories to use AOL 
Communicator. 

To create a new category, group, or directory: Open the File menu, choose New, 
and select the type of contact container you want to create. 

To create a new contact: Select the category in which you want to store the new 
contact and click the New Contact button.

To import address book data: 

• From Outlook or Outlook Express: For details on how to do this quickly, see 
“Importing Contacts from Outlook or Outlook Express” (page 165). The 
imported data appears in the General category.

• From other mail applications: First export the data from that application as an 
LDIF file. Then open Address Book, open the File menu, choose Import, and 
select the LDIF file. 

When a category, group, or directory is selected, you can perform the following 
actions:

• Search (“Name or Email contains”): To locate a specific contact in the selected 
container, type the name or email address you’re looking for in the field near 
the top of the Address Book window. Only the contacts that match what you 
type will be displayed.

To search all categories at once, select All Contacts before typing your search 
information.

• Change the name or other details: Open the Edit menu and choose Rename 
Category, Edit Group, or Edit Directory. 

Note that you can’t change the names of the default categories listed above. 

• Change position in the container list: Drag the individual category, group, or 
directory you want to move to the new position and release the mouse button.

• Delete the selection: Right-click on the item and choose Delete Category, 
Delete Group, or Delete Directory.
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Addressing Mail from Address Book
To address a new email message from within Address Book, follow these steps:

1. Select a category, group, or directory in the left column.

2. Select the recipients’ names (either by Ctrl-clicking for separated entries or 
Shift-clicking for a range).

3. Click the Write Mail icon to open a Write Mail window with the selected 
names entered in the To: field.

4. To add names from a different contact container to the To field or to add names 
to the Cc field, select one or more names and drag them to the appropriate field 
in the Write Mail window.

Using AOL Communicator Offline
You can continue to use AOL Communicator even when you’re offline—that is, 
even when your computer isn’t connected to the Internet. This can be useful, for 
example, when you’re traveling or temporarily disconnected from the Internet.

There are several ways you can make your offline experience with AOL 
Communicator more convenient. The sections that follow summarize your 
offline-related options:

Going Offline (page 49) 
Storing Messages Locally (page 50) 
Using the Outbox (page 50) 
Reconnecting (page 51) 

Going Offline
When you go offline, or if your Internet connection is inadvertently lost, you will 
probably see messages about mail servers not being available, and the names of 
your accounts will change to italics to indicate that they’re not currently available 
for sending or receiving mail.

The name of an account can also change to italics if one of its servers becomes 
temporarily unavailable, even if your Internet connection is still working.
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In either case, you can continue working with an offline account if you follow the 
procedures described in the sections that follow.

Storing Messages Locally
When you set up an AOL member account or an ISP account that uses IMAP, your 
mail is stored on the server. By default, only the message headers are displayed in 
your AOL Communicator Mail inbox.

When you first set up such an account, you have the option of selecting the option 
labeled “Make my mail in this account available offline”. You can also change this 
option at any time after you set up an account.

When the “Store message locally” option is selected for an account, all the 
messages available for that account (not just the headers) are copied to the 
account’s folders on your computer, so you can read, rearrange, or delete them 
when you’re offline. When you go online again, AOL Communicator Mail 
synchronizes any changes you’ve made with the copies on the server.

Lots of messages take longer to store: If you have more than a hundred stored 
messages and a slow connection, the initial download process (after you first select 
the offline option) can take some time. 

Related topic:

You can turn the “Store messages locally” option off or on at any time after you’ve 
set up an account. For instructions, see “Storing Messages for Offline Use” 
(page 70). 

Using the Outbox
When you’re working offline and you’ve finished composing a message, you can 
store it temporarily in the Outbox under Local Mail. Just click Send as you would 
normally. You’ll see a message telling you that the message has been stored in your 
Outbox.

The next time you go online, AOL Communicator Mail asks whether you want to 
send your unsent messages. If you click Yes, all messages in the Outbox (including 
messages from several different accounts) will be sent. 

If you click No, AOL Communicator Mail will remind you again later. While 
you’re still online, you can also open the File menu at any time and choose Send 
Messages in Outbox to send the stored messages. 
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Don’t forget the Drafts folder: If you’re composing a message that you want to 
send later, but you think you might make further changes to it, click Save Draft. 
This saves the message in the Drafts folder for the account you’re sending it from. 
You can reopen messages stored in a Drafts folder at your convenience and work 
on them some more.

If you have chosen to store your AOL or IMAP messages for a given account 
locally, the contents of the Drafts folder will also be available locally when you’re 
offline.

Related topic:

You can turn the “Store messages locally” option off or on at any time after you’ve 
set up an account. For instructions, see “Storing Messages for Offline Use” 
(page 70). 

Reconnecting
When you go back online after using AOL Communicator offline, AOL 
Communicator Mail will ask if you want to send any messages you may have 
accumulated in the Outbox of your Local Mail directory. Click Yes if you want to 
send them right away, or No if you want to wait. 

If you click No, Communicator Mail will keep reminding you until you either click 
Yes or open the File menu and choose Send Messages in Outbox. 

After you go back online, the names of your accounts in the Mail window should 
no longer be in italics. If you have difficult reconnecting with one or more 
accounts—for example, if some account names remain italicized—exit the program 
and relaunch it. 

If you made any changes to any of your AOL Communicator Address Book entries 
while you were offline, the changes will automatically be synchronized with the 
AOL Address Book as soon as you go online again.

This document is provided by AOL for your information only. It may help you 
take certain steps to protect the privacy and security of your personal information 
on the Internet. This document does not, however, address all online privacy and 
security issues, nor does it represent a recommendation by AOL about what 
constitutes adequate privacy and security protection on the Internet.
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Chapter 4

Getting Help With AOL®

Communicator

Using AOL Communicator Help (page 53) 
Playing Tutorial Movies (page 54) 
Reading the Release Notes (page 54) 
Printing Help (page 54) 

Using Keyword: AOL Communicator (page 55) 
Contacting AOL Customer Service (page 55) 

Using AOL Communicator Help
To get Help while using AOL® Communicator:

• Open the Help menu and choose Contents & Index.

The Help window opens to the Contents page. Scroll through the main topics 
and click the one you want to explore. 

Every Help page includes these navigation links near the top:

❍ Contents: Return to the main list of topics.

❍ Index: See an alphabetical list of topics.

❍ Tutorial Movies: See a list of tutorial movies demonstrating simple tasks.

• Click Help buttons to get help on the window you’re viewing.

Some AOL Communicator windows, such as those for setting preferences, 
include a Help button. When you click a Help button, the Help window 
displays information about the window in which the button is located. 
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If you’re viewing subtopic details within a page, click back to top to return to the 
top of the page.

To return to the list of subtopics for a main topic, click the main topic’s link near the 
top of the page.

The Back and Forward buttons in the Help window work just as they do in a 
browser. Click them to move backwards or forwards through Help topics you’ve 
already viewed.

This PDF version of Help that you’re reading contains the same text as the online 
version. Turn to the Contents (page iii) or the Index (page 265) to locate the topic 
you want to learn about.

Playing Tutorial Movies
AOL Communicator Help includes tutorial movies that give step-by-step 
demonstrations of how to perform basic tasks. 

To see a list of the tutorial movies available, open the Help menu in any AOL 
Communicator application and choose Tutorial Movies. Or click Tutorial Movies at 
the top of any Help page.

Click the icon beside each movie title to play the movie.

Reading the Release Notes
AOL Communicator Release Notes provide late-breaking information about this 
release. 

To view the release notes, open the Help menu in any AOL Communicator 
application and choose Release Notes.

Printing Help
To print an entire Help page from within AOL Communicator, click the Print icon 
near the top of the Help window.
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To print a portion of a Help page, select the part you want to print, then click the 
Print icon.

To print the entire text of AOL Communicator Help (over 240 pages) in PDF form, 
follow these steps:

1. Go to AOL Keyword: AOL Communicator 

2. Click Frequently Asked Questions, then click the PDF icon labeled AOL 
Communicator Guide to download the guide.

3. Locate the PDF file that you downloaded to your hard disk.

4. Open the PDF file and print it.

Using Keyword: AOL Communicator
If you can’t find an answer in AOL Communicator Help or the release notes, open the 
Help menu again and choose AOL Communicator KW Services, then KW: AOL 
Communicator. 

Choosing this menu item opens the AOL client software and brings you to the 
main Keyword area for the product, where you will find additional information 
including FAQs and tutorials. 

Contacting AOL Customer Service
Before attempting to contact AOL Customer Service, open the Help menu and 
choose Contents & Index. 

That’s the quickest way to find information on most routine AOL Communicator 
tasks, like account setup or how to use different features. For details, see “Using 
AOL Communicator Help” (page 53).

If you can’t find what you’re looking for in Help, you can send an email message to 
AOL Customer Service. To do so now, click this link:

AOLCommHelp@aol.com

If you’d prefer to ask your question over the phone, AOL provides toll-free 
customer service for AOL Communicator at this number:

877-824-0224

Available 8:00 a.m. to 1:00 a.m. Eastern Time, 7 days a week. 
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Chapter 5

Using AOL® Communicator Mail

Managing Your Mail Accounts (page 58)
Reading and Storing Messages(page 65)
Searching for Messages (page 79)
Writing and Sending Messages (page 81)
Managing Your AOL Mail Messages (page 84)
Controlling Spam (page 91)
Using Message Filters (page 98)
Signing & Encrypting Messages (page 105) 
Mail Account Settings (page 111) 

Related topic:

Getting Started With Mail (page 39)
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Managing Your Mail Accounts
Setting Up a New Account (page 58) 
Importing Local Mail from Outlook or Outlook Express (page 59) 
Importing Local Mail from Netscape® 7.0 (page 60) 
Changing Plain Text Settings (page 62) 
Changing Settings for Existing Accounts (page 63) 
Deleting an Account (page 63) 
Adding or Changing an Outgoing Server (page 64) 
Changing Inbound Server Settings (page 64) 

Related topic:

Mail Account Settings (page 111)

Setting Up a New Account
To set up a new mail account:

1. Open the Edit menu in AOL® Communicator Mail.

2. Choose New Account.

The first screen of the Account Setup Wizard appears.

3. Click Next as you complete the information requested on each screen.

For more detailed information as you fill in each screen, click the Help button.

Related topics:

Step-by-step instructions:
Setting Up an AOL Account (page 15) 
Setting Up an ISP Email Account (page 19) 

If your new account doesn’t work correctly, check your settings: 
Changing Settings for Existing Accounts (page 63) 

If you can’t figure out what setting is wrong, delete the account and start over: 
Deleting an Account (page 63) 

Background information on setting up a new account: 
Setting Up Mail Accounts (page 11) 
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Importing Local Mail from Outlook or Outlook 
Express
If you have been using Outlook or Outlook Express as your primary mail client, 
you can import local mail stored with Outlook into AOL Communicator.

Before importing mail messages from Outlook:

Make sure Outlook is set as the default mail client for your system:

1. Click the Start menu, then Control Panel.

2. Double-click Internet Options.

3. Click the Programs tab.

4. Click the drop-down list beside "E-mail" and select Microsoft Outlook (if it is 
not already selected).

5. Click OK.

These steps are required for importing from Outlook only, not from Outlook 
Express. 

Before importing mail messages from Outlook Express:

• You must be using Outlook Express 5 or later. If you are using an earlier 
version, upgrade it before attempting to import your data.

Only locally stored messages from POP accounts associated with the default 
identity in Outlook Express will be imported. If you want to import data from 
another identity, first make it the default identity. 

To change the default identity in Outlook Express, open the File menu and 
choose Identities, then Manage Identities. The default identity is the one 
labeled Use this identity when a program can’t ask you to choose an identity. 

IMAP messages can't be imported. They are stored on a server, not your 
computer, and you can retrieve them simply by setting up the account in AOL 
Communicator.

• Make sure Outlook Express is installed and working correctly on your 
computer, and that the mail messages you want to import are showing up in 
the default identity.

To import stored local POP mail messages from Outlook or Outlook Express to 
AOL Communicator Mail: 

1. From the main Mail window, choose File, then Import, then Mail Messages.
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The Import Wizard opens.

2. Click the name of the mail application from which you want to import your 
local mail folders, then click Import.

If the application isn’t present in the list, it’s not yet supported. 

The application you select must be installed on your computer before you can 
import messages from it.

3. When all messages have been imported, you’ll see a list of imported folders. 
Click Return to Mail to return to the main Mail window.

You can view the imported messages in the left pane under Local Mail. For 
example, if you’ve just imported local mail messages from Outlook, an 
Outlook folder under Local Mail contains the imported folders.

Related topics:

To reset AOL Communicator Mail as your default email application, see “General 
Mail Preferences” (page 74). 

Only mail messages stored locally by the application you select are imported. To 
import contact information from Outlook and other applications, see “Importing 
Contact Information” (page 165). 

To import local mail messages from Netscape® software, see “Importing Local 
Mail from Netscape 7.0” (page 60). 

Importing Local Mail from Netscape® 7.0 
If you have been using Netscape 7.0 as your mail client, follow these steps to 
import any stored local mail from your Netscape 7.0 profile to AOL Communicator 
Mail:

1. Close all AOL Communicator windows.

2. Exit Netscape 7.0.

3. Open the My Computer icon on your desktop and navigate to the Application 
Data directory for your system user profile:

Windows 2000/XP: C:\Documents and Settings\Windows_Profile_Name\
Application Data\

Windows 98, single user: C:\Windows\Application Data\
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Windows 98, multiple users: C:\Windows\Profiles\ 
Windows_Profile_Name\Application Data\

Note: If you cannot see the Application Data directory inside your profile 
directory, open the Tools menu, choose Folder Options, click the View tab, and 
select the option labeled “Show hidden files and folders”.

4. Inside the Application Data directory, open the directory 
Mozilla\Profiles\

name_of_Netscape_profile\*.slt, 
which contains your Netscape user profile information.

5. Inside the *.slt directory, open the Mail directory. 

6. Ctrl-click all the folders in the Mail directory. While continuing to hold down 
the Ctrl key, drag and copy the folders to a convenient location on your 
desktop.

7. Close the Mail window.

8. Open each of the Netscape profile folders you copied to the desktop and delete 
all the files ending with .msf.

9. Open the My Computer icon on your desktop again and navigate to the 
Application Data directory for your system user profile, as in Step 3 above.

10. Inside the Application Data directory, open the directory AOL 
Communicator\local.

11. Open each of the Netscape profile folders you copied to the desktop and drag 
their contents into the AOL Communicator\local directory.

Warning: Files that already exist in the local directory, such as Drafts, Inbox, 
or Sent, will be replaced by copied Netscape files that have the same names. To 
avoid this, rename the files in the local directory before you begin dragging in 
the Netscape files. 

12. Launch AOL Communicator.

13. If Local Mail in the left pane of the Mail window is not already open, click its 
arrow to expand the folder.

14. Open the File menu and choose Refresh Folder List.

Your local Netscape mail folders should now be visible under Local Mail.

Related topic:

Importing Contacts from Netscape and Other Programs (page 167) 
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Changing Plain Text Settings
By default, AOL Communicator Mail sends messages in HTML format. Messages 
sent in this format allow you to use different fonts and font sizes; underline, 
boldface, or italicize text; easily create bulleted or numbered lists and links to web 
sites; and attach files.

Not all mail programs support HTML, and not all users prefer to receive 
HTML-formatted messages. Some programs display messages in HTML format as 
if they were in plain text, including HTML tags and other format coding that can 
make the original message difficult to read. 

If you are sending a message to someone who can’t read HTML-formatted 
messages (also called “rich text”), you can switch to plain text. You can also specify 
plain text only for messages sent to a specific address or domain.

Messages sent in plain text lose all formatting and attachments. Replies to (and 
forwarded) plain text messages are also sent in plain text.

To change the plain text setting while you are composing a message: 

1. Click in the message area of the Write Mail window.

2. Change the plain text setting:

❍ Click the T icon just below the Subject label to toggle the message between 
plain text and rich text formatting; or

❍ Open the Format menu and choose Rich Text or Plain Text.

When the T icon is red, the message uses rich text. When the T icon is black, the 
message uses plain text.

When you change the plain text setting from a Write Mail window, the setting 
“sticks” for all subsequent messages you write. For example, if you switch from 
rich text to plain text for one message and then open a new Write Mail window, 
that window will also be set to use plain text.

To change the plain text setting for all messages you send to an address or 
domain:

1. Open the Edit menu and choose Preferences.

2. Click Advanced Options.

3. Click Add.

4. Type the email address or domain for which you want all messages to be sent 
in plain text.
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If you specify a domain (such as example.net), you’ll have an opportunity to 
switch to plain text whenever you address a message to an email address that 
includes that domain.

5. Click OK.

Changing Settings for Existing Accounts
To edit or view the settings for one of your accounts, right-click the name of the 
account in the AOL Communicator Mail window and choose “Properties for 
account-name”.

Alternatively, follow these steps:

1. Open the Edit menu in AOL Communicator Mail.

2. Choose Account Settings.

3. Double-click the account whose settings you want to view.

Related topic:

Mail Account Settings

Deleting an Account
To delete a mail account:

1. Open the Edit menu in AOL Communicator Mail.

2. Choose Account Settings.

3. Select the account you want to delete.

4. Click Delete.

5. If you want to set up a new account, click New. Otherwise, click OK.

Related topic:

Setting Up a New Account
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Adding or Changing an Outgoing Server 
An outgoing SMTP server sends outgoing messages to their destinations. 

You can change settings for outgoing servers used with POP or IMAP accounts, 
and you can switch between servers you have already configured. 

You cannot change server settings for an AOL account.

To add or change outgoing server settings for a POP or IMAP account:

1. Right-click the name of the account in the AOL Communicator Mail window 
and choose “Properties for account-name”.

2. To edit settings for an existing server, select the one you want from the 
drop-down list and click Edit Server. 

To add a server to the list, click Add Server.

3. Fill in or modify the server settings.

If you’re not sure what settings to use, check with your service provider.

Example: imap-server.example.net 

To specify a nonstandard port number (required by some ISPs), type a colon 
after the server name, followed by the number:

Example: imap-server.example.net:123 

Related topic:

Outgoing Server Settings (IMAP & POP Accounts) (page 117) 

Changing Inbound Server Settings
An inbound server receives all the mail for an account and lets you download it to 
your computer when you want it. 

You can edit settings for inbound servers used with POP or IMAP accounts. You 
cannot change server settings for an AOL account.

To view or change outgoing server settings for a POP or IMAP account:

1. Right-click the name of the account in the AOL Communicator Mail window 
and choose “Properties for account-name”.

2. Click the Receiving Mail tab.
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3. Change host name, user name, password, or other settings as appropriate.

If you’re not sure what settings to use, check with your service provider.

Example: imap-server.example.net 

To specify a nonstandard port number (required by some ISPs), type a colon 
after the server name, followed by the number:

Example: imap-server.example.net:123 

Related topics:

Receiving Mail Tab (IMAP Account) (page 120) 
Receiving Mail Tab (POP Account) (page 122) 

Reading and Storing Messages
For an introduction to this topic, see “Getting Started With Mail” (page 39).

Getting and Reading Mail (page 66) 
Adjusting Check for New Mail Settings (page 67) 
Viewing and Sorting Your Messages (page 68) 
HOW IT WORKS: Mail Message Security (page 70) 
Storing Messages for Offline Use (page 70) 
Archiving Messages (page 72) 
Backing Up and Restoring Local Mail (page 73) 
Setting the Default Browser (page 74) 

Settings & Preferences:
General Mail Preferences (page 74)
New Folder (page 77) 
Auto-Archive Mail (page 77) 
Backup Local Mail to .zip (page 78) 
Import Mail Messages (page 78) 
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Getting and Reading Mail
By default, AOL Communicator Mail checks each new mail account for mail every 
ten minutes. You can change this setting for each account by editing the account’s 
settings. For details, see “Adjusting Check for New Mail Settings” (page 67). 

New mail normally shows up in the New Mail or Inbox folder for each account that 
you have set up. However, depending on the message filters that you may have set 
up, some mail may automatically get sorted into different folders.

To check mail immediately for all your accounts:

1. Hold the mouse button down while the pointer is over the Read button. 

A drop-down list appears. 

2. Select Read Mail from All Accounts.

To get mail for the currently selected account only:

• Click Read near the upper-left corner of the AOL Communicator Mail window.

To see the messages in an account’s Inbox or New Mail folder:

1. Locate the account’s name on the left side of the AOL Communicator Mail 
window.

2. If the triangle beside the account name is pointing right, click it so that it is 
pointing down and the account’s folders are visible.

3. Click the Inbox or New Mail folder:

The messages appear on the right side of the AOL Communicator Mail 
window. Click a message to view it in the preview pane below (if the pane is 
visible). Double-click a message to view it in its own window.

To change the layout of the AOL Communicator Mail window:

Open the View menu, choose Layout Style, and choose the type of message 
preview you want.
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Adjusting Check for New Mail Settings
By default, AOL Communicator Mail checks each new mail account for mail every 
ten minutes. You can change this setting for each account by editing the account’s 
“check for new mail” settings. 

To edit or view “check for new mail” settings for an AOL account:

1. Open the Edit menu in AOL Communicator Mail.

2. Choose Account Settings.

3. Double-click the AOL account whose settings you want to change.

4. Under Options in the Mail Settings tab, you’ll see these checkboxes:

Check for new mail on startup: Leave this option selected if you want to 
collect messages for this account automatically when you first launch Mail.

Check for new mail every __ minutes: Leave this option selected if you want 
to collect messages for this account at regular intervals. Be sure to fill in the 
interval in minutes that you want.

To edit or view “check for new mail” settings for an IMAP or POP account:

1. Open the Edit menu in AOL Communicator Mail.

2. Choose Account Settings.

3. Double-click the IMAP or POP account whose settings you want to change.

4. Click the Receiving Mail tab.

5. Under Options in the Mail Settings tab, you’ll see these checkboxes:

Check for new mail on startup: Leave this option selected if you want to 
collect messages for this account automatically when you first launch Mail.

Check for new mail every __ minutes: Leave this option selected if you want 
to collect messages for this account at regular intervals. Be sure to fill in the 
interval in minutes that you want.

Related topics:

Getting and Reading Mail (page 66) 
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Viewing and Sorting Your Messages
To sort the messages in the currently selected folder, click the top of the column by 
which you want to sort. 

These column icons have the following meanings:

You can also take these actions on columns: 

• Reverse the order in which a category is sorted:

Open the View menu, choose Sort By, and choose Ascending or Descending.

• Reorder column headings:

Click and drag a column heading to the left or right to reposition the column.

• Display more columns:

Click the arrow icon to the right of the rightmost column and select the column 
you want.

To do something to a message—such as reply, forward, move, or flag 
it—right-click the message and choose an action from the pop-up menu. 

Information about the message, such 
as whether it is marked as unread 
or marked as spam. Click this column 
heading to sort the messages by information
symbols.

Click this column heading to flag a
message, sorted by date.

Click this column heading to sort 
the messages by thread, so each 
message is grouped with all its 
responses. 

When sorted by thread, messages 
with multiple responses are marked 
with this icon in the Thread column. 
Click the arrow in the Subject column 
to show or collapse responses to that 
message.



Reading and Storing Messages

Chapter 5 Using AOL® Communicator Mail 69

To change the layout of the Mail window: Open the View menu, choose Layout 
Styles, and choose the layout you want from the submenu:

• Wide Preview: The default layout shows your list of accounts and folders, the 
contents of the selected folder, and a preview of the selected message.

• Narrow Preview: Lengthens the list of accounts and folders and displays a 
narrower message preview.

• No Preview: Hides the message preview so you see only your accounts and 
folders and the selected folder’s contents.

To print a message: Select it and click the Print icon near the top of the window.

Related topic:

For information on sorting mail into different folders, see “Organizing Mail” 
(page 40). 
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Storing Messages for Offline Use
When you set up an AOL member account or an ISP account that uses IMAP, your 
mail is stored on the server. By default, only the message headers are displayed in 
your AOL Mail inbox.

When you first set up such an account, you have the option of selecting the option 
labeled “Make my mail in this account available offline”. But you can also turn this 
option on or off for an account that’s already set up.

HOW IT WORKS: Mail Message Security

Web sites use a variety of technologies to streamline users’ surfing experience. 
For example, cookies are often used to keep track of your preferences, shopping 
cart, and so on at shopping sites, and JavaScript is often used to make web 
pages more interactive.

Email messages often include web pages that may in turn use cookies, 
JavaScript, and other web technologies. However, while such capabilities are 
useful in standalone web pages, they aren’t required in email messages, since 
you can always go to the web page itself to shop or interact with the site. 

Unfortunately, some technologies used routinely in web pages can potentially 
be used to collect information about you when they are included in email 
messages.

Communicator automatically disables web technologies in all email messages 
that you receive, including cookies, JavaScript, Java, Active X, VBScript, and 
plugins, because these technologies may be used to transport email-borne 
viruses. It also disables images in email messages that are marked as spam.

As a result, Communicator helps users avoid many of the potential privacy and 
security problems associated with email messages.

Virus checking: Files attached to messages sent to and from AOL accounts are 
automatically checked for viruses by the AOL service. If a virus is discovered, 
AOL attempts to repair it. If the repair is successful, both the sender and the 
recipient are notified. If the message can’t be repaired, the message is not sent 
and the sender is notified. The sender and the recipient are also notified if for 
some reason an AOL message’s attachments cannot be checked for viruses. 
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To view or change your current offline options, follow these steps:

1. From any Communicator Mail window, open the Edit menu and choose 
Account Settings.

2. Double-click the name of the account (either an AOL member account or an 
ISP account that uses IMAP) whose offline setting you want to view or change. 

The offline setting is not relevant for ISP accounts that use POP, since POP 
messages are always downloaded to your computer in their entirety.

3. This step varies depending what kind of account you’re viewing:

AOL Account: Click the Options tab and locate the checkbox labeled “Store 
messages locally for offline computing” (in the top part of the window). This 
option should be selected if you want AOL Communicator Mail to download 
all the messages stored in this account to your computer.

ISP Account (with IMAP server): Click the Receiving Mail tab and locate the 
checkbox labeled “Store messages locally for offline computing” (in the 
Options area, near the bottom). 

In either case, the offline option should be selected if you want AOL 
Communicator Mail to download all the messages stored in the account to 
your computer.

4. Click OK to confirm your choice.

5. Click OK in the Account Settings window.

Lots of messages take longer to store: If you have more than a hundred messages 
and a slow connection, the initial download process can take some time.

Once the initial download is completed, Communicator Mail keeps the online and 
offline copies of your messages synchronized whenever you’re online. 

When you’re offline, you can browse through or rearrange any of the messages 
with the assurance that your changes will be reflected on the server the next time 
you go online.

Related topics:

Using AOL Communicator Offline (page 49) 
Archiving Messages (page 72) 
HOW IT WORKS: Passwords & Local Mail (page 220) 
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Archiving Messages
You can set up mail archiving for any of your mail accounts. 

Archiving messages is different from storing messages for offline use:

• Archiving an account’s messages places a copy of every message you send 
from or receive in that account on your hard disk in a special folder that shows 
up under Local Mail in the main Mail window. You can archive any kind of 
account, including POP.

• Storing messages for offline use causes messages in an IMAP or AOL account 
to be available in their normal folders even when you’re not connected to the 
Internet.

To turn on mail archiving for some or all of your accounts:

1. Open the Tools menu and choose Auto-Archive Mail.

2. Select one of these mail archive settings:

All accounts: Archive all sent and received messages for all accounts.

No accounts: Don’t archive any messages.

Archive mail only for the selected accounts: Archive sent and received 
messages for some but not all of your accounts. 

If you choose this setting, click to select or deselect each account as 
appropriate.

3. Click OK.

You can find the archived messages for each account under Local Mail on the left 
side of the main Mail window.

Related topics: 

Storing Messages for Offline Use (page 70) 
HOW IT WORKS: Passwords & Local Mail (page 220) 
Backing Up and Restoring Local Mail (page 73) 
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Backing Up and Restoring Local Mail
In addition to archiving mail for an account, you can back up any Local Mail folder 
as a .zip file, or restore any Local Mail folder that you previously backed up.

This feature can be useful if you want to preserve backups of your mail on a 
separate drive or transfer your Local Mail folders from one computer to another.

To back up any Local Mail folder:

1. Right-click the folder you want to back up.

2. Choose “Backup to .zip”.

3. In the “Backup Local Mail to .zip” window, confirm that the selected folder is 
the one you want to back up. If it isn’t, use the drop-down list to change the 
selection.

4. Confirm that you want any subfolders to be backed up as well (this is the 
default setting).

5. Click Continue.

6. Type a name for the backup folder and select the directory where you want it 
to be saved.

7. Click Save.

If you are backing up a lot of messages, the progress of the backup is indicated 
in the status bar near the bottom of the Mail window.

8. If you are backing up an archive folder, you will be asked if you want to delete 
the messages from the archive, since you just created a backup. 

If you’re backing up a Local Mail folder that’s not an archive, you won’t be 
asked this question, and your original messages in the folder will be preserved.

To restore a .zip file containing one or more backed up Local Mail folders:

1. Open the Tools menu and choose Restore a Backup.

2. Locate the .zip file you want to restore, select it, and click Open.

If you haven’t previously restored any backups, a new folder called Restored 
Backups appears under Local Mail. 

The folders and messages from the backup appear (sorted by backup date) 
under Restored Backups.
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Related topic:

Archiving Messages (page 72) 

Setting the Default Browser
When someone sends you a mail message (or instant message) that includes a link 
(for example, the location of a web page), clicking the link should launch the 
default browser for the computer you’re using and open the web page or other 
information that the link points to.

If you haven’t set the default browser for your computer, clicking links won’t 
work. Instead, you’ll see a message asking you to set your default browser.

Most browser software running on Windows provides a way to make that browser 
the default. Launch the browser you want to set as the default, then follow the 
instructions provided here (or equivalent for other browsers).

To set Netscape 7 as the default browser: 

1. Open the Edit menu and choose Preferences.

2. Click Navigator.

3. Click Set Default Browser.

To set Internet Explorer as the default browser: 

1. Open the Tools menu and choose Internet Options.

2. Click the Programs tab.

3. Click the Reset Web Settings button.

General Mail Preferences
The Preferences window allows you to control general settings that apply to the 
entire AOL Communicator Mail application.

If you aren’t already viewing the Preferences window, open the Edit menu and 
choose Preferences.
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Click to turn these settings off or on:

• Use AOL Communicator as my system’s default mail client: If this setting is 
selected, your system will use AOL Communicator as the default mail client 
software. For example, when you Send Page by E-Mail from Internet Explorer, 
AOL Communicator Mail launches and a Write Mail window opens.

• Show Mail Start Page: By default, the preview pane at the bottom of the Mail 
window displays the main AOL® Search page when you first start the 
program, or when an AOL account folder (rather than a folder within the 
account) is selected. To start up with a blank preview pane instead, deselect 
this option.

Display a confirmation when: These settings control whether you see a 
confirmation message after these actions occur.

• Mail has been sent. If this option is selected, you’ll see a confirmation message 
every time you successfully send a message.

• Mail has been marked to send later. If this option is selected, you’ll see a 
confirmation message every time you choose Send while you’re offline (or 
Send Later at any time) and the message is moved to the Outbox for later 
delivery.

• Emptying trash. If this option is selected, you’ll see a confirmation each time 
you empty the trash for one of your accounts.

When new mail arrives: By default, AOL Communicator Mail plays a sound each 
time a new message arrives in any of your accounts. 

To turn off the default sound, click the Play a sound checkbox to deselect it.

To select a different sound, leave the checkbox and first radio button selected, click 
the arrow beside the name of the current sound, and choose the one you want from 
the drop-down list.

To use a custom sound file on your hard disk, click the second radio button, click 
the Browse button, select the sound file you want to play when a new message 
arrives, and click Open.

Writing mail: These settings control the Write Mail window settings for composing 
a new message.

• Default font for new messages: Select the font you want to use for composing 
messages from the drop-down list.
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• Use rich text for new messages: Select this option to make all new text 
messages use rich text by default. 

Regardless of whether this option is selected, you can still change the setting 
for individual messages manually.

• Auto-add addresses to my address book when I write mail: By default, email 
addresses of recipients in any messages you send are added automatically to 
your “Auto-Added” category in AOL Communicator Address Book. 

After an address is auto-added, Mail can use it for “type-down” addressing. In 
addition, messages from addresses that have been auto-added will not be 
marked as spam (unless you change your spam setting for messages from 
people in your Address Book; for details, see “Spam Filter Settings” on 
page 97).

To stop auto-adding addresses for recipients of your mail messages, deselect 
this option.

• Perform a spell check before sending mail. If this option is selected, AOL 
Communicator Mail runs the spell checker automatically when you click Send. 
If the spell checker finds any errors, it gives you a chance to fix them before the 
message gets sent.

• Manage Plain Text Domains: Click this button to specify the email addresses 
or domains for which you want messages to be sent as plain text rather than 
HTML-formatted “rich text.”

Click OK to confirm your choices.

Related topic: 

Changing Plain Text Settings (page 62) 
Spam Filter Settings (page 97) 
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New Folder
The New Folder window allows you to create a new folder for any of your ISP mail 
accounts. 

If you are not already viewing it, open the File menu in Mail and choose New, then 
choose Folder from the submenu. 

• Name: Type the name for your new folder.

• Create as subfolder of: Use the drop-down list to select the account (and if 
necessary a folder within the account) in which you want to create your new 
folder.

Auto-Archive Mail
When you set up archiving for a mail account, copies of all messages sent and 
received by that account are automatically saved under Archives on your 
computer.

If you’re not already viewing the Auto-Archive Mail window, open the Tools 
menu and choose Auto-Archive Mail. 

Select one of these mail archive settings:

• All accounts: Archive all sent and received messages for all accounts.

• No accounts: Don’t archive any messages.

• Archive mail only for the selected accounts: Archive sent and received 
messages for some but not all of your accounts. 

Click to select or deselect each account as appropriate.

Related topic: 

Storing Messages for Offline Use (page 70) 
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Backup Local Mail to .zip
If you’re not already viewing the Backup Local Mail window, right-click the folder 
you want to back up and choose “Backup to .zip”.

You use this window to confirm what you want to back up:

• Select a folder to back up: Confirm that the folder displayed is the one you 
want to back up. If not, click the down arrow and choose the folder you want 
from the drop-down list.

• Include subfolders: This option is selected by default, which means that all 
subfolders within the selected folder will also be backed up. To back up just the 
top-level folder, deselect this option.

After you’ve confirmed your backup settings, click Continue.

Related topic:

Backing Up and Restoring Local Mail (page 73) 

Import Mail Messages
The Import Mail Messages window lets you select an application from which to 
import stored mail messages. To view this window, open the File menu and choose 
Import, then Mail Messages.

The application you select must be installed on your computer before you can 
import messages from it. 

If you’re importing from Outlook or Outlook Express, see “Importing Local Mail 
from Outlook or Outlook Express” (page 59) before proceeding.

Click Import to begin the import process. The status bar near the bottom of the 
main Mail window displays progress. 

When all messages have been imported, a message appears explaining which 
folders have been imported and where they are located.

To view your imported messages, look under Local Mail for the name of the 
application you were importing from.
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Related topics:

Only mail messages stored locally by the application you select are imported. To 
import contact information from Outlook and other applications, see “Importing 
Contact Information” (page 165). 

To import local mail messages from Netscape software, see “Importing Local Mail 
from Netscape 7.0” (page 60). 

Searching for Messages
To find a message in a folder quickly, select the folder and type the first few letters 
of the sender’s name or the subject line in the field at the top of the Mail window 
labeled “Subject or Sender contains:”. 

As you type, only the messages that match what you have typed so far are 
displayed.

You can also perform a more advanced search within a folder or within an entire 
account, as described in the next section.

Advanced Search
Advanced Search allows you to search using a combination of search rules within a 
folder or within an entire account. 

If you are not already viewing Advanced Search, click the Advanced button near 
the top of the Mail window. You can perform these actions:

• Find messages in: Select the account or folder whose messages you want to 
search.

Note: Advanced Search does not work for AOL accounts. It does work for all 
other types of accounts.

• Search Subfolders: Select this option to search all levels of folders within the 
selected account or folder. 
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• Matching rule: Select one of the following options:

Match all of the following: Only messages that satisfy every rule listed in this 
window will be listed in the search results.

Match any of the following: Messages that satisfy any one of the specified 
rules will be listed in the search results.

• Search rules: Use the area below the matching rule options to specify the 
search rules:

From the leftmost drop-down list, select the part of each message you want to 
search. 

For example, if you choose “recipient,” the To, Cc, and Bcc fields of messages 
in the selected account or folder will be searched. If you choose “body,” the 
body of the messages will also be searched.

From the next drop-down list to the right, select the kind of comparison you 
want the search to perform against the message field you just selected.

In the text field to the right of the drop-down lists, type the text you want to 
search for in the specified message field.

Click Add to display another search rule for this filter. Additional search rules 
will be considered according to the matching rule you selected above. 

To eliminate the bottommost rule, click Remove.

When you are satisfied with your search rules, click Go to initiate the search. 

When you click Go, the Results Found area opens up at the bottom of the window 
to display the messages that meet your search rules. Select a message and click 
Open to view it, File to move it to a different location, or Delete to remove it from 
the account or folder.

Adjust your criteria if necessary to refine the search further. To clear the Advanced 
dialog and start over again, click New Search.
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Writing and Sending Messages
Attaching Files to a Mail Message
Spell Checking a Mail Message
Sending Blind Copies
Storing Messages to Send Later
Saving a Draft

Related topics:

For an overview of basic mail tasks, see Addressing and Sending Mail (page 41).

Attaching Files to a Mail Message
To drag and drop a file into a Write Mail window:

1. Locate the file(s) on your desktop.

2. Drag the file(s) into the Write Mail window.

3. When the pointer is located at the location in the body of the message where 
you want the attachment to appear, release the mouse button.

If the file is a GIF, JPEG, or other common image format, the image will appear 
in your message where you dropped the file.

If the file can’t be displayed, a link will appear where you dropped it. The 
recipient can click this link to open or save the file.

To attach a file from within the Write Mail window:

1. Click at the point in the message where you want the attachment to appear.

2. Click the Attach icon near the top of the Write Mail window:

3. Use the Open Attachment window to navigate to the file.
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4. Select the file and click Open.

If the file is a GIF, JPEG, or other common image format, the image will appear 
in your message where you clicked in Step 1.

If the file can’t be displayed, a link will appear where you clicked in Step 1. The 
recipient can click this link to open or save the file.

Related topic:

Addressing and Sending Mail (page 41) 

Spell Checking a Mail Message
When you’re using the Write Mail window to compose an email message, you can 
check the spelling of your message at any time:

1. Click the Spelling button on the toolbar, or open the Options menu and choose 
Check Spelling.

2. Use the Check Spelling window to correct misspellings and to edit or add 
words to the current spelling User Dictionary. Click Close when you are 
finished.

Check Word: Click to check the spelling of any word you type in the “Change 
to” field.

Ignore and Ignore All: Click to continue checking without changing the word, 
or without changing all occurrences of the word.

Change and Change All: Click to replace the word, or to replace all 
occurrences of the word.

Add Word: Click to add the word to your Personal Dictionary, so that Mail 
recognizes the word instead of highlighting it as a misspelled word.

Edit: Click to add, replace, and remove words from the User Dictionary.

Language: Choose the language that you want the spell checker to use.

Recheck: Click to reset the spell checker and recheck words. This is useful if 
you switch languages and then want to recheck the message's spelling.

Related topic:

Addressing and Sending Mail (page 41) 
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Sending Blind Copies
A Bcc or “blind” copy of a mail message is one that is sent without adding the 
recipient to the list that’s visible to other recipients.

To add one or more Bcc recipients to a mail message that you’re writing:

1. If the Bcc field (just above the Subject field) near the top of the Write Mail 
window isn’t already visible, open the View menu and choose Bcc Address 
Field.

2. Type the addresses to which you want to send a blind copy in the Bcc field.

When you send the message, a blind copy will be sent to the addresses you 
type here.

Related topic:

Addressing and Sending Mail (page 41) 

Storing Messages to Send Later
When you’ve finished composing a message while you’re offline, you can store it 
temporarily in the Outbox under Local Mail. To do so, open the File menu in the 
Write Message window and choose Send, just as you would normally. (You can 
also choose Send Later to accomplish the same thing, even if you’re online.)

The next time you go online, AOL Communicator Mail asks you whether you want 
to send your unsent messages. If you click Yes, all messages in the Outbox 
(potentially including messages from several different accounts) will be sent. 

If you click No, you’ll be reminded again later. While you’re online, you can also 
open the File menu at any time and choose Send Messages in Outbox to send the 
stored messages. 

Related topic:

Using AOL Communicator Offline (page 49) 
Saving a Draft (page 84) 
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Saving a Draft
If you’re composing a message that you want to send later, but you think you 
might make further changes, click Save Draft. This saves the message in the Drafts 
folder for the account you’re sending it from. 

Draft of messages sent from an AOL account are stored in the Drafts folder under 
Local Mail.

To reopen a draft message and continue your work, open the Drafts folder where 
you saved it and double-click the message. You can keep saving and opening the 
draft as you keep working on it. When it’s ready to send, click the Send button.

Managing Your AOL Mail Messages
Account Style Options and Message Retention 
Switching Between AOL Classic and Internet Mail 
AOL Mail Expiration and AOL Communicator 
Moving AOL Mail Messages 
Changing Your AOL Mail Expiration Setting 
Setting a Mail Away Message 
Checking the Status of AOL Mail 
Unsending AOL Mail 
Permanently Deleting AOL Mail Messages 

Account Style Options and Message Retention
There are two ways to view your AOL Mail. In the default account style, called 
AOL Classic, these folders are listed under your AOL account in AOL 
Communicator:

• New Mail: New, unread mail (same as New Mail tab in AOL client software). 

Each new message is displayed in boldface with an orange icon beside it. 

After you read a message, the orange icon disappears and the message header 
is displayed in plain text rather than boldface. It is now considered “Old Mail,” 
but remains in the New Mail folder until the next time you click the Read 
button to collect your mail. 
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When you click the Read button, all read messages in the New Mail folder are 
moved to the Old Mail folder—unless they have been marked Keep as New.

About Keep as New: When you select a message that you’ve already read and 
click the Keep New button (or open the Message menu and choose Keep as 
New), it is marked with the orange icon and stored in the New Mail folder. The 
message header remains in plain text, not boldface. Only unread mail is 
boldface in an AOL account.

New Mail (including messages marked Keep as New) is retained for 27 days. 

• Old Mail: Mail that you have read (same as Old Mail tab in AOL client 
software). 

Each old mail message is displayed in plain text, rather than boldface, and has 
no orange icon. If you select an old messages and click Keep New (see above), 
the orange icon reappears and the message moves to the New Mail folder the 
next time you read your AOL mail. The header remains in plain text rather 
than boldface.

By default, Old Mail is retained for 3 days. You can increase this to 7 days if 
you want. For details, see “Changing Your AOL Mail Expiration Setting” 
(page 88). 

• Sent Mail: Mail that you’ve sent (same as Sent Mail tab in AOL client 
software).

Sent Mail is retained for 27 days. 

• Recently Deleted: Mail that you’ve recently deleted (same as Recently Deleted 
tab in AOL client software).

Recently Deleted mail is retained for 24 hours. 

You use the Options tab under Account Settings to change from the AOL Classic 
style to the Internet Mail style. In the Internet Mail style, these folders are listed 
under your AOL account: 

• Inbox: Both your new, unread mail (New Mail) and the mail you have read 
(Old Mail). 

The Inbox displays messages the same way as in AOL Classic style: New Mail 
is boldface with a orange icon, Old Mail is plain text with no orange icon, and 
mail marked Keep as New is plain text with an orange icon.

• Sent: Mail that you’ve sent. 

• Recently Deleted: Mail that you’ve recently deleted. 
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Mail retention times are identical no matter which account style you are using.

Related topics:

Archiving Messages (page 72) 
Switching Between AOL Classic and Internet Mail (page 86) 
AOL Mail Expiration and AOL Communicator (page 86) 
Changing Your AOL Mail Expiration Setting (page 88) 

Switching Between AOL Classic and Internet 
Mail
There are two ways to view your AOL Mail: AOL Classic and Internet Mail.

To switch between these two account styles: 

1. Open the Edit menu and choose Account Settings.

2. Double-click the name of the AOL account whose style you want to change.

3. Click the Options tab.

4. Under Account Style, click the option you want.

5. Click OK.

Related topics:

Account Style Options and Message Retention(page 84)

AOL Mail Expiration and AOL Communicator
AOL client software lists AOL mail messages that you have read under the Old 
Mail tab and stores them for 3 days before deleting them.

AOL client software stores messages that you’ve sent under the Sent Mail tab, and 
messages that you haven’t read under the New Mail tab. Sent and New messages 
are saved for 27 days.

In AOL Communicator Mail, the default account style allows you to view the 
contents of your New Mail and Old Mail tabs in separate folders. Alternatively, 
you can change your account style to display both New Mail and Old Mail in the 
same folder.
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For short-term storage, you can mark messages unread to ensure that they are 
stored for up to 27 days.

To mark a message unread (same as “Keep as New”): Select the message, then 
open the Message menu and choose Mark As Unread.

To save AOL mail messages permanently: In the AOL client, you can use your 
Personal File Cabinet to save messages for longer than 27 days. 

Your Personal Filing Cabinet is not accessible from AOL Communicator Mail. To 
save local copies of any messages, including AOL messages, drag them to folders 
in your Local Mail directory. For details, see “Moving AOL Mail Messages” 
(page 87).

To change your Old Mail expiration setting: You can increase the Old Mail 
expiration period from 3 days to 7 days. For details, see “Changing Your AOL Mail 
Expiration Setting” (page 88).

Related topics:

Account Style Options and Message Retention (page 84) 
Archiving Messages (page 72) 

Moving AOL Mail Messages
You can easily create local copies of all sent and received messages for an AOL 
account by turning on mail archiving for that account. For instructions, see 
“Archiving Messages” (page 72).

You can also move AOL messages from folders under the AOL account to folders 
under any other account, including the Local Mail storage folder, POP account 
folders, or IMAP account folders.

To create a folder in the Local Mail directory:

1. On the left side of the AOL Communicator Mail window, select Local Mail.

2. If you can’t see the folders inside Local Mail, click its triangle to open it.

3. Open the File menu, then choose New, then Folder.

4. Type a name for the folder you wish to create, such as “Old AOL Mail”.

5. Make sure “Create as subfolder of” is set to Local Mail, and click OK.

Your new folder appears under Local Mail.

To move AOL mail messages:
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1. On the left side of the AOL Communicator Mail window, make sure Local Mail 
is open, so you can see the folder you created for copies of your AOL messages.

2. Identify the AOL mail account whose messages you want to move.

3. If you can’t see the folders inside the AOL mail account, click its triangle to 
open it.

4. Click the AOL mail folder containing the messages you want to move.

5. Select the messages you want to move.

Shift-click to select messages next to each other, or Ctrl-click to select separate 
messages.

6. Right-click the one of the selected messages

7. Choose “Move to” or “Copy to” from the pop-up menu. 

8. Choose the destination folder you want from the submenus.

Changing Your AOL Mail Expiration Setting
By default, AOL client software lists AOL mail messages that you have read under 
the Old Mail tab and stores them for 3 days before deleting them.

You can change the storage period for old mail if you want to. The minimum is 1 
day and the maximum is 7 days. Follow these steps:

1. From the main AOL Communicator Mail window, open the Edit menu and 
choose Account Settings.

2. Double-click the name of the AOL account for which you want to change the 
mail expiration setting.

3. Click Options.

4. Locate the option about halfway down labeled “Keep my old mail online __ 
days after I read it.” 

If you haven’t changed this setting before, the number of days is set to 3.

5. Click the drop-down list beside the number field to select the value you want.

6. Click OK to confirm the new setting.

7. Click OK to close Account Settings.
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Related topic:

AOL Mail Expiration and AOL Communicator (page 86) 
Account Style Options and Message Retention (page 84) 

Setting a Mail Away Message
If you know you can’t answer your AOL mail messages for a period of time, you 
can set a Mail Away message that will automatically be sent once to each person 
who sends mail to your AOL account.

To set a mail away message:

1. Open the Edit menu and choose Account Settings.

2. Double-click the name of the AOL account for which you want to set an away 
message.

3. Click the Mail Away Message link near the bottom of the window.

If it isn’t already open, the AOL software on your computer launches. If you 
haven’t stored your screen name and password, you will need to sign on. 

The Mail Away Message window opens inside the AOL software.

4. Under My Mail Away Message Is, Click On.

5. Under My Mail Away Message Says, click the option you want:

Hello, I am unavailable to read your message at this time: This message will 
be sent once to each person who sends you mail until you turn it off manually 
in this window.

Hello, I am away until: This message will be sent once to each person who 
sends you mail until the date you select.

6. Click OK.

Checking the Status of AOL Mail
When you send a mail message from one AOL account to any other AOL account, 
you and all the recipients of the message can check its status to see who has read it. 

This feature only works between AOL accounts; you can’t use it for mail sent from 
a non-AOL account, or from an AOL account to a non-AOL account.
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To check AOL message status:

1. Open the Sent folder for the AOL account from which you sent the message.

2. Select the message whose status you want to check.

3. Open the View menu and choose Message Status.

4. Click OK.

Unsending AOL Mail
When you send a mail message from one AOL account to any other AOL account, 
you can choose to “unsend” the message if the recipient hasn’t read it yet. 

This feature only works between AOL accounts; you can’t use it for mail sent from 
a non-AOL account, or from an AOL account to a non-AOL account.

To unsend an AOL message, follow these steps:

1. Open the Sent folder for the AOL account from which you sent the message.

2. Select the message you want to unsend.

3. Click the Unsend button near the top of the Mail window.

If the message has already been read, or if it was send to a non-AOL account, an 
error message appears informing you that the message can’t be unsent.

If Unsend is successful, you’ll see a message that tells you so. 

Permanently Deleting AOL Mail Messages
When you delete an AOL Mail message by clicking the Delete button or pressing 
the Delete key, the message is stored in the Recently Deleted folder for 24 hours.

To permanently delete messages in the Recently Deleted folder:

1. Select the messages you want to delete.

2. Click the Permanently Delete button, or right-click and choose Permanently 
Delete.

After you permanently delete a message, it is no longer stored by the AOL service 
and cannot be retrieved. 
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Controlling Spam
AOL Communicator Mail provides an easy way for you to filter spam messages 
from your inboxes as they arrive. For a quick introduction, see “Training Your 
Spam Filter” (page 42).

Spam filtering is turned on by default for POP accounts only. You can turn it on for 
other types of accounts at any time.

The following sections provide more information about controlling spam:

• Host-Based Versus Local Spam Filtering (page 91): How to get the most out of 
spam filtering when you’re using both AOL® 9.0 Optimized and AOL 
Communicator.

• Turning On Spam Filtering in AOL Communicator (page 93): How to turn on 
spam filtering, either for all accounts or for selected accounts.

• Turning Off Spam Filtering in AOL 9.0 Optimized (page 94): How to turn off 
Spam filtering in AOL 9.0 Optimized (for example, to take full advantage of 
AOL Communicator spam filtering)

• Turning Off Spam Filtering in AOL Communicator (page 95): How to turn 
off spam filtering, either for all accounts or for selected accounts.

• Reporting Spam to AOL (page 95): How to report spam messages received by 
any of your AOL accounts to AOL.

• HOW IT WORKS: Spam Filtering (page 96): An overview of the methods 
used by Mail to filter spam.

• Spam Filter Settings (page 97): How to use the Spam Filter window.

Host-Based Versus Local Spam Filtering
AOL client software (AOL 9.0 Optimized and later versions) uses host-based spam 
filtering: 

• A server within the AOL service maintains information about what kinds of 
messages you consider spam. 

• Works equally well no matter what computer you sign on from.
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AOL Communicator uses local spam filtering: 

• Your own computer maintains information about what kinds of messages you 
consider spam. 

• Works for multiple AOL and non-AOL accounts simultaneously

If you want to filter out spam and you want to use both AOL Communicator and 
AOL 9.0 Optimized, choose one of the following two approaches:

1. Turn spam filtering off in AOL 9.0 Optimized and on in AOL 
Communicator:

When you check your mail with AOL Communicator, all spam messages will 
be filtered for all your accounts (not just your AOL account), and the spam 
filter will get better as you use it. 

If you always use AOL Communicator on the same computer, the spam filter 
will work at maximum efficiency. 

When you check your mail with AOL 9.0 Optimized, new spam messages will 
not be filtered. You’ll have to wait until you read your mail with AOL 
Communicator for filtering to occur.

AOL 9.0 Optimized Mail and Spam Controls 

Instructions:

Turning Off Spam Filtering in AOL 9.0 Optimized (page 94) 
Turning On Spam Filtering in AOL Communicator (page 93) 

OR

2. Turn spam filtering on in both AOL 9.0 Optimized and AOL Communicator:

When you first launch AOL Communicator, you’ll be warned if any unread 
spam messages are present in your Spam folder in AOL 9.0 Optimized. Check 
your Spam folder in AOL 9.0 Optimized to make sure you agree with the spam 
filter’s decisions.

Your AOL Communicator spam filter will get better as you use it, but 
improvement may occur slowly. 

When you check your mail with AOL 9.0 Optimized, new spam messages will 
be filtered only for the single AOL account you’re using, and improvement 
may occur slowly.
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Instructions:

Turning On Spam Filtering in AOL Communicator (page 93) 

Spam filtering is turned on by default in AOL 9.0 Optimized (and later 
versions). To view or change the setting, click Mail and Spam Controls or go to 
AOL Keyword: Mail Controls. 

Turning On Spam Filtering in AOL 
Communicator
By default, spam filtering is turned on for POP accounts and off for IMAP and AOL 
accounts. 

To turn on spam filtering for any account:

1. From the main AOL Communicator Mail window, open the Spam menu and 
choose Spam Filter.

2. If you want to turn spam filtering on for all accounts, click “Filter spam for all 
accounts”.

3. If you want to turn on spam filtering for only some of your accounts, click 
“Only for the selected accounts below”. Spam filtering is then activated for 
accounts with checkmarks beside them. Click to check or uncheck each 
account.

4. Click OK to confirm your spam filter settings.

If you have a lot of messages in your Inbox: When spam filtering is turned on for 
an AOL or IMAP account, AOL Communicator Mail downloads the content of 
each message to determine whether the message is spam. If you have are using a 
slow dialup connection, this may cause mail retrieval to seem a bit slow the first 
time.

The slowdown is proportional to the number of messages in your Inbox—the more 
you have, the longer spam filtering takes. If you have fewer than a hundred or so 
messages in your Inbox any given time, you probably won’t notice any slowdown 
if you select this option.

Related topics:

Training Your Spam Filter (page 32)
Turning Off Spam Filtering in AOL Communicator (page 95) 
Spam Filter Settings (page 97) 
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Turning Off Spam Filtering in AOL 9.0 Optimized
To take full advantage of spam filtering in AOL Communicator Mail, turn off spam 
filtering in AOL 9.0 Optimized:

1. Click this link: Mail and Spam Controls

Alternatively, open AOL 9.0 Optimized and go to AOL Keyword: Mail 
Controls 

2. In the Mail and Spam Controls window, locate the checkbox labeled “Mail 
filtered by AOL’s Advanced Spam Filter”:

3. If the checkbox has a checkmark in it, click it to turn spam filtering off. 

The checkbox should be empty, as in the picture above.

4. Click Save. 

5. If your mailbox isn’t already open, click Read near the upper-left corner of the 
window to open it.

6. If you can’t see your Spam folder, click the Spam folder link near the 
bottom-left of your Mailbox window to reveal it.

7. Click Spam in the left column.

8. Make sure all the messages in the Spam folder are actually spam messages. 

If some of the messages have been marked incorrectly as spam, select them and 
click This is Not Spam.

9. Click Delete All.

You have now turned off spam filtering in AOL 9.0 Optimized.

Related topic:

Host-Based Versus Local Spam Filtering (page 91) 



Controlling Spam

Chapter 5 Using AOL® Communicator Mail 95

Turning Off Spam Filtering in AOL 
Communicator
By default, spam filtering is turned on for POP accounts and off for IMAP and AOL 
accounts. 

To turn off spam filtering for any account:

1. From the main AOL Communicator Mail window, open the Spam menu and 
choose Spam Filter.

2. If you want to turn spam filtering off for all accounts, click "Don't filter spam 
(No accounts)".

3. If you want to turn on spam filtering for only some of your accounts, click 
“Only for the selected accounts below”. Spam filtering is then activated for 
accounts with checkmarks beside them:

Click to select or deselect each account as appropriate.

4. Click OK.

Related topics:

Turning On Spam Filtering in AOL Communicator (page 93) 

Reporting Spam to AOL
When you receive spam messages addressed to one of your AOL accounts, you can 
report the messages to AOL to help anti-spam efforts within the AOL service.

To report spam messages:

1. Select one or more messages that you want to report.

2. Right-click on the message.

3. Choose Report Spam.

If you selected a single message in Step 1, you can type comments about that 
message in the Optional Comments field. 

If you selected multiple messages in Step 1, you won’t see the Optional 
Comments field.

4. Click “Send, then Delete” to report the message and delete it at the same time

Alternatively, click Send Report to report the message without deleting it.
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By reporting spam, you can help AOL reduce the amount of spam being sent to 
you and other AOL members.

Related topic:

Training Your Spam Filter (page 32) 

HOW IT WORKS: Spam Filtering

When spam filtering is turned on, AOL Communicator Mail checks each 
incoming message for characteristics it considers typical of spam. The filter gets 
smarter and more powerful as you use it, learning over time what types of mail 
messages you consider to be spam.

If the spam filter determines that particular messages are spam, it marks them 
like this in the list of messages:

At first, the filter may make mistakes. You can right-click incorrectly marked 
messages to train the filter as you observe it in action. For details, see “Training 
Your Spam Filter” (page 32). 

By default, Mail does not consider messages from email addresses listed in your 
AOL Communicator Address Book to be spam. For example, mail from 
addresses in your Auto-Added address book, which are added automatically 
when you send messages, are not checked for spam.

However, spam messages may sometimes masquerade as messages from people 
you know. 

If you are receiving such spam messages, you can turn off the Mail option called 
“Messages from people in my address book are never spam”. When you turn off 
this option, Mail checks incoming messages for spam regardless of whether the 
sender has an entry in your AOL Communicator Address Book. For details, see 
the section on the Options tab under Spam Filter Settings (page 97).
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Spam Filter Settings
If you’re not already viewing the Spam Filter window, open the Spam menu and 
choose Spam Filter. 

General Tab

Select one of these spam filter settings:

• Filter spam for all accounts: Turn spam filtering on and apply it to all 
accounts. This is the default setting. 

• Don’t filter out spam (No accounts): Turn all spam filtering off.

• Only for the selected accounts below: Apply spam filtering to some but not all 
of your accounts. 

Click to select or deselect each account as appropriate.

Options Tab

These options apply to all accounts for which spam filtering is turned on: 

• Messages from people in my address book are never spam: In general, it's 
best to leave this option selected (the default setting).

However, spam messages may sometimes masquerade as messages from 
people you know. 

When this option is turned off, Mail checks incoming messages for spam 
regardless of whether the sender has an entry in your AOL Communicator 
Address Book. 

• Auto-delete spam __ after I receive it. Select this option if you want to set a 
limit (3 days, 1 week, or 2 weeks) on the length of time AOL Communicator 
Mail retains messages marked as spam.

When this option is selected, the drop-down list becomes active. Click the 
arrow, then click the length of time you want.

Use this option with caution, since the spam filter sometimes makes mistakes 
(especially if you haven’t trained it very much). 

• Reset Spam Filter: Click to erase all the spam filter training that you have done 
so far and start over. 

You may need to do this if you accidentally train the filter to treat some of your 
non-spam messages as spam.
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Related Topics: 

To filter spam effectively, you need to train the filter as you observe the filters in 
action: “Training Your Spam Filter” (page 32) 

HOW IT WORKS: Spam Filtering (page 96)
Turning On Spam Filtering in AOL Communicator (page 93) 
Turning Off Spam Filtering in AOL Communicator (page 95) 

Using Message Filters
If you get a lot of email, Mail can help you keep it organized by automatically 
moving, deleting, or marking messages according to your message filters:

• Creating a Simple Message Filter for an Email Address (page 98): How to set 
up a filter based on an email address.

• Creating a Message Filter (page 100): How to set up a filter from scratch and 
test it before activating it.

• Applying Message Filters (page 101): How to apply all filters associated with 
an account to selected messages.

Settings & Preferences:

• Setup Custom Message Filters (page 102): How to use the Setup Custom 
Message Filters window, which lists all the filters that are currently available.

• Custom Message Filter (page 103): How to use the Custom Message Filter 
window, which allows you to set up one or more rules for filtering messages 
with specified characteristics.

Creating a Simple Message Filter for an Email 
Address
To create a simple message filter based on an email address:

1. Right-click any email address listed in a message’s header (the shaded area at 
the top of every mail message).

2. Choose “Create Filter from Message” from the pop-up menu.
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3. For Filter name, type the name you want to use to identify this filter. Example: 
John Chapman

4. Under Applies To, leave Incoming Messages selected.

5. Use the first drop-down list next to Perform the following action to specify the 
action that you want to perform on messages that this filter applies to. 

For example, choose Move to folder if you want to move messages from this 
email address to a particular folder.

If you choose “Move to folder” or “Copy to folder,” you must also specify a 
folder:

❍ Use the second drop-down list to specify the account (or Local Mail) in 
which the destination folder resides. 

❍ Use the last field to select a folder in that account.

6. Under For these conditions, leave the option If Any of the following 
conditions are met selected

7. In the bottom portion of the window, specify the condition you want the filter 
to test for.

By default, it is set up to check whether the same field in each message (such as 
sender or recipient) contains the email address you right-clicked in Step 1. If 
necessary, use the drop-down lists to change the message field or condition 
you want the filter to check for.

8. Click OK to confirm your filter settings. 

The new filter is enabled by default and appears in the Setup Custom Message 
Filters (page 58) window under the account to which it applies. From now on, 
messages that meet the conditions you specified will be treated as you specified.

You can use the Setup Custom Message Filter window to change the account the 
filter applies to or enable, disable, edit, or delete the filter.
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Creating a Message Filter
To set up a message filter from scratch:

1. Starting from the Mail window, open the Tools menu and choose Custom 
Message Filters, then Setup.

The Setup Custom Message Filters window appears.

2. From the drop-down list labeled “Filter for messages on:”, choose the account 
that you want the filter to apply to.

3. Click New Filter.

The Custom Message Filter window appears.

4. Fill in the Filter name. Example: BigProject 

The remainder of these instructions describe how to create a simple filter that 
identifies incoming messages whose To or Cc fields include the word 
BigProject. You can substitute your own decisions at each step, including 
adding additional conditions if necessary.

5. Under Applies To, leave Incoming Messages selected.

6. Use the first drop-down list next to Perform the following action to specify the 
action that you want to perform on messages that this filter applies to. 

For example, choose Move to folder if you want to move messages from this 
email address to a particular folder.

If you choose “Move to folder” or “Copy to folder,” you must also specify a 
folder:

❍ Use the second drop-down list to specify the account (or Local Mail) in 
which the destination folder resides. 

❍ Use the last field to select a folder in that account. For example, the name of 
the folder to which to move matching BigProject-related messages might 
be BigProject.

7. Under For these conditions, select If __ of the following conditions are met. 

8. Select one of these options from the drop-down list:

❍ Any: Messages that satisfy any one of the specified conditions will trigger 
the filter.

❍ All: Only messages that satisfy every condition listed in this window will 
trigger the filter.
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9. Specify your conditions in the bottom portion of the window. Choose items 
from the drop-down lists so that the sentence reads as follows:

the recipient of the message contains

10. Finish the sentence by typing BigProject in the field after contains.

11. To add more conditions, click the Add button. To delete the bottommost 
condition, click Remove.

12. Click OK to confirm your filter settings and return to the Setup Custom 
Message Filters window.

You can set up as many filters as you want. They will be applied in the order they 
are listed against messages received in the selected inbox. Click Move Up or Move 
down to change the position of the selected filter.

You can also use the Setup Custom Message Filter window to change the account 
your new filter applies to or disable, edit, or delete the filter.

Click OK to return to the main AOL Communicator Mail window. If you left the 
new filter enabled, messages that meet the conditions you specified will be filtered 
accordingly.

Applying Message Filters
A message filter is associated with an account. When the filter is enabled in the 
Setup Custom Message Filters (page 58) window, it is applied automatically to all 
incoming and/or outgoing messages for that account (depending how you set up 
the filter). 

You can also manually apply the message filters associated with an account to 
selected messages that have already been received or sent. 

To apply message filters manually:

1. Select the messages you want to filter.

2. Open the Tools menu and choose Custom Message Filters, then Run Filters on 
Selected Messages.

If any of the selected messages meet the conditions specified for any of the 
filters for this account, they will be copied, moved, and so on accordingly. 

Related Topics: 

Controlling Spam (page 91) 
Creating a Simple Message Filter for an Email Address (page 98) 
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Setup Custom Message Filters
The Setup Custom Message Filters window lists all the mail filters that you have 
previously set up for each of your inboxes.

If you are not already viewing it, open the Tools menu in Mail and choose Custom 
Message Filters, then Setup. You can take these actions:

• Filters for messages on: Select the account for which you want this filter’s rules 
to apply.

• New Filter: Click this button to open the Custom Message Filter window and 
create a new filter.

• To perform any of the following actions, select the filter you want to modify 
and click the appropriate button: 

Edit: Opens the Custom Message Filter window for the selected filter. 

Delete: Deletes the selected filter.

Move Up: Moves the selected filter up in the list. 

Move Down: Move the selected filter down in the list.

Note that the order in which filters are listed in the Setup Custom Message 
Filters window is the order in which the filters are applied. This can be 
important for complex filtering schemes.

Click OK to confirm your choices.

Related Topics: 

Controlling Spam (page 91) 
Creating a Message Filter (page 100) 
Custom Message Filter (page 103) 
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Custom Message Filter
The Custom Message Filter window allows you to set up, view, and change a 
message filter’s definition. You see this window when you create a new filter or 
edit an existing one in the Setup Custom Message Filters (page 58) window.

Complete the filter definition as follows:

Filter name: Type the name you want to use to identify this filter. Example: My 
Project Filter

Applies To: Select the type of messages you want the filter to apply to:

• Incoming Messages: Filter will be applied to all incoming messages when you 
collect mail for the account to which the filter applies.

• Outgoing Messages: Filter will be applied to all messages that you send.

Perform the following action: Use the first drop-down list to specify the action 
that you want to perform on messages that this filter applies to: 

• Move to folder: Move messages that meet your conditions to the destination 
you specify on the right.

• Copy to folder: Copy messages that meet your conditions to the destination 
you specify on the right, leaving the original message in its original location.

• Delete: Delete messages that meet your conditions.

• Mark Read: In the View pane (the right-hand side of the main AOL 
Communicator Mail window), change the entry for this message from boldface 
to plain text for this message and remove the orange icon (indicating that a 
message is unread) from the status column.

• Mark Spam: Messages that meet your conditions will be marked as spam.

If you choose “Move to folder” or “Copy to folder,” you must also specify a folder:

• Use the second drop-down list to specify the account (or Local Mail) in which 
the destination folder resides. 

• Use the last field to select a folder in that account.

For these conditions: 

• No conditions, apply filter to all specified messages: Select this option with 
care—it performs the specified action on all messages to which this filter 
applies (incoming, outgoing, or both). 
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• If __ of the following conditions are met: Select this option to specify 
conditions that must be met for the filter to take the specified action. When this 
option is selected, you can select one of these options from the drop-down list:

❍ Any: Messages that satisfy any one of the specified rules will trigger the 
filter.

❍ All: Only messages that satisfy every rule listed in this window will trigger 
the filter.

Selecting the conditions option also causes a box to appear in the bottom half of 
the window. Use the box to specify your conditions:

❍ the: From the drop-down list on the left, select the part of the message you 
want this filter to search. 

For example, if you choose “recipient,” the filter will search the To and Cc 
fields of incoming messages (and the Bcc fields for AOL messages on 
which you’ve been Bcc’d). If the text you specify is found in either field of a 
message, it will be moved to the location that you specified above.

❍ of the message: From the drop-down list on the right, select the kind of 
condition you want the filter to check for, such as “contains” or “isn’t.”.

❍ (unlabeled field or drop-down list): In the text field to the right of the 
drop-down lists, enter the text you want the filter to check for. 

If you have chosen to search the Status field, the unlabeled field is replaced 
by a drop-down list, from which you can choose Read or Replied.

To create another condition for this filter, click Add. The filter applies 
additional conditions according to your selection of Any or All above.

To eliminate the bottommost condition, click Remove. 

Click OK to confirm your filter settings.

A brand new filter is enabled by default and appears in the Setup Custom Message 
Filters (page 58) window under the account to which it applies. You can use the 
Setup Custom Message Filter window to change the account or enable, disable, 
edit, or delete the filter.

Related topics: 

Controlling Spam (page 91) 
Creating a Message Filter (page 100) 
Setup Custom Message Filters (page 102) 
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Signing & Encrypting Messages
The sections that follow describe how to obtain, set up, and use certificates to sign 
and encrypt your email messages. 

Setting Up Secure Mail (page 105)
HOW IT WORKS: Digital Signatures & Encryption (page 106)
Getting Other People's Certificates (page 107)
Configuring Security for an Account (page 107)
Signing & Encrypting a New Message (page 108)
Reading Signed & Encrypted Messages (page 109)

Settings & Preferences:
Message Security Info (Write Mail) (page 110) 
Message Security Info (Received Mail) (page 111) 

Related topics:

“Getting Started With Identity Manager” (page 231) describes how to configure 
your existing certificates to support signed and encrypted mail messages.

For additional information on digital signatures, encryption, and the Identity 
Manager, see “Using AOL Communicator Identity Manager” (page 213).

Setting Up Secure Mail
When you compose a mail message, you can choose to attach your digital signature 
to it. A digital signature helps recipients of the message to verify that the message 
really comes from you and decreases the possibility that the message has been 
tampered with since you sent it.

You can also choose to encrypt a mail message. Encryption makes it more difficult 
for anyone other than the intended recipient to read the message while it is in 
transit over the Internet.

Before you can sign or encrypt a message, you must take these preliminary steps:

1. Obtain one or more certificates (the digital equivalents of ID cards). For details, 
see “Getting Your Own Certificate” (page 235).

2. Configure the security settings for your email account. For details, see 
“Configuring Security for an Account” (page 107).
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Once you have completed these steps, you can complete the instructions in 
“Signing & Encrypting a New Message” (page 108).

HOW IT WORKS: Digital Signatures & Encryption 

A digital signature: 

Identifies the sender of the message.

Helps detect tampering with the message after it was sent.

To create a digital signature for an email message that you are sending, you 
need two things:

A signing certificate that identifies you for this purpose. Every time you 
sign a message, your signing certificate is included with the message.

A certificate is a bit like your name and phone number in the 
phonebook—it is public information that helps other people communicate 
with you.

A private key, which is created and stored on your computer when you 
first obtain a certificate. Every private key corresponds to a public key 
included with your certificate. 

Your private keys are protected by your Master Password.

Mail uses your private key to create a unique, verifiable digital signature for 
every message you choose to sign. The public key in your signing certificate 
allows other people to confirm that your private key, and nobody else’s, was 
used to create the signature.

To encrypt an email message, you must have an encryption certificate for each 
of the message's recipients. The public key in each certificate is used to encrypt 
the message for that recipient.

If you don't have a certificate for even a single recipient, the message cannot be 
encrypted.

The recipient's software uses the recipient's private key, which remains on that 
person's computer, to decrypt the message.
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Getting Other People's Certificates
Every time you send a digitally signed message, your encryption certificate is 
included with the message. Therefore, one of the easiest ways to obtain someone 
else's certificate is for that person to send you a digitally signed message.

When you receive such a message, the person's certificate is automatically stored 
by Identity Manager. This is useful because you need to have a certificate for each 
recipient of any email message that you want to send in encrypted form.

Another way to obtain certificates is to look them up in an online directory, such as 
the "phonebook" directories maintained by many companies.

It's also possible to look up certificates automatically. When you are using any 
account that is configured to look up addresses in a directory, the same directory 
will be searched for matching certificates when you attempt to send an encrypted 
message to one or more recipients for whom you don't have certificates on file.

Configuring Security for an Account
Once you’ve obtained one or more certificates for signing and encrypting mail 
messages, you can configure your Mail accounts to use them. 

To specify which signing and encryption certificates to use with a particular 
identity, begin from the Mail window: 

1. Open the Edit menu and choose Account Settings.

2. Double-click the name of the account for which you want to configure 
certificates.

3. Click the Security tab and adjust the settings as necessary:

Digitally sign messages by default: If you want new messages to be digitally 
signed by default, select this checkbox. 

This setting is optional. Even if it’s not selected, you can still choose to digitally 
sign an individual message when you write it.

Use this certificate to digitally sign messages sent from this account: Choose 
the signing certificate you want to use from the drop-down list.

You must choose a signing certificate here before you can encrypt or digitally 
sign any message sent from this account.

Encrypt messages by default: If you want new messages to have encryption 
turned on by default, select this checkbox.
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This setting is optional. Even if it’s not selected, you can still choose to encrypt 
an individual message when you write it.

Use this certificate to encrypt and decrypt messages for this account: Choose 
the encryption certificate you want to use from the drop-down list.

You must choose an encryption certificate here before you can encrypt or 
digitally sign any message sent from this account.

4. Click OK to confirm your choices.

5. Click OK in the Account Settings window.

In some cases you may be able to specify the same certificate for both signing and 
encryption. Check with your system administrator to find out for sure. 

Signing & Encrypting a New Message
Before you can digitally sign or encrypt any message, you must obtain at least one 
email certificate and configure secure mail for at least one of your identities. For 
details, see “Setting Up Secure Mail” (page 105). An identity’s secure mail settings 
also determine the default settings for new Write Mail windows.

To open a Write Mail window, start from the Mail window and click Write Mail. 

To view or change the current security settings for the Write Mail window you are 
viewing:

1. Press and hold the mouse button while the pointer is over the lock button near 
the top of the window.

2. Choose Digitally Sign or Encrypt to select or deselect those options in the 
drop-down list.

To view more detailed information about the message's security status, open the 
View menu and choose Message Security Info.



Signing & Encrypting Messages

Chapter 5 Using AOL® Communicator Mail 109

Reading Signed & Encrypted Messages
When you view a signed or encrypted message in the Mail window, these icons 
near the upper-right corner of the message header indicate the security status of 
the message:

To see more detailed information about the message's security, click the key or lock 
icon.

For information about certificate validation, see “Controlling Certificate 
Validation” (page 252).

The message is digitally signed and 
has been validated. If there is a 
problem with the signature, the pen is 
broken.

The message is signed, but it has a 
large attachment that has not yet 
been downloaded. Click the icon to 
download the attachment and 
validate the signature.

The message is encrypted. If there is 
a problem with the encryption, the 
lock is broken.
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Message Security Info (Write Mail)
This section describes the Message Security Info window that you can open for any 
message you are composing. If you're not already viewing Message Security Info, 
click the Security icon in the toolbar near the top of the Write Mail window.

The Message Security Info window describes how your message will be sent:

Digitally Signed: This line describes whether your message will be signed. There 
are three possibilities:

Yes: Digital signing has been enabled for this message, you have a valid 
certificate identifying you, and the message can be signed.

No: Digital signing has been disabled for this message.

Not possible: Digital signing has been enabled for this message. However, a 
valid certificate identifying you for this purpose is not available, or there is 
some other problem that makes signing impossible.

Encrypted: This line describes whether your message will be encrypted. There are 
three possibilities:

Yes: Encryption has been enabled for this message, valid certificates for all 
listed recipients are available, and the message can be encrypted.

No: Encryption has been disabled or is not possible for this message.

Not possible: Encryption has been enabled for this message. However, a valid 
certificate for at least one of the listed recipients is not available, or no 
recipients are listed, or there is some other problem that makes encryption 
impossible.

Certificates: Certificates available for the recipients of your message.

View: To view the details for any certificate in the list, select its name and click 
View.

Related topics:

For information about obtaining certificates and configuring message security 
settings: Signing & Encrypting Messages (page 105). 

To indicate your default signing and encryption preferences for all messages: 
Configuring Security for an Account (page 107).
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Message Security Info (Received Mail)
In general, message security info for a received message is of interest only if you 
have a certificate (a form of digital ID) and receive digitally signed or encrypted 
messages from other people. 

If you’re not already viewing Message Security Info for a message, select the 
message whose status you want to view, open the View menu and choose Message 
Security Info.

The top part of the window displays information about the digital signature, if any, 
associated with the message.

The bottom part of the window displays information about the encryption status of 
the message.

Related topic:

Signing & Encrypting Messages (page 105) 

This document is provided by AOL for your information only. It may help you 
take certain steps to protect the privacy and security of your personal information 
on the Internet. This document does not, however, address all online privacy and 
security issues, nor does it represent a recommendation by AOL about what 
constitutes adequate privacy and security protection on the Internet.

Mail Account Settings
These sections describe how to view and edit the settings associated with each of 
your mail accounts:

Account Settings Window (page 112) 

Mail Settings Tab (AOL Account) (page 112) 
Options Tab (AOL Account) (page 114) 
Advanced Options (AOL Account) (page 115) 

Sending Mail Tab (IMAP & POP Accounts) (page 116) 
Outgoing Server Settings (IMAP & POP Accounts) (page 117) 
Advanced Options (IMAP & POP Accounts) (page 119) 
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Receiving Mail Tab (IMAP Account) (page 120) 
Receiving Mail Tab (POP Account) (page 122) 

Security Tab (page 123) 

Account Settings Window
The Account Settings window lists all the accounts that are currently set up for use 
with Communicator Mail.

If you are not already viewing the list of accounts, open the Edit menu in 
Communicator Mail and choose Account Settings. 

To create a new account, click New.

To perform any of the following actions, select the account you want to modify and 
click the button:

• Edit: Opens the Edit Account window for the selected account. 

• Delete: Deletes the selected account.

• Up: Moves the selected account up in the list.

• Down: Move the selected account down in the list.

The order in which accounts are listed in the Account Settings window is also 
the order in which they are listed in the main Mail window.

Click OK to confirm your choices.

Related topic

Setting Up Mail Accounts (page 11) 

Mail Settings Tab (AOL Account)
The Mail Settings tab in the Edit Account window displays the settings for an AOL 
account.

If you’re not already viewing your mail settings, open the Edit menu in AOL 
Communicator Mail, choose Account Settings, and double-click the AOL account 
whose settings you want to view.
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• Description: The description at the top of the window identifies this account in 
the Account Settings Window. You can type anything you want here.

Examples: John’s AOL Account or mr1smth@aol.com 

• Your Name: The name listed here shows up as one of the names you can select 
in the From field when you write a new mail message. 

• Screen Name: Your AOL screen name.

• Password: Your AOL password.

Password quality: Passwords that can be easily guessed have little value. 

The password quality meter gives you a rough idea of the relative quality of 
your password as you type it based on factors such as length and the use of 
uppercase letters, lowercase letters, numbers, and symbols. 

For more information, see “Using the Password Quality Meter” (page 216).

Remember password: Leave this option selected if you don’t want to be 
prompted for your password every time you launch AOL Communicator.

Note: If you leave the “Remember password” selected, other people with 
physical access to your computer may be able to access your AOL account.

• Reply-to Address: Enter a reply-to address only if it is different from the email 
address specified above.

The reply-to address appears in the To field when a recipient of a message sent 
from this account clicks Reply.

• Organization/Institution: An appropriate organization name, if any, that you 
want to associate with this account.

• Signature Text: Specify the signature (if any) that you want to append to every 
message you send from this account. 

If you want your signature to appear in HTML, you must include the 
appropriate tags manually. Here’s an example:

<b>Your Name</b><br>
Your Company<br>
Your Street Address<br>
Your City, State, Zip<br>
Your Phone Number<br>
<em><center>any little quote you'd like to include</center></em><br>
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• Set Mail Away Message: Click this link to launch the AOL software and open 
the Mail Away message settings for this account. 

While your Mail Away message is turned on, anyone who sends a message to 
this account receives a one-time notification that you are not currently 
available to answer your mail.

Related topics:

Setting a Mail Away Message (page 89) 

Options Tab (AOL Account)
The Options tab in the Edit Account window displays the following settings for an 
AOL account:

• Check for new mail on startup: Select this option if you want to collect 
messages for this account automatically when you first launch Mail. 

• Check for new mail every __ minutes: Select this option if you want to collect 
messages for this account at regular intervals. 

For example, if select the checkbox and type in 10, Mail will check for new 
messages every 10 minutes.

• Store messages locally for offline computing: When this option is selected, 
messages stored on the AOL server are downloaded to your computer so that 
they’re available when you’re not online. 

Lots of messages take longer to store: If you have a lot of stored messages, the 
initial download process can take some time.

• Keep my old mail online __ days after I read it: Use the arrows beside the 
number field to increase or decrease the value. Messages will be deleted after 
this interval.

Account Style: 

• AOL Classic: Displays your messages in folders that correspond to the mail 
tabs in AOL client software: New Mail, Old Mail, and Sent Mail.

• Internet Mail: Displays New Mail and Old Mail together in the Inbox folder.

Advanced Options: Click this button at the bottom of the window to view or 
change your draft message folder setting, Bcc settings, and directory settings.

When you have adjusted the mail settings to your liking, click OK.
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Related topics:

Account Style Options and Message Retention (page 84) 
AOL Mail Expiration and AOL Communicator (page 86) 

Advanced Options (AOL Account)
To open the Advanced Options window for an AOL account, click Advanced 
Options in the Options Tab (AOL Account) (page 114).

Copies and Folders

• Save Drafts of messages in: When you click Save Draft while writing a 
message to be sent from this account, the draft is stored in the folder you select 
here.

• Bcc this address on all outgoing messages: Select this option and type an 
address to which you want to send a blind copy of every outgoing message, 
without showing up on the list of recipients.

• Automatically Bcc “your_screen_name” on all outgoing messages: Select this 
option to send a copy of every outgoing message to yourself, without showing 
up on the list of recipients.

Addressing Mail

You can set up your account to make use of an online directory. This allows you to 

• Fill in names and addresses from the directory automatically when you 
address a message.

• Use your Buddy List® window to check for recent mail from anyone listed in 
the directory. 

Whenever you receive a message from someone listed in the directory, a green 
envelop icon appears beside their name in your Buddy List window. You can 
double-click the icon to read that person’s most recent message.

These options control your directory settings:

• For this account, use a directory for type-down addressing: If your 
organization has an LDAP directory, select this option.

If you have previously configured any directories, you can select the one you 
want from the drop-down list. 

• New. If the directory you want to associate with this account is not available in 
the drop-down list, click New to set it up. 
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If you don’t know your organization’s directory settings, ask your system 
administrator.

Related topics:

Setting Up a New Directory (page 177) 

Sending Mail Tab (IMAP & POP Accounts)
The Sending Mail tab displays outgoing mail settings for an IMAP or POP account.

If you’re not already viewing the Edit Account window, open the Edit menu in 
AOL Communicator Mail, choose Account Settings, and double-click the account 
whose settings you want to view.

• Description: The description at the top of the window identifies this account in 
the Account Settings Window. You can type anything you want here.

Examples: John’s AOL Account or mr1smth@aol.com

Personal Information

• Your Name: The name listed here shows up as one of the names you can select 
in the From field when you write a new mail message. 

• Email Address: The email address for this account. 

Example: jnm@example.net 

• Reply-to Address: Enter a reply-to address only if it is different from the email 
address specified above.

The reply-to address appears in the To field when a recipient of a message 
clicks Reply. 

• Organization/Institution: An appropriate organization name, if any, for this 
account. 

• Signature Text: Specify the signature (if any) that you want to append to every 
message you send from this identity. 



Mail Account Settings

Chapter 5 Using AOL® Communicator Mail 117

If you want your signature to appear in HTML, you must include the 
appropriate tags manually. Here’s an example:

<b>Your Name</b><br>
Your Company<br>
Your Street Address<br>
Your City, State, Zip<br>
Your Phone Number<br>
<em><center>any little quote you'd like to include</center></em><br>

Outgoing Server

• Outgoing SMTP Server: In many cases, this is the same name as the 
corresponding Mail server. 

Example: mail.example.net

You can select any server from the drop-down list.

• Add Server: Click this button to set up a new server and add it to the 
drop-down list.

• Edit Server: Click this button to edit the currently selected server.

Advanced Options: Click this button at the bottom of the window to view or 
change your draft message folder setting, Bcc settings, and directory settings.

Outgoing Server Settings (IMAP & POP 
Accounts)
To edit outgoing server settings, open the Sending Mail Tab (IMAP & POP 
Accounts) (page 116) and click Edit Server or Add Server.

• Server Name: In many cases, this is the same name as the corresponding Mail 
server. Example: 

imap-server.example.net 

The server name must be spelled correctly or you will not be able to send any 
messages.

To specify a nonstandard port number (required by some ISPs), type a colon 
after the server name, followed by the number:

Example: imap-server.example.net:123 
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• Use secure connection (SSL): A secure connection means that all 
communication between your computer and the mail server is encrypted. A 
secure connection does not protect your outgoing messages after the server 
directs them to their recipients. 

If you select Always, your messages will be sent only if an encrypted 
connection is available. 

Not all servers support SSL. If you’re not sure about your server, check with 
your system administrator or select “When available” or “Never”.

• Use authentication when sending mail. Select this checkbox if the outbound 
host server requires name and password authentication each time you send 
mail. If you’re not sure, check with your system administrator.

• SMTP User: Your SMTP user name is typically everything to the left of the “@” 
sign in your email address. 

Example: If your email address is jnm@example.net, your user name could be 
jnm or jnm@example.net 

• SMTP Password: Your password for the SMTP user specified above. 

You can’t provide a password unless you also select “Remember SMTP 
password” below.

• Password quality. Passwords that can be easily guessed have little value. 

The password quality meter gives you a rough idea of the relative quality of 
your password as you type it based on factors such as length and the use of 
uppercase letters, lowercase letters, numbers, and symbols. 

For more information, see “Password Quality Meter” (page 216).

• Remember SMTP password. Select this option if you don’t want to be 
prompted for it.

Note: If you leave this option selected, other people with physical access to 
your computer may be able to access your ISP account.

If this option is not selected and the option “Use authentication when sending 
mail” above is selected, you will be prompted for the password the first time 
you send mail after launching AOL Communicator.
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Advanced Options (IMAP & POP Accounts)
To open the Advanced Options window, click Advanced Options in the Sending 
Mail Tab (IMAP & POP Accounts) (page 116).

Copies and Folders

• Save drafts of messages in: When you click Save Draft in any new message 
sent from this account, the draft will be stored in the folder you select here.

• When I delete a message, move it to: For most people the default Trash folder 
is fine as a destination for deleted mail. If you want, you can use the 
drop-down list to select a different folder.

• Save a copy of all outgoing messages to: Select this option to send a copy of 
every outgoing message to the account and folder you choose from the 
drop-down list.

• Bcc this address on all outgoing messages: Select this option and type an 
address to which you want to send a blind copy of every outgoing message, 
without showing up on the list of recipients.

• Automatically Bcc “your_email_address” on all outgoing messages: Select 
this option to send a copy of every outgoing message to yourself, without 
showing up on the list of recipients.

Addressing Mail

You can set up your account to make use of an online directory. This allows you to 

• Fill in names and addresses from the directory automatically when you 
address a message.

• Use your Buddy List window to check for recent mail from anyone listed in the 
directory.

Whenever you receive a message from someone listed in the directory, a green 
envelop icon appears beside their name in your Buddy List window. You can 
double-click the icon to read that person’s most recent. message.

These options control your directory settings:

• For this account, use a directory for type-down addressing: If your 
organization has an LDAP directory, select this option.

If you have previously configured any directories, you can select the one you 
want from the drop-down list. 
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• New: If the directory you want to associate with this account is not available in 
the drop-down list, click New to set it up. 

If you don’t know your organization’s directory settings, ask your system 
administrator.

Related topic:

Setting Up a New Directory (page 177) 

Receiving Mail Tab (IMAP Account)
The Receiving Mail tab of the Edit Account window displays these incoming mail 
settings for an IMAP account:

• Inbound IMAP Host: Fill in the complete name of the server. Example: 

mail.example.net 

To specify a nonstandard port number (required by some ISPs), type a colon 
after the server name, followed by the number:

Example: mail.example.net:123 

• Use a secure connection (SSL): A secure connection means that all 
communication between your computer and the incoming mail server is 
encrypted. 

Before they reach your mail server, messages sent to you are not necessarily 
protected by a secure connection.

Not all servers support SSL. If you’re not sure about your server, check with 
your system administrator.

• IMAP Folder Path: Not all servers require this information. Check with your 
system administrator.

User Name: Typically, this is everything to the left of the “@” sign in your 
email address. For example, if you email address is jnm@example.net, your 
user name could be jnm or jnm@example.net 

• Password: Your IMAP password.

Password quality: Passwords that can be easily guessed have little value. 
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The password quality meter gives you a rough idea of the relative quality of 
your password as you type it based on factors such as length and the use of 
uppercase letters, lowercase letters, numbers, and symbols. 

For more information, see “Using the Password Quality Meter” (page 216).

Remember password: Leave this option selected if you don’t want to be 
prompted for your password every time you launch AOL Communicator.

Note: If you leave this option selected, other people with physical access to 
your computer may be able to access your account.

Options

• Check for new mail on startup: Select this option if you want to collect 
messages for this account automatically when you first launch AOL 
Communicator.

• Check for new mail every __ minutes: Select this option if you want to collect 
messages for this account at regular intervals. 

For example, if you select the checkbox and type in 10, Mail will check for new 
messages every 10 minutes.

Unless you enter your password in the Password field above and select 
“Remember password,” you will be asked for your password the first time 
AOL Communicator Mail checks mail after launching (or whenever your 
Internet connection is restored after you’ve been offline).

• Store messages locally for offline computing: When this option is selected, 
messages stored on the server are downloaded to your computer so that 
they’re available when you’re not online. 

Lots of messages take longer to store: If you have a lot of stored messages, the 
initial download process can take some time.

• Show only subscribed folders: Some IMAP client software uses a 
“subscription” model that allows you to subscribe to certain folders (which 
show up in your list of folders) and not others (which don’t show up).

If you want only folders to which you have subscribed to show up in the list of 
folders in the left pane of the main AOL Communicator Mail window, select 
this option. 

If this option is not selected, all folders on the IMAP server show up.

When you have adjusted the settings to your liking, click OK. 
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Related topics:

Controlling Your Passwords (page 217) 

Receiving Mail Tab (POP Account)
The Receiving Mail tab of the Edit Account window displays incoming mail 
settings for an IMAP or POP account.

• Inbound POP Host: Fill in the complete name of the server. Example: 

mail.example.net 

To specify a nonstandard port number (required by some ISPs), type a colon 
after the server name, followed by the number:

Example: mail.example.net:123 

• User Name: Typically, this is everything to the left of the “@” sign in your 
email address. For example, if you email address is jnm@example.net, your 
login would be jnm 

• Password: Your POP password.

Password quality: Passwords that can be easily guessed have little value. 

The password quality meter gives you a rough idea of the relative quality of 
your password as you type it based on factors such as length and the use of 
uppercase letters, lowercase letters, numbers, and symbols. 

For more information, see “Using the Password Quality Meter” (page 216).

Remember password: Leave this option selected if you don’t want to be 
prompted for your password each time you launch AOL Communicator (or 
whenever your Internet connection is restored after you’ve been offline).

Note: If you leave the “Remember password” option selected, other people 
with physical access to your computer may be able to access your POP account.

Options

• Check for new mail on startup: Select this option if you want to collect 
messages for this account automatically when you first launch Mail.
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• Check for new mail every __ minutes: Select this option if you want to collect 
messages for this account at regular intervals. 

For example, if you select the checkbox and type in 10, Mail will check for new 
messages every 10 minutes.

Unless you enter your password in the Password field above, you will be asked 
for your password each time Mail collects messages.

• Leave messages on POP server: Optional. Leaving messages on the server can 
be sometimes be convenient; for example, if you want to be able to read 
messages from other locations after you download them to this installation of 
Mail.

Delete messages on server when they are deleted locally: This setting gives 
you a way to delete individual messages that you’ve left on the server.

When you have adjusted the settings to your liking, click OK. 

Related topic:

Controlling Your Passwords (page 217) 

Security Tab
The Security tab of the Edit Account window allows you to select two certificates 
that identify you:

• The email certificate you want to use for signing mail messages you send to 
other people.

• The email certificate you want other people to use when they encrypt messages 
they send to you.

Before you can select certificates from this tab, you must obtain one or more 
certificates. For details, see “Setting Up Secure Mail” (page 105).

Depending on the policies of the certificate authority (CA) that issues your 
certificate(s), you can use one certificate for both purposes or two different 
certificates. Even if you use just one, you must specify it twice, once for digital 
signing and once for encryption.

The certificates you select here are included with every signed message you send. 
These certificates allow your recipients to verify your digital signature and to 
encrypt messages that they send to you.
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Digital Signing

You use the Digital Signing area in the Security panel to specify how you want to 
sign your email messages:

• Digitally sign messages by default: Select this checkbox if you want to 
digitally sign all the messages you send.

A personal certificate must be specified below before you can select this 
checkbox.

This option controls the default setting. You can change your mind about 
whether to digitally sign an individual message.

• Use this certificate to digitally sign messages sent from this account: If this 
field is empty or displays the wrong certificate, click the triangle to choose 
another certificate from the drop-down list.

Encryption

You use the Encryption area in the Security panel to specify how you routinely 
want to use encryption when sending your messages:

• Encrypt messages by default. Select this checkbox if you want to encrypt all 
the messages you send.

This option controls the default setting. You can change your mind about 
whether to encrypt an individual message.

• Use this certificate to encrypt and decrypt messages for this account: If this 
field is empty or displays the wrong certificate, click the triangle to choose 
another certificate from the drop-down list.

Import Certificate: Click to import a certificate backup file that already exists on 
your hard disk.

Manage Certificates: Click to open Communicator Identity Manager, where you 
can view and change preferences and settings for your certificates.

Refresh Certificates: Click to force an immediate refresh of the certificates 
available in the drop-down lists.

Related topics:

Getting Started With Identity Manager (page 231) 
Getting Your Own Certificate (page 235) 
Managing Certificates (page 236) 
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This document is provided by AOL for your information only. It may help you 
take certain steps to protect the privacy and security of your personal information 
on the Internet. This document does not, however, address all online privacy and 
security issues, nor does it represent a recommendation by AOL about what 
constitutes adequate privacy and security protection on the Internet.
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Chapter 6

Using Instant Messenger™ for AOL®

Communicator

 

Using Screen Names (page 128)
Signing On and Off (page 131)
Using the Buddy List® Window (page 135)
Sending Instant Messages (page 149)
Using Chat Rooms (page 154)
Controlling Privacy & Security (page 157)

Related topics: 

“Buddy List® Basics” (page 25)

This document is provided by AOL for your information only. It may help you 
take certain steps to protect the privacy and security of your personal information 
on the Internet. This document does not, however, address all online privacy and 
security issues, nor does it represent a recommendation by AOL about what 
constitutes adequate privacy and security protection on the Internet.
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Using Screen Names
You must have at least one AOL® member screen name to use AOL® 
Communicator. 

Once you have created your first AOL Communicator Mail account using a valid 
AOL member screen name, you can use the same screen name to sign on to Instant 
Messenger™ for AOL® Communicator. You can also sign on using additional AOL 
member screen names, AIM® screen names, or ICQ® IDs. 

Each of your AOL member screen names and AIM screen names has its own 
password and AOL email address.

Registering a New Screen Name (page 128)
Creating an Additional AOL Screen Name (page 129)
Changing Your Email Address (page 129)
Changing Your Password (page 130) 

Registering a New Screen Name
If you don’t yet have a screen name, there are three main ways to get one:

• Sign up for an AOL account at http://www.aol.com

• Sign up for an Instant Messenger™ account at http://www.aim.com 

• Sign up for a Netscape® account at http://home.netscape.com 

If you already have an AOL account and want to create an additional screen name 
for that account, see the next section, “Creating an Additional AOL Screen Name.”
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Creating an Additional AOL Screen Name
Each America Online® account can have up to seven screen names at any one time.

The screen name you chose when you first registered your America Online 
membership is your master screen name and cannot be deleted or changed. Other 
screen names that you create can be deleted at any time.

To create a new screen name for your AOL account:

1. Sign on to America Online with a master screen name (the first screen name 
you created when you registered your AOL membership, or another screen 
name you have designated as an additional master screen name). 

2. Open the Settings menu on the AOL toolbar and click Screen Names. 

3. In the AOL Screen Names window, click Create a Screen Name. 

Read and follow the instructions for creating a screen name, selecting a password, 
and designating the Parental Controls category for the new screen name.

Notes on Screen Names: 

• Screen names can have from three to sixteen characters (letters, numbers, 
and/or spaces). The first character in a screen name must be a letter, and will 
be capitalized automatically. 

• If the screen names you select are already in use, AOL will suggest a screen 
name for you. If you do not like the suggestion, just delete the suggested screen 
name and try again. There is no limit on how many times you can try different 
names. 

• America Online reserves the right to delete any screen name it deems to be in 
violation of the AOL Terms of Service (TOS). 

Changing Your Email Address
Whether you can change the main email address associated with a screen name 
depends on how you first registered the screen name.

• AOL Instant Messenger Screen Name: To change an email address associated 
with an AOL Instant Messenger screen name, you must be running AIM 5.1 or 
a later version. (AIM 5.1 is a standalone AIM client that can be run 
independently of AOL client software or other software that includes AIM, 
such as AOL Communicator or Netscape 7.0.)
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The email address for your screen name is normally the screen name followed 
by “@aol.com”.

• Netscape Screen Name: If you have a screen name for use with the Netscape 
Network, there are two email addresses associated with the screen name:

The email address you specified when you first signed up. To change it, use 
your screen name to log on at http://home.netscape.com and click My 
Account.

The email address formed by adding “@netscape.net” after the screen name. 
You cannot change this email address.

• AOL Member Screen Name

You cannot change an email address associated with an AOL member screen 
name. 

The email address for each of your screen names is simply the screen name 
followed by “@aol.com”. 

Changing Your Password
The procedure for changing your screen name password varies slightly depending 
on the type of screen name you’re signed on with:

• If your screen name is one of those associated with your AOL member account, 
you must change it from within the AOL client software (such as AOL 8.0).

• If your screen name is one that you obtained for use with AOL Instant 
Messenger™ (AIM®) software only, you must change it at the AIM web site.

In either case, you start the same way from your Buddy List® window:

1. Make sure you are signed on to the appropriate service using the screen name 
whose password you want to change.

2. From your Buddy List window, open the MyIM menu and choose Change 
Password.

If you’re signed on with an AOL member account screen name, you’ll see a 
window informing you that you’re about to launch the AOL client. In this case, 
go to step 3.

If you’re signed on with an AIM screen name, your browser opens to the page 
at aim.aol.com where you can change that screen name’s password. In this 
case, go to step 4.
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3. If the AOL software opens, click Change Password, type your current 
password, then type the new password twice and click Change Password to 
save the change.

Your new AOL member password is now set and ready to start using with the 
screen name that you’re currently signed in with.

4. If your browser opens to the page for changing your AIM password, type the 
screen name whose password you want to change (if it’s not already entered 
for you), type your current password, then type the new password twice and 
click Continue.

Your new AIM password is now set and ready to start using with the AIM 
screen name that you’re currently signed in with.

Related topics: 

Using the Password Quality Meter (page 216) 

Signing On and Off
Signing On to the Instant Messenger Service (page 131)
Signing On Automatically (page 132)
Saving Your Password (page 133)
Switching Screen Names or ICQ® IDs (page 133) 

Settings & Preferences:
Sign On/Off Preferences (page 134) 
Connection Preferences (page 134) 

Signing On to the Instant Messenger Service
To sign on to the Instant Messenger service:

1. Launch Instant Messenger for AOL Communicator.

2. Type the screen name you want to use. 

3. Type your password.

If you leave Save Password selected, you won’t have to type your password 
the next time you sign on.
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If you leave Auto sign on selected, the Instant Messenger software will sign 
you on automatically the next time you launch the program.

4. Click Sign On.

Related topics:

Buddy List Basics(page 25) 
Switching Screen Names or ICQ® IDs (page 133)) 
Sign On/Off Preferences (page 134) 

Signing On Automatically
You can set up Instant Messenger for AOL Communicator to sign you on 
automatically whenever you launch the program.

To set the Auto sign on preference from the Sign On window:

1. Launch Instant Messenger for AOL Communicator.

2. In the Sign On window, make sure the currently selected screen name is the 
one you want to sign on with automatically.

If you want to set the preference for a different screen name, select it from the 
drop-down list or type it.

3. In the Sign On window, click the Auto sign on checkbox to select it.

4. Click Sign On.

The next time you launch Instant Messenger for AOL Communicator, you won’t 
see the Sign On screen. Instead, the program signs you on automatically and your 
Buddy List window appears.

To set the Auto sign on preference from your Buddy List window:

1. Open the MyIM menu and choose Preferences.

2. Click Sign On/Off in the Category column.

3. Under Sign On, click the checkbox labeled “Automatically sign on when AIM 
starts” to select or deselect it.

4. Click OK.
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Saving Your Password
To save your password so you don’t have to type it every time:

1. Launch Instant Messenger for AOL Communicator.

2. In the Sign On window, make sure the currently selected screen name is the 
one you whose password you want to remember.

If you want to save the password for a different screen name, select it from the 
drop-down list or type it.

3. In the Sign On window, click the Save Password checkbox to select it.

4. Click Sign On.

The next time you sign on to Instant Messenger for AOL Communicator, your 
saved password will be sent automatically.

To change your Save Password setting from the Buddy List window:

1. Open the MyIM menu and choose Preferences.

2. Click Sign On/Off in the Category column.

3. Under Sign On, click the checkbox labeled “Save Password” to select or 
deselect it.

4. Click OK.

Switching Screen Names or ICQ® IDs
You can sign on to Instant Messenger for AOL Communicator using an AOL 
screen name, an AIM or Netscape screen name, or an ICQ ID. However, the Instant 
Messenger interface currently uses Instant Messenger terms (such as “buddy” 
rather than “contact”) rather than ICQ terms, even when you’re logged onto ICQ.

Each time you sign on using a new screen name or ICQ number, Instant Messenger 
for AOL Communicator stores that information (and the associated password, if 
you choose to save it) and adds it to the drop-down list beside the screen name 
field in the sign-on window.
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To switch from one AOL screen name or ICQ number to a different one:

1. Launch Instant Messenger for AOL Communicator.

2. In the Sign On window, type the screen name and password that you want to 
switch to.

If have you have previously used this screen name, you can select it from the 
drop-down list instead of typing it.

3. Click Sign On.

To switch screen names from the Buddy List window:

Open the MyIM menu and choose Sign On As a Different User. 

You can then select or type a different screen name (or ICQ number) and password 
in the SIgn On window as described above.

Sign On/Off Preferences
If you aren’t already viewing your Sign On/Off preferences, open the MyIM menu, 
choose Preferences, and click Sign On/Off.

Sign On

• Save Password: When this option is selected, Instant Messenger for AOL 
Communicator remembers your password and enters it for you automatically 
when you sign on.

• Automatically sign on when AIM starts: When this option is selected, Instant 
Messenger for AOL Communicator signs you on automatically whenever you 
launch the program.

Related topic:

Buddy List® Setup (page 141) 

Connection Preferences
If you aren’t already viewing your Connection preferences, open the MyIM menu, 
choose Preferences, and click Connection. 

You can also open your Connection preferences by clicking the Connection button 
on the Instant Messenger Sign-On window.
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If you access the Internet through an Internet service provider, you most likely will 
not need to make any changes to your Connection preferences. If you access the 
Internet through a local area network firewall (for example, at your workplace), 
then your network administrator may need to supply information so that you can 
configure the proxy section of the Connection preferences panel.

Server Settings

• Host Name: The default name of the instant messaging server. Under normal 
circumstances, you do not need to change this address. 

If your proxy server needs to resolve the host name, you may need to type the 
IP address instead of the name of the server in this field. You can obtain the IP 
address from your network administrator.

• Port Number: The default server port number for the instant messaging server. 
Under normal circumstances, you don’t need to change this field.

Proxy Settings

• Connect using proxy: Click this button to activate the Instant Messenger proxy 
server controls. Enter the appropriate proxy host, port number, protocol, and 
authentication information after obtaining it from your network administrator. 

Using the Buddy List® Window
The Buddy List® Window (page 136)
Setting Up Buddies and Groups (page 138)
Using the Recent Buddies Group (page 138)
Setting Alerts (page 139)
Getting Buddy Information (page 140)
Using Away Messages (page 141)

Settings & Preferences:
Buddy List® Setup (page 141)
Buddy Info (page 142)
Away Message Preferences (page 143)
Buddy List® Preferences (page 144)
Fonts Preferences (page 145) 
Sound Preferences (page 145) 
Incoming Expressions Preferences (page 146) 
Outgoing Expressions Preferences (page 147) 
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The Buddy List® Window
When you sign on to Instant Messenger or ICQ software, your Buddy List window 
appears. Folders for three groups are automatically created for you: Buddies, 
Family, and Co-Workers. 

Buddy List information is stored on a server rather than on your computer. You 
can open your Buddy List window from any online computer, whenever you sign 
on.
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Buddy icons
from AOL
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Setting Up Buddies and Groups
It’s easy to add buddies and groups and move them around:

• To add a buddy or group while you are viewing the Buddy List window, open 
the Actions menu and choose Add Buddy or Add Group.

• To move a buddy or group to a different location in the Buddy List window, 
click and drag it to the desired location. 

• To move, add, delete, rename, or sort buddies and groups, click Setup.

Related topics:

Buddy List® Setup (page 141)

Using the Recent Buddies Group
When you exchange instant messages with people you haven’t already added to 
your Buddy List window, their names automatically show up under Recent 
Buddies. This special group, located just above Offline buddies at the bottom of the 
list, makes it easy to see who you’ve been communicating with recently.

People who are already listed in any of your other Buddy List groups aren’t added 
to the Recent Buddies group.

To move one of your Recent Buddies permanently to another group, just drag the 
buddy’s name to the group you want. 

You cannot move or rename the Recent Buddies group, or add buddies to it 
manually. You can delete individual buddies from the list.

To stop or start adding Recent Buddies automatically: 

1. Open the MyIM menu and choose Preferences.

2. In the Buddy List category, look at the option labeled:
Add people I exchange IMs with to my Recent Buddies Group

When this option is not selected, any names under Recent Buddies will remain 
on the list, but new names will not be added. 

When this option is selected, buddies with whom you exchange instant 
messages will be added to the list automatically.
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3. Click OK to confirm your choice.

Deleting the Recent Buddies group has the same effect as deselecting the Recent 
Buddies option.

Related topic:

Setting Up Buddies and Groups (page 138) 

Setting Alerts
Instant Messenger for AOL Communicator can notify you every time one of your 
buddies signs on, returns after being away from his or her computer, or becomes 
available again after not using the Instant Messenger software for a while. This 
kind of notification is called an alert.

Simple Alerts
The easiest way to set an alert is to select a name in the Buddy List window and 
click the Alert button near the bottom of the list (or open the Actions menu and 
choose Set Buddy Alert):

Alternatively, right-click one or more buddies and choose Set Alert.

After you set an alert, the alert bell icon appears beside the buddy’s name if the 
buddy is offline or idle or has set an Away Message.

An alert set in this manner includes all alert options:

• You will be alerted when the buddy does any of the following:

❍ Signs on to the Instant Messenger service.

❍ Starts using the service after having been idle.

❍ Dismisses his or her Away Message after returning to the computer.

• You will be alerted in two ways:

❍ An alert window will pop up.

❍ A sound will play (unless your computer’s volume is turned down or 
muted).



Using the Buddy List® Window

140 AOL Communicator Help • 25 July 2003

When the alert window pops up, it includes this checkbox:

• Always alert for this buddy: 

If this checkbox is selected, the alert will be triggered every time the buddy 
becomes available. 

If this checkbox is not selected, the alert will not be triggered the next time the 
buddy becomes available.

Custom Alerts
If you want to limit actions by this buddy that trigger an alert, limit the way you 
will be alerted, or select the sound used for this buddy’s alerts, follow these steps:

1. Select the buddy’s name and click the Info button near the bottom of the list (or 
open the Actions menu and choose View Buddy Info).

2. Click the Alerts tab.

3. Set the characteristics of the alert. For details, see “Buddy Info” (page 142).

Getting Buddy Information
To get information about a buddy, select the buddy’s name in the Buddy List 
window and click the Info button (or open the Actions menu and choose View 
Buddy Info):

The Buddy Info window for that buddy opens. It displays the time the buddy has 
been signed on or idle, and the buddy's warning level, if any. Click the tabs for 
more details, or click the Help button.

If the buddy isn't signed on, no information is available.

Related topics: 

Setting Alerts (below) describes how to use the Alerts tab.
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Using Away Messages
If you’re going to be away from your computer briefly, you can turn on an Away 
Message that will be displayed whenever anyone attempts to send you an instant 
message.

To set, edit, or add an Away Message, click the Away Message button near the 
bottom of the Buddy List window and choose an item from the menu:

• Default Away Message: Choose this to trigger the current default Away 
Message.

• Other Away Messages: Other Away Messages that you may have created also 
appear in this list. Choose the one you want.

• Edit Away Message: Choose this to open the Away Message Preference Panel, 
where you can add and edit alternative Away Messages for different 
situations.

Related topics

Away Message Preferences (page 143)

Buddy List® Setup
If you aren’t already viewing Buddy List Setup, click Setup in your Buddy List 
window, or open the MyIM menu and choose List Setup. 

To change the order in which groups or buddies are listed, click the item you want 
to move and drag it to its new position.

You can take these actions at any time:

• Add Buddy: Click this button to specify a new buddy’s screen name and the 
group where you want the new buddy listed. 

You must type the exact screen name. 

• Add Group: Click this button to name a new group. 

After you type the new group’s name and click OK, the group shows up at the 
bottom of the list on the left. You can then click the new group and drag it to 
the location you want it to appear in your Buddy List window.
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To take these actions, you must first select at least one buddy or group:

• Remove: Delete the selected buddies or groups.

• Rename: Rename the selected buddy or group (in this case a single buddy or 
group must be selected)

• Sort Group: Sort the selected group alphabetically.

• Alert: Set alerts for the selected buddies. (If a buddy is not selected, you will be 
asked to type the buddy’s screen name.)

The Preferences button allows you to adjust preferences such as fonts, privacy 
settings, sounds, and so on.

Related topics: 

Setting Up Buddies and Groups (page 138)

Buddy Info
If you aren’t already viewing Buddy Info, select the buddy’s name in the Buddy 
List window and click the Info button.

The following information appears in the top-right corner (for online buddies 
only):

• Online Time: How long the buddy’s been online

• Service: The type of instant messaging client this buddy is currently using.

• Warning Level: A buddy’s warning level indicates how frequently that user 
has been warned by other users who received annoying messages.

The tabs display details about this buddy:

Contact Info: Displays your contact entry for this buddy, if any. 

To edit the buddy’s contact entry, click Edit Contact Info. 

If the buddy isn’t included in any of your own categories, but does have an 
entry in an online directory that you’ve configured for use with Address Book, 
Edit Address Book Info opens a new entry based on the online directory entry. 

You can then edit the entry, if necessary, and add it to one of your own 
categories, using the drop-down list near the top of the Contact Entry window.

Away Message: The buddy’s Away Message (if the buddy has activated it).
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Capabilities: Features available in the instant messaging client this buddy is 
currently using.

Alerts: Details of the alert for this buddy. If you select any options under one of 
these items, you must select at least one item under the other:

• Notify me when buddy: Select checkboxes for the action(s) by this buddy that 
you want to generate an alert. 

• Notify me by: Select checkboxes for the method(s) of notification you want to 
use. 

If you to be notified by a sound, you can choose one from the drop-down list or 
browse to locate a sound file on your hard disk. Click Preview to hear the 
selected sound.

• Always use this alert for this buddy: 

If this option is not selected, the alert information you set here lasts only until 
the buddy is available again and you are alerted. You will be alerted only once.

If this option is selected, the alert information you set here will remain set 
even after you are alerted that the buddy is available, so that you continue to 
be alerted every time the buddy becomes available.

Notes: You can use this area to store miscellaneous information about this buddy. 
The information is stored on a server rather than your computer, so it’s available 
no matter what computer you log in from.

Send IM: Click this button to send an instant message to this buddy.

Away Message Preferences
Away Message Preferences allow you to create or delete custom Away Messages. 

When you set an Away Message and a buddy sends you an instant message, your 
currently selected Away Message (if any) will be displayed in response.

• To set an Away Message from among those currently available, click the 
Away button near the bottom of the Buddy List window and choose the name 
of the message you want to use.

• To display Away Message Preferences so you can add or delete Away 
Messages, click the Away button and choose Edit Away Message.
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Away Message Preferences include these options:

Labels for Away Messages: The left column lists the labels for your existing Away 
Messages. Click a label to display the corresponding message in the right column. 

Click these buttons to take the actions indicated:

• New: Displays a window where you can type a new message label and 
message text. 

• Edit: Select an Away Message label and click this button to edit message’s label 
or text.

• Delete: Select an Away Message label and click this button to delete the 
message.

When I’m Away: 

• Hide Instant Message windows: Select this option to hide all your Instant 
Message windows automatically when you turn on your Away Message. 

The hidden message windows reappear when you click “I’m Back”.

• Mute sounds: Select this option to mute all Instant Messenger sounds while 
your Away Message is turned on.

• When idle respond with this message: Select this option to display the 
message that you type below when you’re idle.

The message shown here will be sent automatically to anyone who sends you 
an instant message while you’re idle.

Buddy List® Preferences
If you’re not already viewing the Buddy List preferences, open the MyIM menu, 
choose Preferences, and click Buddy List.

Enable Forwarding of Instant Messages to your cell phone: Click this link to open 
a web page that allows you to enable or disable forwarding of all your instant 
messages to your cell phone.

This feature requires a text- or Internet-enabled mobile device and an enabled 
wireless service plan. Additional charges may apply from your wireless provider, 
depending on your service plan. Contact your wireless service provider for details.

Dim buddies after they have been idle for 20 minutes: When this option is 
selected, a buddy’s name dims (turns gray) if that buddy hasn’t used Instant 
Messenger software for 20 minutes.
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Add people I exchange IMs with to my Recent Buddies group. When this option 
is selected and you exchange instant messages with people who aren’t already 
listed in your Buddy List window, their screen names appear in a special group 
called Recent Buddies at the bottom of the list, just above Offline. 

If you deselect this option, names will no longer be added to the Recent Buddies 
group. If you remove the Recent Buddies group, this option will be automatically 
deselected.

Fonts Preferences
If you’re not already viewing the Fonts preferences, open the MyIM menu, choose 
Preferences, and click Fonts.

Settings for: Choose the type of fonts settings you want to see from the drop-down 
list: for your Buddy List window, for instant messages that you send, or for chat 
messages that you send. 

Font face: From the drop-down lists, choose the font and font size in which you 
want your buddies’ names to be displayed. 

Font preview: This area shows what the currently selected font settings will look 
like.

Sound Preferences
Sound preferences allow you control the sounds that identify various events while 
you’re logged on, such as a buddy signing on or off.

If you’re not already viewing Sound preferences, open the MyIM menu, choose 
Preferences, and click Sound.

Note: The selections you make here may be overridden by selections you make in 
Incoming Expressions Preferences (page 146) under the heading Choose what you 
want to hear from others. 

Buddy List Sounds

Use this area to control the sounds triggered by any buddy signing on or off. Select 
the checkbox for each action that you want to trigger a sound.

For each selected action, choose a sound from the drop-down list. To hear the 
currently selected sound, click Preview.
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IM Sounds

Use this section to control the sounds triggered whenever a buddy sends you an 
instant message. Select the checkbox for each action that you want to trigger a 
sound:

Play a sound when first receiving a message: This is the sound you’ll hear if you 
don’t already have a message window open for the buddy who is sending the 
message.

Play a sound when sending a message: This is the sound you’ll hear when you 
click Send.

Play a sound when receiving a message: This is the sound you’ll hear if you 
already have a message window open for the buddy who is sending the message.

For each selected action, choose a sound from the drop-down list. To hear the 
currently selected sound, click Preview.

Incoming Expressions Preferences
Incoming Expressions preferences control whether you see the following AOL 
Expressions set by others:

If you’re not already viewing Incoming Expressions preferences, open the MyIM 
menu, choose Preferences, and click Incoming Expressions.

Choose what you want to see from buddies

Buddy Icons: Choose one of the following options from the drop-down list:

❍ Show me other members’ AOL® Buddy Icons in instant messages: Select 
this option to block all icons displayed in messages from other people 
except for those available from AOL version 8.0 or later versions (the AOL 
Buddy Icons).

❍ Show me other members’ AOL Buddy Icons and icons from Internet 
users on my Buddy List: Select this option to accept all types of icons in 
messages from other people who are listed in your Buddy List window. 
(This is the default option.)

❍ Do not show me Buddy Icons: Select this option to block all icons 
displayed in messages from other people.

Wallpaper: Choose one of the following options from the drop-down list:
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❍ Show me other members’ wallpaper in AOL instant messages: Select this 
option to see the background wallpaper that users of AOL Communicator 
or AOL version 8.0 (or later versions) can use in their messages.

❍ Do not show me wallpapers: Select this option to see a plain background 
for all instant messages that you receive.

Choose what you want to hear from others

Other people can choose sounds to play when they perform various actions (such 
as signing on or off), and you can also choose sounds for the same actions. 

These options allow you to select which sounds other people’s actions will trigger:

• Do not play any sounds at all: If you select this option, you won’t hear any 
sounds when buddies sign on or off or sends you a message.

• Play other members’ AOL sounds: If you select this option, you’ll hear the 
sounds that other members’ have specified for the AOL service.

• Use the custom sounds selected in the Sounds panel: If you select this option, 
you’ll hear the sounds that you have specified in your Sounds preferences. 
Click Sounds on the left side of the Preferences window to see what they are.

Outgoing Expressions Preferences
Outgoing Expressions preferences control the personal icons, smileys, wallpaper, 
and sounds that your buddies will see or hear when you send them messages.

If you’re not already viewing Outgoing Expressions preferences, open the MyIM 
menu, choose Preferences, and click Outgoing Expressions.

The sections that follow describe the corresponding preferences:

Outgoing AOL Expressions (page 148) 
Outgoing AOL Instant Messenger (AIM) Expressions (page 148) 
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Outgoing AOL Expressions

You must have AOL 8.0 (or later versions) on your computer to set these 
preferences. Each of the links in this area opens the AOL client software to the area 
where you can set the corresponding Expressions:

• My Buddy Icon: Select one of the AOL icons as your buddy icon. 

• My Smiley Theme: Select one of the AOL smiley themes (different ways of 
drawing the same set of smileys). 

Versions of AOL software earlier than 8.0 may not be able to display smiley 
themes.

• My IM Wallpaper: Allows you to spice up your instant message conversation 
window by choosing a background wallpaper that will be displayed to you 
and other users of AOL Communicator or AOL 8.0 (or later versions).

• My IM and Buddy Sounds: Allows you to select personal sound to be played 
on your buddy's computer whenever you do any of the following: send that 
person an instant message, appear in that person's Buddy List window (Buddy 
In), or sign off (Buddy Out). 

Your buddy must be using either AOL Communicator or AOL 8.0 (or higher), 
and must have Instant Messenger preferences for Incoming Expressions set to 
"play other member's sounds" to hear the personal sound you have chosen.

Outgoing AOL Instant Messenger (AIM) Expressions

AIM buddy icons do not appear with your messages to buddies who are using the 
AOL client. AIM buddy icons may or may not appear with your messages to 
buddies using other AIM software, depending on their individual preference 
settings.

To select one of the standard AIM icons: Click Set Icon, scroll through the list of 
categories, and click the category you want. Then click the icon you want to use 
and click OK.

To select a custom icon available on your hard drive: Click Set Icon, then click 
Browse to specify its location. After you have done so, click OK to confirm your 
selection and dismiss the Set Icon window.
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Sending Instant Messages
Sending an Instant Message (page 149)
Adding Formatting, Smileys, and Links (page 150)
Using Time Stamps (page 151)
Ending a Conversation and Signing Off (page 151)
Sending and Receiving Files or Folders (page 152)

Settings & Preferences:
Send File or Folder (page 152) 
Receive File or Folder (page 153) 
File Transfer Preferences (page 154) 

Related topic:

Using the Buddy List® Window (page 135). 

Sending an Instant Message
Follow these steps to create and send an instant message:

1. If you’re not viewing your Buddy List window, open the Window menu of any 
other AOL Communicator application and choose Instant Messenger.

If you’re not already signed on, you may need to provide your screen name 
and password.

2. You can send an instant message in two ways:

To send an instant message to a person in your Buddy List who is currently 
online, double-click the person’s name. 

A window opens where you can type your message. The To field is filled in 
automatically.

To send an instant message to a person who’s not in your Buddy list, click the 
IM button (or open the Actions menu and choose Send Instant Message) and 
type the person’s screen name.

3. Type your message in the composition area of the Instant Message window.

4. Click the Send button or press Enter to send the message.

You see your message in the top pane of the message window. Your buddy's 
response will appear below it. You can continue typing and sending messages 
as long as you and your buddy want to converse. 
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Related topics:

Adding Formatting, Smileys, and Links (page 150) 
Using Time Stamps (page 151) 
Sending and Receiving Files or Folders (page 152) 

Adding Formatting, Smileys, and Links
You can format both instant messages and chat room messages as described here.

To change the font, size, or style of selected text: 

1. Select the text you want to change. 

2. Click in the formatting bar at the top of the message composition area to format 
the selected text:

• Choose the font and size you want to use from the drop-down lists. 

• Click the icons to apply styles to the text.

To add a hyperlink to a message:

1. Copy the hyperlink (also known as URL, for example: http://www.aol.com). 

For example, select the URL in the browser’s location bar while you are 
viewing the web page you want to link, open the Edit menu, and choose Copy.

2. Make sure your cursor is positioned at the point in the instant message 
composition area where you want the link to appear.

3. Paste the link you copied directly into the composition area. When you send 
the message, the recipient can click the link to view the web page.

Alternatively, click the globe icon in the formatting bar at the top of the 
message composition area, type the URL into the field provided, and click OK 
to insert the link at the cursor’s location.

To add a smiley to a message: 

1. Make sure your cursor is positioned at the point in the instant message 
composition area where you want the smiley to appear. 

2. Open the Actions menu and choose Insert Smiley (or click the Smiley icon near 
the top of the instant message window.

3. Click the smiley that you want to insert.
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Related topics:

To change smiley themes (different ways to display smileys), see Outgoing 
Expressions Preferences (page 147).

Using Time Stamps
While you’re sending and receiving instant messages, you can choose to display 
the exact time that each message is sent.

By default, time stamps are turned off.

To turn timestamps on or off for all instant message windows: 

1. From any instant message window, open the View menu

2. Locate the Timestamps menu item. If it has a checkmark beside it, time 
stamping is on. 

3. If necessary, select Timestamps to change the setting.

Ending a Conversation and Signing Off
A conversation ends when both parties stop sending instant messages. To close the 
message window, click the close box.

If the other person continues to send messages after you have closed the message 
window, you will continue to receive message notifications, unless you block that 
person from sending you messages. 

To sign off the Instant Messenger service, open the MyIM menu and choose one of 
the following:

• Sign Off and Exit closes the Instant Messenger window and signs you off. You 
will no longer show up as “online” in other people’s Buddy List window.

• Sign On As a Different User signs you off and opens the Sign On window, 
from which you can sign back on as a different user.
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Sending and Receiving Files or Folders
To send a file or folder to one of your buddies:

1. Right-click the person’s name in the Buddy List window and choose Send File 
or Folder.

2. Click the File or Folder to select the item you want to send. 

3. Type the message, if any, that you want your buddy to see when the file or 
folder arrives.

4. Click Send.

Alternatively, you can drag and drop the file you want to send:

1. Locate the file that you want to send on your computer’s desktop.

2. Place the pointer over the file icon, drag the icon over your Buddy List 
window, and drop it (release the mouse button) when the pointer’s over the 
name of the person to whom you want to send the file.

Alternatively, if an instant message window for that buddy is already open, 
you can drag the file icon directly into the instant message window.

3. Type the message, if any, that you want your buddy to see when the file or 
folder arrives.

4. Click Send.

To receive a file or folder: When a buddy sends you a file or folder, you’ll see a 
window asking whether you want to accept it. Verify that the file is coming from 
someone you know before you accept the transfer.

Send File or Folder
There are three ways to send a file or folder to one of your buddies:

• Right-click the person’s name in the Buddy List window and choose Send File 
or Folder. 

• Drag the file or folder you want to send over your Buddy List window and 
drop it (release the mouse button) when the pointer’s over the name of the 
person to whom you want to send the file.
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• Drag the file or folder into an instant message window for the buddy you want 
to send it to.

All three of these actions open the Send File or Folder window:

File: Click to select the file you want to send (if it’s not already selected).

Folder: Click to select a folder that you want to send (if it’s not already selected).

Accompanying message: Type the message, if any, that you want your buddy to 
see when the file or folder arrives.

Send: Click Send to send the item.

Receive File or Folder
The Receive File or Receive Folder window appears when someone uses Instant 
Messenger software to send you a file or folder.

Be cautious about accepting a file or folder transfer from someone you don’t know. 
It may contain a computer virus.

Incoming file (or folder) transfer from: The screen name of the person sending 
you the file. Make sure you recognize the person before you accept the transfer.

Name, Size, Type: This information describes the file or folder:

• If it’s a file, check to make sure it corresponds to a file you would expect this 
buddy to transfer. 

• If you have a slow Internet connection, a large file may take a long time to 
download.

Accompanying Message: This area displays a note from the buddy who is sending 
you the file. An accompanying message is not required, so this may be blank.

Accept: Click to accept the file and save it to your hard disk.

Reject: Click to reject the file. It will not be saved to your hard disk.

Warn: Click to increase the sender’s warning level and reject the file.
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File Transfer Preferences
If you’re not already viewing your File Transfer preferences, open the MyIM menu, 
choose Preferences, and click File Transfer.

Incoming file transfer requests: This setting controls how Instant Messenger for 
AOL Communicator treats incoming file transfers. Select one of the options 
available.

Files sent to me: This field specifies where files sent to you are stored. Click Folder 
to change the location.

Using Chat Rooms
Inviting Buddies to Chat (page 154)
Sending a Chat Message (page 155)
Sending an Instant Message from a Chat Room (page 156)
Stopping Messages from People in a Chat Room (page 156)
Ending a Chat (page 156) 

Inviting Buddies to Chat
To invite a buddy to chat:

1. If your Buddy List window isn’t visible, choose Instant Messenger from the 
Window menu in any AOL Communicator window.

If you’re not already signed on, enter your screen name and password and 
click Sign On.

2. In your Buddy List window, select the names of the people you want to invite 
to the chat room. 

To select multiple names, hold down the Ctrl key as you select each name. 

To invite all the buddies in a group, select the name of the group.
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3. Open the Actions menu and choose Send Chat Invitation.

The Buddy Chat Invitation window opens. 

If you want to send the invitation to additional buddies, type their screen 
names in the “Screen names to invite” field. You can either type one screen 
name on each line or separate the screen names by commas. 

You can also change the default invitation message.

4. Click Invite to send the invitation.

When a buddy accepts your invitation, Instant Messenger for AOL 
Communicator displays a message indicating that the buddy has entered the 
room. You can start typing your chat messages in the text area after you receive 
the notification. The same message is displayed for each invitee.

You can also invite a buddy to join a chat in progress. To do so, open the Actions 
menu and choose Invite Others; or just drag names from the Buddy List window 
into the Chat Room window’s list of participants.

Sending a Chat Message
To send a chat message:

1. Type the message that you want to send in the text area box near the bottom of 
the Chat window. 

You can format chat messages in much the same way that you can format 
instant messages: with links and smileys, different fonts, or styles such as bold, 
italic, or underlining. 

2. Click Send.

When you are finished with your chat conversation, you can open the File menu 
and choose Save this Chat to save the conversation to a file. 

Related topic:

Adding Formatting, Smileys, and Links (page 150) 
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Sending an Instant Message from a Chat Room
You can send someone participating in a chat conversation an instant message 
directly from the Chat Room window. Follow these steps:

1. In the Chat Room window, select the name of the person to whom you want to 
send an instant message.

2. Click the Send IM button.

3. Type your message in the Instant Message window that appears.

4. Click Send.

Stopping Messages from People in a Chat Room
To stop receiving messages from one or more people in the chat room:

1. Select the person’s screen name in the field that lists participants in the chat 
room.

2. Click Ignore. An X appears next to the selected screen name. Click Ignore again 
to turn the Ignore feature off.

Once you've clicked Ignore, you won't see any messages from those people whose 
screen names you selected. However, others in the chat room will continue to see 
messages from those people. 

Ending a Chat
A chat ends when all parties close their chat windows. To close your chat window, 
click the close box.

When you finish a chat, your Buddy List window remains open and you can 
continue to send instant messages or start new chats.
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Controlling Privacy & Security
Controlling Your Privacy (page 157)
Setting Warnings (page 159)
Signing & Encrypting Instant Messages (page 159) 

Settings & Preferences:
Privacy Preferences (page 160) 
Security Preferences (page 162) 
Add Certificate (page 163) 
Knock-Knock Message (page 164)

Controlling Your Privacy
You can set Instant Messenger preferences that control who can send you messages 
and how much information about you other users can have.

To view or change your Privacy preferences:

1. From the Buddy List window, open the MyIM menu and choose Preferences. 

2. Click Privacy.

3. Adjust your settings as necessary:

The left column under “Who can contact me” specifies which users are allowed 
to contact you. 

The right column under “Who can contact me” lets you specify which users 
you want to block, so they can’t contact you.

The checkboxes near the bottom of the window control what information 
about your activities users can see, and how you are informed about other 
users who attempt to contact you.

Related topics:

Privacy Preferences (page 160) describes the available options in more detail.

Blocking and Unblocking Users (page 158) describes how to block users from the 
Buddy List window or from an instant message window.
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Blocking and Unblocking Users
You can block one or more users so they can't send you messages. 

This feature is useful if you want to block users who send offensive messages or if 
you simply do not want to receive messages for a while. 

When you block a user, that user appears to be offline in your Buddy List window, 
and you appear to be offline in that user’s Buddy List window. 

You can unblock a blocked user at any time by removing their name from the 
blocked list under Privacy preferences.

To block a user whose name is displayed in your Buddy List window:

1. Right-click the name of the user you want to block.

2. Choose Block.

3. Click OK.

To block a user directly from an instant message window:

1. In an instant message window for the user you want to block, click the Block 
button.

2. Click Yes to confirm that you want to block that user.

To block or unblock users from your Privacy preferences:

1. From the Buddy List window, open the MyIM menu and choose Preferences.

2. Click Privacy.

3. In the right column under “Who can contact me,” you can change your 
blocking options as follows:

Block all users: Select this if you do not want to receive messages from anyone.

Block AIM users only: Select this if you want to receive messages only from 
other AOL members, and not from people using an AIM screen name.

Block the users below: Select this if you do not want to receive messages from 
certain people.

❍ To add someone to the block list, click Add Name and type his or her 
screen name.

❍ To remove someone from the block list, click his or her screen name, then 
click Remove.
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Related topics:

Controlling Your Privacy (page 157).

Setting Warnings
To warn a user who has sent you an offensive message, click Warn in the instant 
message window in which you received the message.

Warn imposes a warning on the sender, hampering that person's ability to send 
and receive messages. With frequent warnings, the user will not be able to 
exchange any messages with anyone. Only after a “cooling off” period can that 
user send and receive messages again.

When you click Warn, you can choose to impose the warning anonymously. 
Anonymous warnings are less severe and the user you are warning won't know 
who issued the warning.

Regarding warnings you send and receive:

• You can issue only one warning for each message someone sends you.

• If a user warns you, consider ending the conversation. Every additional 
message you send enables that user to warn you again.

A user’s warning level is visible to all other users next to the person's name or 
screen name in the Buddy List window. 

Signing & Encrypting Instant Messages
If you already have a digital certificate, you can set it up for use with AOL Instant 
Messenger for Communicator. This allows you to digitally sign and encrypt 
messages sent to any buddies who meet both these criteria:

• They are using a version of Instant Messenger software that supports signing 
and encryption. 

For example, AIM 5.1 and Instant Messenger for AOL Communicator both 
support signing and encryption.

• They have valid digital certificates of their own and have configured them 
correctly for use with Instant Messenger software.
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When you are exchanging signed and encrypted messages with someone, a lock 
icon and the label “Encrypted conversation” appear near the top of the instant 
message window.

If you do not yet have a digital certificate, you must obtain one before you can send 
or receive signed and encrypted instant messages.

Related topics:

If you have a certificate, see “Getting Started With Identity Manager” (page 231) for 
details on how to use it with Instant Messenger for AOL Communicator.

If you don’t have a certificate, see “Getting Your Own Certificate” (page 235) for 
guidance.

Privacy Preferences
The Privacy panel of the Instant Messenger preferences window displays the 
settings that control who can contact you and what they can find out about you 
while you’re logged on.

If you’re not already viewing your Privacy preferences, open the MyIM menu, 
choose Preferences, and click Privacy.

Who can contact me:

• Allow all users to contact me: Select this if you do not want to restrict others 
from sending messages to you.

• Allow only users on my Buddy List: Select this to receive messages only from 
those people currently in your Buddy List window, including Recent Buddies.

• Allow only the users below: Select this to specify the people from whom you 
will receive messages. Click Add Name and type the screen name for each 
person you want to add to the list.

• Block all users: Select this if you do not want to receive messages from anyone.

• Block AIM users only: Select this if you want to receive message only from 
other AOL members, and not from people using an AIM (Internet) screen 
name. 

Note that screen names for people who have signed on using software such as 
AIM 5.1 are treated as Internet screen names even if the screen name is 
associated with a paying AOL member account.
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• Block the users below: Select this if you do not want to receive messages from 
certain people. 

❍ To add someone to the block list, click Add Name and type his or her 
screen name.

❍ To remove someone from the block list, click his or her screen name, then 
click Remove.

Allow users to see how long I've been idle: Select this if you want users who can 
contact you to see that you've been away from the keyboard (idle), and for how 
long.

Allow users to see that I’m typing an IM response: Select this if you want users 
who can contact you to be informed when you are typing a response to a message 
(assuming their Instant Messenger software supports this feature).

Display a Knock-Knock before showing IMs from Internet users on my Buddy 
List: Select this if you want to be informed when one of the Internet users on your 
Buddy List wants to send you an instant message. (Messages from AOL members 
continue to appear without a Knock-Knock warning.

As with the blocking option, screen names for people who have signed on using 
software such as AIM 5.1 are treated as Internet screen names even if the screen 
name is associated with a paying AOL member account.

For users not on my Buddy List, always show me their names: Select this to help 
you identify people you receive messages from who aren’t in your Buddy List 
window. 

This option also helps you avoid displaying potentially offensive screen names.

Related topic:

Blocking and Unblocking Users (page 158) describes how to block users from your 
Buddy List window or from an instant message window.
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Signing & Encrypting Instant Messages (page 159) describes where to find 
information on using digital certificates.

Knock-Knock Message (page 164) describes knock-knocks in more detail.

Security Preferences
Security preferences allow you to specify whether you want your instant messages 
to be digitally signed and encrypted.

If you’re not already viewing your Security preferences, open the MyIM menu, 
choose Preferences, and click Security.

Enable security features in Instant Messenger for AOL Communicator: Select this 
option to turn on digital signing and encryption.

When this option is turned on, only messages sent to buddies whose software 
supports it will be signed and encrypted.

Before you can send or receive signed and encrypted messages, you must also 
select your certificates from the two drop-down lists:

• Encryption Certificate

• Signing Certificate

Add Certificate: If you don’t have any certificates available, you may be able to 
click the Add button in this section to obtain one. 

However, to take advantage of this service, you or your organization must already 
be signed up to use AIM security credentials, and the recipients of your instant 
messages must be using Instant Messenger software that is configured correctly to 
support signing and encryption.

Import Certificate: If no certificates are listed and you have a certificate backup file 
available on your hard disk, click Import Certificate to locate and import your 
stored certificates.

Manage Certificates: Click this button to view and manage your existing 
certificates.

Refresh Certificates: Click this button to update the list with all your existing 
certificates. 
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Related topics:

Signing & Encrypting Instant Messages (page 159) 
Getting Started With Identity Manager (page 231) 
Getting Your Own Certificate (page 235) 
Managing Certificates (page 236) 

Add Certificate
You see the Add Certificate window when you click the Add button in the Security 
Preferences panel for Instant Messenger for AOL Communicator.

This method of obtaining a certificate won’t work unless you or your organization 
are signed up to use AIM security credentials. For more information, see 
http://enterprise.aim.com/products/aim/personalcerts/. 

Enter your password as requested in this window to verify your identity, then click 
OK.

Passwords that can be easily guessed have little value. The password quality meter 
gives you a rough idea of the relative quality of your password as you type it based 
on factors such as length and the use of uppercase letters, lowercase letters, 
numbers, and symbols. For more information, see “Using the Password Quality 
Meter” (page 216). 

If a certificate is available for the screen name you are currently using, your new 
certificate should show up in the drop-down lists after a few minutes. 

Even if you are entitled to obtain a certificate from AOL, you can obtain only one 
per screen name. If you’ve already obtained one on a different computer (or if 
you’ve used AOL Communicator Identity Manager to delete it from this copy of 
AOL Communicator), you must import a backup of that certificate so you can use it 
with the current system. For details, see “Getting Started With Identity Manager” 
(page 231). 

If a certificate isn’t available for the screen name you’re using, you’ll see a message 
to that effect. In this case you can still obtain a certificate from some other source 
and use it to send encrypted messages. For details, see “Signing & Encrypting 
Instant Messages” (page 159).
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Knock-Knock Message
A Knock-Knock message appears when you receive an instant message from a 
screen name that is associated with an Internet account isn’t included in your 
Buddy List window. Instant messages from screen names for AOL members are 
displayed immediately, without triggering a Knock-Knock message first.

A Knock-Knock message gives you a chance to decide what you want to do with an 
instant message before it gets displayed:

Accept: Click this button to accept the message and let it be displayed.

Ignore: Click this button to ignore the message and any other messages from 
the same screen name during this session (that is, until you sign off and then 
sign on again).

Block: Click this button to block the user from sending you any messages. 
After you block a user, that user appears to be offline, and you appear to be 
offline to that user. You can unblock the user later.

Related topics:

Blocking and Unblocking Users (page 158) 
Privacy Preferences (page 160) 

This document is provided by AOL for your information only. It may help you 
take certain steps to protect the privacy and security of your personal information 
on the Internet. This document does not, however, address all online privacy and 
security issues, nor does it represent a recommendation by AOL about what 
constitutes adequate privacy and security protection on the Internet.
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Chapter 7

Using AOL® Communicator Address
Book

 Importing Contact Information (page 165) 
Managing Your Address Book (page 168) 
Managing Directories (page 177) 

Related topic:

Getting Started With Address Book (page 47) 

Importing Contact Information
Importing Contacts from Outlook or Outlook Express (page 165) 
Importing Contacts from Netscape and Other Programs (page 167) 
Exporting And Importing Contacts (page 167) 

Importing Contacts from Outlook or Outlook 
Express
To import contact information from Outlook or Outlook Express into your AOL® 
Address Book (and simultaneously into your AOL® Communicator Address 
Book), follow these steps:

1. Open the Start menu and choose Programs, then AOL Communicator, then 
Tools, then Address Book Import Assistant.

2. Type your AOL screen name and password.
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3. Click Continue.

4. Select the program or programs from which you want to import contact 
information:

Outlook: Import contact information from Outlook only.

Outlook Express: Import contact information from Outlook Express only.

Both: Import contact information from both Outlook and Outlook Express.

5. Click OK to confirm your choices.

If you are importing information from Outlook Express, you’ll be asked to 
enter your identity at this point.

A progress indicator appears while the Address Book Import Assistant imports 
the contact info. 

When the import procedure completes, your Outlook and/or Outlook Express 
contacts appear in your AOL Address Book under “Uncategorized.”

About address book synchronization: AOL Communicator synchronizes AOL 
Address Book and your AOL Communicator Address Book every time you open 
AOL Communicator Address Book or change any entry in it. 

Therefore, if you open AOL Communicator Address Book after importing your 
Outlook or Outlook Express contacts into your AOL Address Book, the new 
contacts will show up in your AOL Communicator Address Book after a minute or 
two. You’ll find them in a category labeled “General”.

However, if AOL Communicator Address Book happens to be open while you 
import your contacts, they won’t show up until you trigger synchronization by 
changing an entry, relaunching the application, or clicking OK in the AOL 
Synchronization Settings window (page 174).

If you want to sort your imported addresses into different categories, you can do so 
in either your AOL Address Book or your AOL Communicator Address Book, and 
your changes will show up the next time synchronization occurs.

Related topic:

Importing Local Mail from Outlook or Outlook Express (page 59) 
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Importing Contacts from Netscape and Other 
Programs
To import contacts from address books created with Netscape® software or other 
software that supports the LDIF format, follow these steps:

1. In the program from which you want to import address book contacts, open 
the address book and export the personal address book (category) that contains 
the contacts you want.

For example, in the Netscape® 7.x Address Book, click the personal address 
book you want to export, open the Tools menu, and choose Export. In 
Netscape® Communicator 4.x Address Book, this command is located in the 
File menu.

2. Save the resulting LDIF file in a convenient location that you can find again.

3. From AOL Communicator Address Book, open the File menu and choose 
Import.

4. Locate the LDIF file you just exported from the other application.

5. Click Open.

The contacts from the imported address book show up under the General 
category in the left pane.

Related topic:

Importing Local Mail from Netscape 7.0 (page 60) 

Exporting And Importing Contacts
You can export contacts in the form of an LDIF file (a text file in a standard format 
used by address books and directories).

To export contacts:

1. In the left pane of the main Address Book window, click the name of the 
category whose contacts you want to export.

To export all your locally stored contacts, click All Contacts.

2. Open the File menu and choose Export.

3. Locate the directory where you want to save your export file.
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4. Click Save.

All the contacts in the category you selected in Step 1 are included in the 
exported file.

To import contacts from an LDIF file:

1. Open the File menu and choose Import.

2. Locate the directory where the LDIF file you want to import is located.

3. Click Open.

If the LDIF file you imported was created by AOL Communicator Address 
Book, all the contacts in the file are imported into the same category from 
which they were exported. If the category doesn’t exist, it will be created.

Otherwise, imported contacts appear in the General category. 

Managing Your Address Book
Changing Address Book Synchronization Settings (page 169) 
Adding Contacts (page 170)
Adding Groups (page 171) 
Adding Categories (page 172) 
Managing Duplicate Contacts (page 173) 
Where Is My Screen Name Stored? (page 172) 

Settings & Preferences:
AOL Synchronization Settings (page 174) 
New Contact (page 175) 
New Group (page 176) 
New Category (page 177) 

Related topic:

Working With Your Address Book (page 47) 
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Changing Address Book Synchronization 
Settings
By default, AOL Communicator Address Book continuously synchronizes stored 
contact information with the AOL Address Book for your screen name. Updates 
occur whenever you first open AOL Communicator Address Book or change or 
add any entry.

AOL Synchronization Settings let you turn this feature on or off and synchronize 
your contacts with the AOL Address Books for different screen names.

To change your synchronization settings:

1. From the AOL Communicator Address Book window, open the Edit menu and 
choose AOL Synchronization Settings.

2. Adjust these settings:

Enable Address Book synchronization: Click the checkbox to turn 
synchronization off or on.

Screen Name: You must provide a screen name for the AOL member account 
with which you want to synchronize your Communicator Address Book 

You must enable synchronization, at least temporarily, to enter a screen name. 

By default, this is the screen name for the first AOL member account you set 
up. Even if you turn off synchronization, the screen name stored here 
determines the Address Book entries used to display email and other 
information in your Buddy List® window. 

Don’t change the synchronization screen name unless you’re willing to deal 
with changed behavior in other AOL Communicator applications as well. For 
example, a AOL member screen name must be specified here to sign on to 
Radio@AOL or My AOL Today. This screen name determines what kind of 
personalization settings you will see in those applications.

Password: If you select the “Remember password” checkbox, you must enter 
the password for the screen name.

Remember Password: Leave this option selected if you don’t want to be 
prompted for your password every time synchronization takes place.

3. Click OK to confirm your selections.
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Adding Contacts
To add a contact to one of your Address Book categories, follow these steps:

1. Click the New Contact button.

2. Type the contact’s name in the First Name and Last Name fields at the top of 
the New Contact window. This name will be displayed in your Buddy List 
window as the Friendly Name for this contact.

3. From the drop-down list, select a category in which you want to store the new 
contact.

4. Enter the following Primary Contact Information (if you have it). For each 
item, you can use the drop down lists to label it Home, Work, or Other:

E-Mail Address: Enter the main e-mail address from which this person sends 
you messages.

Screen Name: Enter the main screen name you use to communicate with this 
person via Instant Messenger software.

If you provide this information, the Buddy List window displays an envelope 
icon beside this screen name when you receive email from this email address.

5. Fill in any other information about this contact that you want to keep track of.

6. Click OK.

Related topic:

Working With Your Address Book (page 47) 
Adding a New Buddy (page 32)
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Adding Groups
A group is a set of related email addresses. If you address a message to a group, the 
message will be sent to every email address in that group when you click Send.

To create a group:

1. Control-click to select existing contacts that you want to add to the group. (This 
step is optional.)

Note that preselecting contacts in this manner won’t work for contacts listed 
under Directories.

To see all your non-directory contacts in one list, click All Contacts in the left 
pane. 

2. Click the New Group button.

The New Group window appears. If you selected any existing contacts in Step 
1, they appear in the New Group window.

3. Type a name for the new group. 

The name you specify must be unique among all group names, category 
names, and directory names in your Address Book. It appears as the name for 
this category in the list of categories in the left pane of the Address Book 
window.

4. To add an email address to the group, type it in the Address field. 

When you stop typing for a brief interval, a list of matching email addresses 
appears just below the field (“type down addressing”). Click a name to select it 
from the list. 

To add an address to the list, click Add. To remove it, select it and click 
Remove.

When you type a new address that’s not yet available as a contact, clicking 
Add brings up a window where you can type basic information for a new 
contact, which will then be added to the group. 

Clicking New Contact allows you to enter complete information for a new 
contact entry, which will then be added to the group
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5. Click OK.

The group name you specified appears under the Groups heading in the left 
pane. Click a group name to see the contacts it contains.

Related topic:

Working With Your Address Book (page 47) 

Adding Categories
A category is a collection of contacts.

To create a new category:

1. In the main Address Book window, open the File menu and choose New, then 
Category.

2. Type the category name. 

The name you specify must be unique among all group names, category 
names, and directory names in your Address Book. It appears as the name for 
this category in the list of categories in the main Address Book window.

3. Click OK.

Your new category appears at the bottom of the list of categories in the main 
Address Book window.

4. Drag your new category to the position where you want it to appear in the list.

5. To add entries to your new category:

Select the category and click New Contact.

Move entries from other categories by dragging and dropping them over the 
name of this one.

Related topic:

Working With Your Address Book (page 47) 
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Managing Duplicate Contacts
As you use AOL Communicator and add entries to AOL Communicator Address 
Book, you may end up with several identical or nearly identical entries for the 
same contact.

Entries that are nearly identical have one or more conflicts: for example, the screen 
names are different, or the first name is given as “Jonathan” in one entry and “Jon” 
in another.

To merge duplicate entries, you need to review any conflicts and decide how to 
resolve them. Follow these steps:

1. If you’re not already viewing the Merge Selected Entries window, open the 
Tools menu and choose Manage Duplicate Contacts.

The field on the left summarizes the contact entries that appear to be 
duplicates. 

2. Click an entry to see information about it.

If the currently selected set of duplicate entries includes some conflicts, the first 
set of conflicting data is displayed near the center of the window. In this case, 
go on to Step 3.

If no information is displayed in the center of the window, the currently 
selected set of duplicates are identical, with no conflicts. Click Save to merge 
them into a single entry, then go on to Step 4.

3. If conflict information is displayed about the currently selected set of duplicate 
entries, click the version that you want to keep (or type the correct information 
in the field on the right).

If there are more conflicts, the button on the right changes to Next. Click it to 
display the next conflict.

If you have resolved all the conflicts, the button on the right changes to Save. 
Click it to save your decisions.

If you have already saved your decisions, the button on the right is dimmed, 
and you are finished resolving the conflicts for that entry.

4. After you finish resolving one set of duplicates and click Save, repeat Steps 2 
and 3 for the next entry.

5. When you have finished resolving the duplicates you want to merge, click 
Finish.
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Where Is My Screen Name Stored?
Radio@AOL for AOL Communicator, My AOL Today for AOL Communicator, 
and My AOL Today Ticker all use the same screen name to identify you for the 
purpose of saving your preferences and settings.

The screen name used by these applications is stored under AOL Synchronization 
Settings (page 174) in AOL Communicator Address Book. This is the same screen 
name used for synchronizing AOL Communicator Address Book with your AOL 
Address Book.

By default, this is the screen name for the first AOL member account you set up. If 
you’re not seeing the radio presets or My AOL settings that you expect, it may be 
because this screen name is different from one you have used in the past with 
Radio@AOL or My AOL.

Don't change this screen name unless you're willing to deal with changed behavior 
in other AOL Communicator applications as well. For example, even if you turn off 
synchronization, the screen name stored here determines the Address Book entries 
used to display email and other information in your Buddy List window. 

Related topic:

Changing Address Book Synchronization Settings (page 169) 

AOL Synchronization Settings
By default, AOL Communicator Address Book continuously synchronizes stored 
contact information with the AOL Address Book for your screen name. 

If you’re not already viewing the AOL Synchronization Settings, open the Edit 
menu from the main Address Book window and choose AOL Synchronization 
Settings.

You can control these settings:

• Enable Address Book Synchronization: Click the checkbox to turn 
synchronization off or on.

If you want to disable synchronization, do so after entering a screen name.
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• Screen Name: You must provide a screen name for the AOL member account 
with which you want to synchronize your AOL Communicator Address Book

You must enable synchronization, at least temporarily, to enter a screen name. 

Important: By default, this is the screen name for the first AOL member 
account you set up. Even if you turn off synchronization, the screen name 
stored here determines the Address Book entries used to display email and 
other information in your Buddy List window.

Don’t change the synchronization screen name unless you’re willing to deal 
with changed behavior in other AOL Communicator applications as well. For 
example, a AOL member screen name must be specified here to sign on to 
Radio@AOL or My AOL Today. This screen name determines what kind of 
personalization settings you will see in those applications.

• Password: If you select the “Remember password” checkbox, you must enter 
the password for the screen name.

• Remember Password: Leave this option selected if you don’t want to be 
prompted for your password every time synchronization takes place.

Related topic:

Synchronization with the AOL Address Book (page 30)

New Contact
The New Contact window allows you to create a new contact entry. If you’re not 
already viewing it, click New Contact in the main Address Book window. 

The same window appears when you right-click the name of the contact in the 
Address Book window and choose Edit Contact Info. 

Be sure to complete the following fields at the top:

• First Name: The contact’s first name. 

• Last Name: The contact’s last name. The first and last names you enter here 
will be displayed in your Buddy List window as the Friendly Name for this 
contact.

• File In: From the drop down list, choose the category in which you want to file 
this contact. (You can change it later if you want to.)

A row of tabs allows you to fill in basic contact information as well as additional 
details under Home, Work, and Other. 
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The Contact tab contains the following fields:

Nickname: A shortcut you can use to enter this person’s email address.

Primary Contact Information: Be sure to enter the following information (if you 
have it). For each item, you can use the drop down lists to label it Home, Work, or 
Other:

• E-Mail Address: Enter the main e-mail address from which this person sends 
you messages.

• Screen Name: Enter the main screen name you use to communicate with this 
person via Instant Messenger software.

If you provide this information, your Buddy List window displays an envelope 
icon beside this screen name when you receive email from this email address.

Other Contact Information: You can use this area to store any other information 
about this contact, including alternate email addresses. 

New Group 
The New Group window allows you to create a new group. If you’re not already 
viewing it, click New Group in the main Address Book window. 

The same window appears when you right-click the name of the group in the left 
pane of the Address Book window and choose Edit Group. 

You can specify the following properties for a group:

• Group Name: The name that appears under Groups in the left pane of the 
Address Book window.

The name you specify must be unique among all group names, category 
names, and directory names in your Address Book.

Address: To add an email address to this group, type it in this field. 

When you stop typing for a brief interval, a list of matching email addresses 
appears just below the field (“type down addressing”). Click a name to select it 
from the list. 

• Add: Adds the email address in the Address field to the group. 

If a contact entry does not already exist for the address, a window opens that 
lets you enter basic information for a new contact entry. 

• Remove: Removes the selected entries from this group.
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• New Contact: Opens a New Contact window where you can type complete 
information for a new contact entry that will be added to the group.

New Category
The New Category window allows you to create a new category. If you’re not 
already viewing it, open the File menu and choose New, then Category. 

The same window appears when you right-click the name of the category in the left 
pane of the Address Book window and choose Rename Category. 

The name you specify must be unique among all group names, category names, 
and directory names in your Address Book. It appears as the name for this category 
in the list of categories in the main Address Book window.

Related topics: 

Adding Categories (page 172)

Managing Directories
Setting Up a New Directory (page 177) 

Settings & Preferences:
New Directory (page 178)

Setting Up a New Directory
Some organizations publish online directories of members, employees, and so on. 

When configured for use with such a directory, AOL Communicator Mail can fill in 
names and addresses automatically when you address a message, and Instant 
Messenger for AOL Communicator can notify you when you receive mail from 
anyone listed in the directory.

AOL Communicator can be set up to work this way with any directories that use 
LDAP (“Lightweight Directory Access Protocol). Before you attempt to set one up, 
get the information listed in the next section from your directory server 
administrator.
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To set up an LDAP directory from Address Book:

1. Open the File menu and choose New, then Directory.

2. Fill in the requested information. See New Directory for details.

New Directory
The New Directory window allows you to create a new directory entry. If you’re 
not already viewing it, open the File menu, choose New, and then Directory. 

The same window appears when you right-click the name of an existing directory 
in the left pane of the Address Book window and choose Edit Directory. 

When you create a new directory, you see exactly the same fields:

• Directory Name: The name you want to assign this directory in your Address 
Book. For example: Corporate Phonebook

The name you specify must be unique among all group names, category 
names, and directory names in your Address Book.

• LDAP Server: The name of the server for this directory. Ask your directory 
server administrator for this information.

• Port: For many directories you can leave the default value of 389. Ask your 
directory server administrator if you need to change this setting.

• Search Root: This important information is directory-specific. Ask your 
directory server administrator what to type here. Example: dc=com 

• Maximum Results: This setting controls the maximum number of results 
displayed when you search the directory for a name or part of a name.

• Typing delay: This setting determines the delay in milliseconds between 
keystrokes before Communicator starts looking for matches in the configured 
directory. The default of 200 is fine. Some people prefer a shorter delay, such as 
100.

• Use secure connection (SSL): Select this option if you want communication 
between your computer and the directory to be encrypted. 

Not all directory servers support secure connection. If you select this option 
and the server doesn’t support SSL, you will not be able to use the directory. If 
you’re not sure, check with your system administrator.

When you have filled in the requested information, click OK.
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Related topic: 

Using AOL Communicator Offline (page 49) 
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Using Radio@AOL for AOL®

Communicator

Getting Started With Radio@AOL (page 181) 
Managing Your Preset Radio Stations (page 184) 
Sharing Radio Stations (page 185) 
Radio Settings (page 187) 
Troubleshooting Radio@AOL (page 187) 

Getting Started With Radio@AOL
What Do I Need to Listen to Radio@AOL? (page 181) 
Starting Radio@AOL (page 182) 
Listening Hints (page 183) 

What Do I Need to Listen to Radio@AOL?
If you’re running AOL® Communicator, you probably already have what you need 
to listen to Radio@AOL with CD-quality sound:

• A computer with a sound card and speakers

• Windows 98, Windows 2000, or Windows XP operating system

• A broadband connection to the Internet (such as DSL or cable).
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Starting Radio@AOL
To launch Radio@AOL, open the Window menu in any other AOL Communicator 
application and choose Radio@AOL.

When it first opens, Radio@AOL displays a window that lets you choose whether 
your Instant Messenger buddies can see what station you’re listening to.

After you respond to this initial request, the Radio@AOL player opens, downloads 
the list of currently available stations, and displays them in the left pane:

• To play a station: Click the triangle beside the category you want in the left 
pane, then double-click the name of the station in that category that you want 
to play. 

The standard Play, Stop, Mute, and Volume controls work as you expect. 

• Information about the current station and selection: The right side of the 
window displays information about the current selection. You can also view 
album art, click links to get more information about the music, or buy tickets 
for live concerts.

• To change stations: Double-click the name of the station you want to change 
to.

• To save the current station for easy access: Click one of the numbered Preset 
buttons near the top of the window. The station name appears in the button, 
and you can play it again by clicking the button again. 

Related topic:

Listening Hints (page 183) 
Managing Your Preset Radio Stations (page 184) 
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Listening Hints
Here are some hints to help you get the most out of Radio@AOL.

• Exploring Radio Stations: To find your favorite music stations, look in the left 
column of your radio player, under the words Stations by Category. 

To show or hide all of the stations within a category, click the triangle to the left 
of the category name. 

• Using the Controls: Next to the Play button in the lower-left corner of your 
radio player are Stop and Mute buttons, along with a sliding volume control. 
Click Stop to stop playing the music. Click Mute to turn the sound on or off 
completely.

To increase or decrease the volume, place the pointer over the volume slider, 
then click and hold your mouse button down while moving the slider to the 
right or left.

• Current Station: The box on the upper-right side of the Radio@AOL player 
displays the name of the station, the name of the selection that’s currently 
playing, and the name of upcoming selections. 

You can also click one or more links in this area to try stations that play similar 
music. 

• Now Playing: The area below the Current Station box displays the artist, song, 
and album names for the selection currently playing (along with 
corresponding album art and links to AOL® Music Search, if available). 

Notice the timer located near the middle of this box. This indicates how much 
time is left in the current song.

In many cases, the Now Playing box also lets you buy the CD you’re hearing, 
find tickets for live concerts, and get additional information about the music.

• Rate This Song: Click the Rate this Song button in the Now Playing box to 
send your rating of that song directly to the Radio@AOL DJs. Your feedback is 
an important factor in station programming.

• AOL® Recommends: If you're not sure what you want to hear or just want to 
try something new, check out the first entry in the 'Stations by Category' list 
called 'AOL Recommends.' This category features three stations specially 
chosen by our expert DJs every week. 
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Managing Your Preset Radio Stations
The presets feature of Radio@AOL allows you to save up to five of your favorite 
stations in the preset buttons at the top of the Radio@AOL player.

To add stations to your blank preset buttons: 

1. In the Radio@AOL player, click the name of the station you want to add.

2. Locate the five preset buttons near the top of the player. Click any button 
labeled Add to Preset to add the selected station to that button.

The Add to Preset window appears.

3. Make sure the station displayed in the Add to Preset is the one you want to 
add. 

If you want to assign it to a different preset button (even one that is already set 
to a different station), choose the number of the button you want from the 
drop-down list.

4. Click OK

The label for the button you selected changes to show the name of the station 
you assigned to it.

5. Repeat Steps 1 through 4 for each button you want to preset. 

To play one of your preset stations, just click its button.

Related topic:

Radio Setup (page 187) 
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Sharing Radio Stations
Revealing What You’re Listening To (page 185) 
Adding Radio Stations to Messages (page 186) 

Revealing What You’re Listening To
By default, what you listen to on Radio@AOL remains private. Your buddies can’t 
tell if you’re listening to the radio or what station you’re listening to. 

You can change your privacy settings so that anyone on your Buddy List can tune 
in to the same radio station you’re listening to whenever you send them instant 
messages. 

To change your radio privacy settings: 

1. Click the Radio Setup button, or open the Radio menu and choose Radio Setup.

2. Select this option (near the bottom of the window):

Allow people on my Buddy List to see that I’m listening to the radio: When 
this option is selected, anybody on your Buddy List can see what station you’re 
listening to when you send them instant messages.

3. Click OK.
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Adding Radio Stations to Messages 
SWhile you’re listening to Radio@AOL, you can send anyone information about 
the station you’re listening to.

To send the current station: 

1. Click one of these icons near the top right corner of the Radio@AOL player:
 

2. Fill in the screen name or email address of the person you’re sending the 
message to, and type whatever additional text you want to include in the 
message.

3. Click Send.

The recipient just clicks the link in your message to open and play the same station. 

Note: For this feature to work, recipients of your instant messages must have 
Netscape® 7.0 (or later), AOL® 8.0 (or later), or AOL Communicator installed on 
their computers.

Creates a new instant message window containing a link to the 
currently selected radio station. 

Creates a new email message containing a link to the currently 
selected radio station.
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Radio Settings
Add to Preset (page 187) 
Radio Setup (page 187) 

Add to Preset
The Add to Preset window allows you to connect a radio station to one of the 
preset buttons across the top of the Radio@AOL player. It appears when you click a 
an empty preset button.

Make sure the station displayed is the one you want to add. 

The preset number shown by default corresponds to the button you clicked. To 
save the station in a different button, choose a different number from the 
drop-down list.

Click OK to confirm your new preset.

Radio Setup
The Radio Setup window allows you to set up your preset buttons and change 
your start and sharing options. 

The window appears when you click the Radio Setup button or open the Radio 
menu and choose Radio Setup. 

Setup Presets: Modify your preset buttons:

• Remove a preset station from a button: Click the name of the button under My 
Presets, then click Remove.

• Add a new station to the next available blank button: Click the station’s name 
under Available Stations, then click Add.

• Change preset button order: Click a button, then click the up or down arrows 
to reposition it.
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Auto-play when Radio starts: When this option is selected, launching Radio@AOL 
causes one of the following to happen:

• The station that was selected when you last exited the player starts playing.

• If no station was selected when you last exited, the first station stored in one of 
your preset buttons starts playing.

• If you have no presets set, the first AOL Recommends station starts playing.

Allow people on my Buddy List to see that I’m listening to the radio: When this 
option is selected, anybody on your Buddy List can see what station you’re 
listening to when you send them instant messages.

Troubleshooting Radio@AOL
Why Is There No Sound When I Start Radio@AOL? (page 188) 
How Do I Improve Radio@AOL Reception? (page 189) 
Error: Cannot Open Audio Device (page 189) 
Error: Could Not Create DirectSound Object (page 189) 

Why Is There No Sound When I Start 
Radio@AOL?
Check for the following:

• Is the volume for your computer turned on and turned up?

• Are your speakers turned on?

• Is the Mute button selected on the Radio@AOL player?

• Is the player’s volume turned up?

• Have you selected a radio station? 

Click the triangle beside a category to see the stations available in that 
category. Double-click a station name to play it.

• Are your volume settings adjusted properly?

To adjust your Windows volume settings, follow these steps:
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1. Click Start, then Settings, then Control Panel.

2. Double-click Sounds and Multimedia. 

3. Click the Audio tab. 

4. Under Sound Playback, click Volume. 

5. Deselect any Mute (Mute all) checkbox. 

6. Move the Volume slider for Wave Balance to the top. 

This should restore your audio, and you should be able to hear the music when 
you double-click a radio station’s name.

How Do I Improve Radio@AOL Reception?
Static and interrupted playback are typically caused by a poor Internet connection. 
Streaming audio is especially susceptible to network problems.

Try exiting some of your open applications to improve your radio experience. 

Error: Unable to Play Stream
This error often indicates a temporary loss of contact with the server. Click Try 
Again to keep trying.

You can also click Exit to close Radio@AOL and try launching it again after some 
time has passed.

Error: Cannot Open Audio Device
This error usually indicates a problem with your sound card or sound card drivers, 
in which case you will need to contact your sound card manufacturer. AOL cannot 
help you with this type of problem.

If you are running a game, playing a CD, or running other software that is playing 
sound, exit that application and try running Radio@AOL again. 
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Error: Could Not Create DirectSound Object
This error usually indicates a limitation of your sound card. Your system may have 
a built in sound card that cannot support playback of more than one audio process 
at a time.

If Radio@AOL is playing and you start another program that uses your sound card, 
Radio@AOL may stop playing and this message may appear.



191

Chapter 9

My AOL Today for AOL®
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My AOL and AOL Communicator (page 191) 
Using My AOL Today Ticker (page 193) 
Using My AOL Today (page 195) 
Setting Up Your Portfolios (page 200) 
Managing Your Portfolios (page 202) 
Portfolio Tools & Settings (page 206) 

My AOL and AOL Communicator
If you are familiar with My AOL (my.aol.com), you know that you can customize 
your news, weather, and financial information and view it on your own My AOL 
web page. 

AOL® Communicator uses your My AOL settings to present headlines that you can 
check quickly while you're working or when your computer is idle, and view the 
details at your own convenience.

Two AOL Communicator applications display information based on the My AOL 
settings for your screen name:

• My AOL Today is a screen saver that displays dynamic, full-screen, interactive 
content. You can click streaming images at any time to display more details.

• My AOL Today Ticker provides a continuous stream of up-to-date 
information across the top of your screen. You can click streaming headlines at 
any time to view the whole story.
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The screen name used by My AOL Today is stored under AOL Synchronization 
Settings (page 174) in AOL Communicator Address Book. Unless you have 
changed it, this should be the screen name with which you set up your initial 
AOL® member account.

Related topics: 

“Sign On to AOL Communicator” (page 192) describes the sign-on screen that 
requests your screen name and password (if they’re not already stored in AOL 
Communicator Address Book).

“AOL Communicator Launch Options” (page 38) determine which applications 
get launched when you start AOL Communicator.

Sign On to AOL Communicator
The Sign On window appears when AOL Communicator needs to verify your AOL 
member screen name and password. 

Screen Name: The screen name displayed here is used by Radio@AOL for 
AOL Communicator and by My AOL Today to determine your personal 
settings for those applications. If you have previously entered a valid AOL 
member screen name, it will show up here.

This screen name is stored under AOL Synchronization Settings (page 174) in 
AOL Communicator Address Book. Unless you have changed it, it should be 
the screen name with which you set up your initial AOL member account. 

Internet screen names, such as those you can obtain from the Netscape® or 
AIM® service, won’t work for this purpose.

Password: Make sure you type the password for the screen name shown 
above. Type it slowly.

Remember this password: If you select this option, you won’t be asked to 
enter your password the next time you launch Radio@AOL or My AOL Today.

Click Sign On when you’re sure everything is correct.
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Using My AOL Today Ticker
Viewing and Controlling the Ticker (page 193) 
Customizing the Ticker (page 194) 

Viewing and Controlling the Ticker
AOL Communicator Ticker gives you another way to monitor news and 
information you care about. It provides a continuous stream of up-to-date 
information across the top of your screen, including customized headlines, stock 
quotes, and weather.

The headlines streamed by the Ticker are based on the My AOL preferences for the 
screen name listed under AOL Synchronization Settings (page 174) in AOL 
Communicator Address Book.

If you're not already viewing the Ticker, open the Window menu in any AOL 
Communicator application and choose My AOL Today Ticker.

Ticker tips:

• Move your pointer over a Ticker item to pause the streaming and display a 
tooltip summarizing the item.

• Click a Ticker item to open a Details Window with complete information. 

• To the right of the streaming headlines are two arrow key buttons. Click the 
right button to move to the end of the currently displayed topic section, or click 
the left button to move to the beginning.

• Click the pause button to pause the headlines midstream. When the headlines 
are paused, the pause button becomes a start button. Click the start button to 
resume streaming.

• The icons to the right of the arrow keys are just like the taskbar icons in any 
other AOL Communicator application. Click them to move from one 
application to another.
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To change Ticker settings: Click the checkbox button near the right side of the 
Ticker and choose the appropriate menu item: 

• Choose Customize Ticker to select which categories of customized 
information the Ticker streams across the top of your screen and to edit your 
My AOL settings for each category.

• If Always on Top has a checkbox beside it, the Ticker is always visible on top 
of all other applications. Select Always on Top to toggle this option off or on.

• The Scroll settings control how quickly the Ticker scrolls headlines across your 
screen.

Related topic:

You can use Launch Options to open the Ticker automatically every time you 
launch AOL Communicator: see “AOL Communicator Launch Options” (page 38).

Customizing the Ticker
There are two ways to customize the content displayed by My AOL Today Ticker: 

• Select My AOL categories to be displayed (affects the Ticker only)

• Customize your My AOL content settings (no matter where you sign on)

If you’re not already viewing the Customize My AOL Today Ticker window, click 
the checkbox button near the right side of the Ticker and choose Customize Ticker. 

The window has two sections:

Customize Ticker 

This part of the window lets you select the categories of information from your My 
AOL web page that the Ticker will include in its scrolling headlines.

Categories with checkmarks beside them will be displayed. Click the plus sign 
beside each category to see its subcategories. Click a checkbox to select or deselect 
it. 

The types of headlines displayed within each category are determined by your 
corresponding My AOL settings.
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My AOL Ticker Content

Click Customize Content to edit your My AOL settings for News, Portfolio, 
Weather, Sports Scores, or Horoscopes.

The Customize My AOL Today Content window opens to Customize News. You 
can select different categories from the drop-down list at the top of the window. 

Related topic:

Customizing My AOL Content (page 199) 

Using My AOL Today
Starting My AOL Today (page 195) 
Running My AOL Today (page 196) 
Customizing My AOL Today (page 198) 
Customizing My AOL Content (page 199) 

Starting My AOL Today
My AOL Today is a screen saver that displays dynamic, full-screen, interactive 
content based on your My AOL settings. You can also run My AOL Today as 
regular AOL Communicator application

When My AOL Today is active, images and headlines scroll across your screen. 
You can click an image or headline at any time to display more details.

To launch My AOL Today manually: 

These instructions assume that at least one AOL Communicator application is 
already running.

1. Click the AOL Communicator icon in your system tray (near the lower-right 
corner of your screen).

Or open the Window menu in any AOL Communicator application.

2. Choose My AOL Today from the menu.

My AOL Today launches. 

To close My AOL Today and return to your regular screen, click the close box near 
the upper-right corner.
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To turn on My AOL Today as your screen saver:

1. Click the AOL Communicator icon in your system tray (near the lower-right 
corner of your screen).

Or open the Window menu in any AOL Communicator application.

2. Choose Launch Options from the menu.

3. Under My AOL Today, select the checkbox labeled Make My AOL Today my 
default system screen saver.

4. Click OK.

The My AOL Today screen saver appears after the interval set in your Display 
control panel has passed with no activity on your computer (default setting is 5 
minutes). 

To change this interval, click the Start menu, then Settings, then Control Panel, then 
Display. Then click the Screen Saver tab, adjust the Wait value to your liking, and 
click OK.

Related topics:

Running My AOL Today (page 196) 

Running My AOL Today
When My AOL Today starts up, you’ll see five categories at the top of your screen: 

• Click a category to view its headlines.

• The topics displayed under Business, Entertainment, News, and Sports depend 
on your My AOL News selections.

• The items displayed under Portfolio depend on your My AOL Portfolio 
selections. For instructions on using this area, see Portfolio Summary 
(page 206).
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Streaming images: Near the bottom of the screen (under Business, Entertainment, 
News, and Sports), you’ll see a continuous stream of images, each representing a 
story or video in the category highlighted at the top of the screen:

• The headline images reflect your customized My AOL settings for that 
category.

• Move your pointer over an image see a summary of that story. 

• Click an image to explore the story further.

If you leave My AOL Today running by itself, it rotates through all the stories and 
videos in each News category, but does not display Portfolio.

Story or Video Summary: The middle of the screen usually displays a summary of 
a single story or video.

• Click Read More or Watch Video to explore further.

Sports, Weather, Financials: The bottom left of the screen rotates sports scores, 
weather, stocks, and market indices (depending on your My AOL settings).

Google Search: On the bottom right, you’ll see a Google search field:

• To search the World Wide Web, type the terms you want to search for and click 
Go.

Related topics:

Customizing My AOL Today (page 198) 
Portfolio Summary (page 206) 
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Customizing My AOL Today 
There are two ways to customize the content displayed by My AOL Today: 

• Customize your My AOL content settings (no matter where you sign on)

• Select Watcher categories (for My AOL Today only)

If you’re not already viewing the Customize My AOL Today window, click 
Customize near the upper-right corner of My AOL Today. 

The window has two sections:

My AOL Content

Click Customize Content to edit your My AOL settings for News, Portfolio, 
Weather, Sports Scores, or Horoscopes.

The Customize My AOL Today Content window opens to Customize News. You 
can select different categories from the drop-down list at the top of the window. 

Watcher Content

This part of the window lets you select the categories of information from your My 
AOL web page that will be continuously summarized in the area at the bottom left 
of My AOL Today. 

The content that the Watcher displays for each selected category is determined by 
your corresponding My AOL settings. 

Related topics:

Customizing My AOL Content (page 199) 
Setting Up Your Portfolios (page 200) 
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Customizing My AOL Content
When you customize My AOL Today or My AOL Today Ticker, you can also 
customize your My AOL content. 

If you’re not already viewing the window, click Customize Content in the 
Customize window for My AOL Today or My AOL Today Ticker. 

Changes you make to these My AOL settings are reflected on your My AOL web 
page as well as in My AOL Today. 

Similarly, changes you make directly to your My AOL web page are reflected in 
My AOL Today and My AOL Today Ticker (with the exception of Portfolio; see 
“Setting Up Your Portfolios” on page 200). 

The screen name that ties your My AOL settings together, no matter where you 
sign on, is stored under AOL Synchronization Settings (page 174) in AOL 
Communicator Address Book.

Customize Content for: 

Choose the My AOL category you want to edit from the drop-down list at the top 
of the window.

For News, Portfolio, Weather, Sports Scores, and Horoscopes, the list on the left 
shows available subcategories, and the list on the right shows those that are 
currently displayed:

• Read the instructions near the top of the window.

• Select an item and click Add or Remove to move it from one list to the other. 

For detailed instructions on Portfolio, click Help for that category or check the 
related topics below.

Related topics:

Customizing the Ticker (page 194) 
Customizing My AOL Today (page 198) 
Setting Up Your Portfolios (page 200) 
Managing Your Portfolios (page 202) 
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Setting Up Your Portfolios
About Portfolios (page 200) 
Creating a Portfolio (page 201) 

About Portfolios
A Personal Finance Portfolio is a group of investments that you are tracking with 
the help of AOL. A single portfolio can include investments such as stocks, mutual 
funds, money markets, and cash, as well as information about those investments. 
You can include additional information such as the number of shares, purchase 
price per share, purchase date, and so on. 

If you have already set up one or more portfolios, you already know that you can 
view them from my.aol.com, finance.aol.com, or AOL Keyword: My Portfolios.

My AOL TodayTicker displays the current value for the ticker symbols listed in 
your portfolios (unless you choose not to include stock quotes in the ticker 
contents).

My AOL Today displays more detailed information about each portfolio in the 
Portfolio area. 

If you haven’t yet set up any portfolios, you can do so from within My AOL Today. 
You can also edit existing portfolios. 

Delayed Updates: Changes you make to your portfolios in My AOL Today are 
automatically reflected in the portfolio views available at finance.aol.com or AOL 
Keyword: My Portfolios for the same screen name. 

However, subsequent changes you make at either of those locations will not be 
reflected in My AOL Today immediately. Changes made in those locations show 
up only after you attempt to customize some aspect of a portfolio from My AOL 
Today.

The screen name that My AOL Today uses to update your other portfolio views is 
stored under AOL Synchronization Settings (page 174) in AOL Communicator 
Address Book.

Related topics:

Creating a Portfolio (page 201) 
Managing Your Portfolios (page 202) 
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Creating a Portfolio
Each portfolio you create can hold up to 100 items. You can create up to 20 
portfolios per screen name.

To create a new portfolio for the Portfolio area in My AOL Today:

1. Click Customize (near the top-right corner of the My AOL Today screen.)

The Customize My AOL Today window opens to My AOL Content.

2. Click Customize Content.

The Customize My AOL Today window displays Customize News. 

3. Choose Portfolio from the drop-down list at the top of the window.

The My Portfolios window opens, showing a list of your portfolios.

4. Click Create New (or Create New Portfolio, if you haven’t previously set any 
up).

The Create Portfolio window opens.

5. Name the portfolio. 

You can name the portfolio anything your wish as long as the name is no 
longer than 25 characters.

6. Add holdings to the portfolio.

Each line in the Create Portfolio window specifies the information for one 
stock, mutual fund, money market fund, or market index. 

You must enter a ticker symbol in the first field. If you don’t know the ticker 
symbol, click Symbol Lookup to look it up.

The remaining fields are optional. You can specify a number of shares, price, 
date of purchase, or commission.

You can also create a portfolio without any of these details if you like, just to 
track a cash value or market indices. 

If you have more than six holdings to add, click Add More Symbols. You’ll 
then see pane of rows where you can enter more symbols and related 
information. Click Next or Previous to move between panes within a portfolio.
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7. Add cash to the portfolio. 

This step is optional, but can be useful for tracking uninvested cash. 

For example, if you had $500.00 from the sale of a particular stock and plan to 
invest this amount at a later date, it may be helpful to add this amount to your 
portfolio. 

You can update this cash amount at any time, even if you leave it blank at first.

8. Click Save to confirm your data and return to My Portfolios.

Delayed Updates: Your new portfolio (including any further changes you make to 
it) is automatically reflected in the portfolio views available at finance.aol.com or 
AOL Keyword: My Portfolios for the same screen name. 

However, subsequent changes you make at either of those locations will not be 
reflected in My AOL Today. Changes made in those locations show up only after 
you attempt to customize some aspect of a portfolio from My AOL Today.

Managing Your Portfolios
Editing a Portfolio (page 202) 
Adding an Item to a Portfolio (page 203) 
Adjusting or Moving Stock Data (page 204) 
Deleting a Portfolio (page 205) 
Deleting an Item from a Portfolio (page 206) 

Editing a Portfolio
To edit one of your existing portfolios:

1. On the My AOL Today screen, click Portfolio. 

2. From the drop-down list labeled Choose a Portfolio, choose the one you want 
to edit.
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3. Click Edit Portfolio. 

The Edit Portfolio window opens for the portfolio you selected. You can use 
this window to edit the items in the portfolio or add new ones.

For complete details on using this window, see “Create/Edit Portfolio” 
(page 208). 

Related topics: 

Adding an Item to a Portfolio (page 203) 
Deleting an Item from a Portfolio (page 206) 
Creating a Portfolio (page 201) 

Adding an Item to a Portfolio
If you know the ticker symbol: 

1. On the My AOL Today screen, click Portfolio. 

2. From the drop-down list of portfolios, choose the one to which you want to 
add an item.

3. Click Edit Portfolio. 

The Edit Portfolio window opens for the portfolio you selected. 

In the first blank line, enter a ticker symbol and any additional details about 
this item that you want to include. 

If you have more than six items in your portfolio, you will need to click Next 
(near the bottom right) one or more times to find the next blank line.

4. Click Save. 

If you don’t know the ticker symbol:

1. On the My AOL Today screen, click Portfolio. 

2. From the drop-down list of portfolios, choose the one to which you want to 
add an item.

3. Click Edit Portfolio. 

4. The Edit Portfolio window opens for the portfolio you selected. 

5. Click Symbol Lookup. 

The Symbol Lookup window opens.
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6. Type the first letters of the company or ticker symbol that you want, and click 
Symbol Lookup. 

Matching symbols are displayed below.

7. Click the symbol you want to add.

8. Click Add to Portfolio. 

The Add to Portfolio window appears. The ticker symbol you selected is 
automatically added to the Symbol field. 

Add any additional details about this item in the appropriate fields (optional).

9. Click Save. 

You’ll see the Edit Portfolio window for this portfolio, with the new item 
added to the next open row.

Adjusting or Moving Stock Data
To copy or move the data for one of your stocks, or adjust for a stock split:

1. On the My AOL Today screen, click Portfolio.

2. From the drop-down list of portfolios, choose the one that contains the stock 
you want to edit.

3. Click Edit Portfolio. 

4. Click the S button beside the row you want to edit, or the T button beside the 
row you want to copy or move.

Follow the appropriate instructions for the resulting window:

Split Portfolio Item

1. Confirm that the item being split is the one you intend.

If not, click Cancel and click the S button beside the correct item.

2. Select the split ratio (or enter a custom ratio) for this stock. 

3. Click Calculate New Values. 

4. If you’re sure the split ratio and new values are correct, click Save. If not, adjust 
the split ratio and click Calculate New Values again.
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Transfer Portfolio Item

1. Confirm that the item being transferred is the one you want to transfer.

If not, click Cancel and click the T button beside the correct item.

2. Choose the destination portfolio from the drop-down list.

3. Click Move or Copy as appropriate.

Delayed Updates: Changes you make to your portfolios in My AOL Today are 
automatically reflected in the portfolio views available at finance.aol.com or AOL 
Keyword: My Portfolios for the same screen name. 

However, subsequent changes you make at either of those locations will not be 
reflected in My AOL Today. Changes made in those locations show up only after 
you attempt to customize some aspect of a portfolio from My AOL Today. 

Deleting a Portfolio
To delete one of your portfolios:

1. Click Customize (near the top-right corner of the My AOL Today screen.)

The Customize My AOL Today window opens to My AOL Content.

2. Click Customize Content.

The Customize My AOL Today window displays Customize News.

3. Choose Portfolio from the drop-down list at the top of the window.

The My Portfolios window opens, showing a list of your portfolios.

4. Select the portfolio you want to delete.

5. Click Delete.

6. When asked to confirm the deletion, click OK.
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Deleting an Item from a Portfolio
To delete an item from one of your portfolios:

1. On the My AOL Today screen, click Portfolio. 

2. From the drop-down list of portfolios, choose the one that you want to change.

3. Click Edit Portfolio. 

The Edit Portfolio window opens for the portfolio you selected. 

4. Click Delete beside the item you want to delete.

5. When asked to confirm the deletion, click OK. 

Portfolio Tools & Settings
Portfolio Summary (page 206) 
My Portfolios (page 207) 
Create/Edit Portfolio (page 208) 
Add to Portfolio (page 209) 
Quotes (page 209) 
Charts (page 210) 
Symbol Lookup (page 210) 
Frequently Asked Questions About Stock Symbols (page 211) 

Portfolio Summary
To view your Portfolio Summary, click Portfolio in My AOL Today.

• Choose a Portfolio: Choose the portfolio you want to view from the 
drop-down list near the center of the screen.

• Symbol Lookup: This link opens a window where you can look up ticker 
symbols by company name.

• Get Quote: To get a current stock quote, type the ticker symbol in the field 
labeled Enter Symbol below and click Get Quote. 

Or, for a stock listed in one of your portfolios, click the stock symbol in the 
Symbol column.
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To edit your portfolios:

• Click Edit Portfolio (near the middle of the screen) to edit the current portfolio.

To get more information about a stock:

• Click the Charts icon beside a stock symbol to see its charts (if available).

• Click the News icon beside a stock symbol to see related news (if available).

Delayed Updates: Changes you make to your portfolios in My AOL Today are 
automatically reflected in the portfolio views available at finance.aol.com or AOL 
Keyword: My Portfolios for the same screen name. 

However, subsequent changes you make at either of those locations will not be 
reflected in My AOL Today. Changes made in those locations show up only after 
you attempt to customize some aspect of a portfolio from My AOL Today. 

The screen name that ties these My AOL settings together, no matter where you 
sign on, is listed under AOL Synchronization Settings (page 174) in AOL 
Communicator Address Book.

My Portfolios
The My Portfolios pane of the Customize My AOL Today window lets you create 
and edit your portfolios. 

If you haven’t set up a portfolio yet, click Create New Portfolio.

If you’ve already set up one or more portfolios, they are listed here. Click to select a 
portfolio or take these actions:

• Create New: Specify information for a new portfolio.

• Edit: Modify information for the selected portfolio.

• Delete: Remove the selected portfolio from the list and permanently erase all 
the information it contains.

• Close: Close the window.

Related topic:

Customizing My AOL Content (page 199) 
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Create/Edit Portfolio
The Create Portfolio and Edit Portfolio windows work the same way. To open 
them, click Create New in the My Portfolios window, or select an existing portfolio 
and click Edit. 

• Portfolio name: You can name the portfolio anything you want, as long as the 
name is no longer than 25 characters. The name you type here shows up in the 
list under My Portfolios.

• Holdings: Each line in the Create Portfolio window specifies the information 
for one holding.

The first field, Symbol, is mandatory. It must contain a valid ticker symbol for a 
stock, mutual fund, money market fund, or market index.

The remaining fields are optional. You can specify details of an actual or 
planned purchase, or omit the details completely and just track the current 
value of the holding. 

• Symbol Lookup: If you don’t know the ticker symbol for the item you want to 
add, click Symbol Lookup.

• Add More Symbols: If you have more than six holdings to add, click Add 
More Symbols. 

You’ll then see another six lines where you can enter rows of information. Click 
Next or Previous to move between panes within a portfolio.

• Cash amount to include in this portfolio: This information is optional, but can 
be useful for tracking uninvested cash. 

You can update this cash amount at any time, even if you leave it blank at first.

• Save: When you finish entering or editing the information for this portfolio, 
click Save.

After you create your first portfolio, you’ll see a privacy notice. After reading the 
notice, click OK.

If you’ve made an error or omitted required information, you’ll see a message 
listing the problems. You must fix the problems before you can save the portfolio.

Delayed Updates: Changes you make to your portfolios in My AOL Today are 
automatically reflected in the portfolio views available at finance.aol.com or AOL 
Keyword: My Portfolios for the same screen name. 
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However, subsequent changes you make at either of those locations will not be 
reflected in My AOL Today. Changes made in those locations show up only after 
you attempt to customize some aspect of a portfolio from My AOL Today. 

Related topic:

Customizing My AOL Content (page 199) 

Add to Portfolio
The Add to Portfolio window allows you to add a symbol from the Symbol Lookup 
window (page 210) to any of your portfolios:

• Symbol: Shows the symbol you selected in the Symbol Lookup window. 

If this is the wrong symbol, click Cancel.

• Portfolio: Choose the portfolio to which you want to add a holding. 

• Number of Shares: This can be the actual number of shares your own, or a 
hypothetical number for planning purposes. Optional.

• Purchase Price Per Share: This can be the current price, the price you actually 
paid, or a hypothetical price. Optional.

• Purchase Date: Optional.

• Commission Fee: The fee owed to your broker, if any. Optional.

• Save: When you finish entering the information for this symbol, click Save.

Quotes
To get a current stock quote from your Portfolio Summary (page 206), type the 
ticker symbol in the field labeled Enter a Symbol below and click Get Quote. 

Confirm all data with your broker or financial advisor before trading.

To get quotes for a different symbol, enter it in the Portfolio Summary and click 
Get Quote again. If you don't know the symbol for the stock you want quotes for, 
click Symbol Lookup to find it.
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Charts
To see charts for a particular stock or other holding in your portfolio, click the 
Charts icon (if available) beside that row in your Portfolio Summary (page 206).

To change the period of time covered by the chart:

1. Choose another Chart Setting from the drop-down list.

2. Click Update Chart. 

Symbol Lookup
To look up stock, mutual fund, money market fund, or index ticker symbols by 
name, click Symbol Lookup in the Portfolio Summary (page 206) or Create/Edit 
Portfolio window (page 208).

Enter Company name or US Symbol below: Type the first letters of a company, 
fund, or index name or symbol in the field at the top left, then click Symbol 
Lookup.

Match Symbols Only: Select this option if you want to search only for ticker 
symbols that match what you type (excluding, for example, matching company 
names).

Matching ticker symbols are listed below. 

To add one of them to your portfolio, select it and click Add to Portfolio.

Related topic:

Frequently Asked Questions About Stock Symbols (page 211) 
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Frequently Asked Questions About Stock 
Symbols
• Why can't I find the stock class for my stock?

Stocks with different classes use the stock symbol followed by a period and 
then the class. For example, BRK.A is for Berkshire Hathaway Class A stock.

• Why doesn't the preferred stock symbol I have from the newspaper work?

The S&P Comstock format for preferred stocks uses the regular stock symbol 
followed by a dash and then the appropriate letter or no letter if there is only 
one type of preferred stock issued. For example, GM-G is for General Motors 
Series G Preferred stock.

• How do I find a quote on a new "when issued" stock?

To obtain the price on a stock that is trading on a "when issued" basis, or "WI" 
on some other system symbols, type the stock symbol followed by a pound 
sign (#). For example, NCR#.

• Why can't I find a new fund symbol?

When a fund is just starting, the fund may ask for an assigned symbol from 
NASDAQ. However, to actually be listed on the exchange, they must meet 
special reporting requirements. For example, until the fund has grown to 
sufficient size, NASDAQ will not report on it, and quotes for the fund won’t be 
available. 
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Chapter 10

Using AOL® Communicator Identity
Manager

 

Managing Passwords (page 214) 
Getting Started With Identity Manager (page 231) 
Getting Your Own Certificate (page 235) 
Managing Certificates (page 236) 
Managing SSL Settings and Warnings (page 247) 
Managing Smart Cards and Other Security Devices (page 248) 
Controlling Certificate Validation (page 252) 
Certificate Properties (page 255) 

This document is provided by AOL for your information only. It may help you 
take certain steps to protect the privacy and security of your personal information 
on the Internet. This document does not, however, address all online privacy and 
security issues, nor does it represent a recommendation by AOL about what 
constitutes adequate privacy and security protection on the Internet.
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Managing Passwords
Turning on Your Master Password (page 214)
Using the Password Quality Meter (page 216)
Choosing a Good Password (page 217)
Controlling Your Passwords (page 217) 
Changing Remember Password Settings (page 218) 
HOW IT WORKS: Passwords & Local Mail (page 220) 
What to Do If You Forget Your Master Password (page 221) 

Settings & Preferences: 

Manage Master Password (page 224)
Set Master Password (page 224)
Change Master Password (page 225)
Turn Off Master Password (page 226) 
Change Device Password (page 226)

Master Password Request (page 227) 
Mail Server Password Request (page 228) 
AOL Password Request (page 229)
Private Key Password Request (page 230)
SecurID Password Request (page 230)
Password Management Preferences (page 230)

Turning on Your Master Password
When you set up a mail account in AOL® Communicator Mail, you can enter your 
passwords and leave the default setting “Remember password” selected. That way 
you don’t have to retype them each time you launch AOL Communicator (as long 
as your Internet connection isn’t interrupted).

This is convenient, but it also means that anyone with access to your computer can 
use AOL Communicator to send and receive mail or log onto your Instant 
Messenger™ accounts. 

To prevent other people with access to your computer from using AOL 
Communicator, set your Master Password. When your Master Password is turned 
on, you must enter it each time you launch an AOL Communicator application for 
the first time (assuming that no other AOL Communicator applications are already 
running).
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Security note: Setting a Master Password for an account means only that you must 
type the password before launching AOL Communicator. Without launching the 
program, someone who can access your computer may still be able to read local 
mail that you’ve stored on your hard disk. For details, see “HOW IT WORKS: 
Passwords & Local Mail” (page 220). 

To set your Master Password: 

1. In the Mail window, open the Tools Menu and choose Manage Master 
Password.

2. If you haven’t yet set your Master Password, click Set Password. To change an 
existing Master Password, click Change Password.

3. Enter your new password. Check the password quality meter as you type. 

Passwords that can be easily guessed have little value. The password quality 
meter gives you a rough idea of the relative quality of your password as you 
type it based on factors such as length and the use of uppercase letters, 
lowercase letters, numbers, and symbols. 

For more information, see “Using the Password Quality Meter” (page 216).

4. Enter your new password again in the “Confirm new password” field. You 
must type it exactly the same way.

5. Type a password hint to help you remember it. This should be a word or 
phrase that only you can associate with your Master Password. 

Warning: If you forget your Master Password, you will have to reinstall AOL 
Communicator from scratch, including setting up all your accounts again. To 
avoid this, you can take two precautions:

Memorize your Master Password.

Supply a hint in case you forget it again.

6. Click OK.

Related topics:

Controlling Your Passwords (page 217) 
What to Do If You Forget Your Master Password (page 221) 
Turn Off Master Password (page 226) 
HOW IT WORKS: Passwords & Local Mail (page 220) 
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Using the Password Quality Meter
AOL Communicator may request a password before allowing you to set up an 
account, check messages, sign on to the Instant Messenger service, and perform 
other tasks that involve confidential information. 

For example, you may be asked to provide one or more account passwords when 
Instant Messenger for AOL Communicator launches, since it needs to access your 
accounts to check mail status for your buddies.

Passwords that can be easily guessed have little value. Wherever you need to 
create a new password or type one in your account settings, you’ll see the 
password quality meter:

The password quality meter gives you a rough idea of the relative quality of your 
password as you type it based on factors such as length and the use of uppercase 
letters, lowercase letters, numbers, and symbols. It does not guarantee that no one 
will be able to guess your password.

If the quality bar doesn’t move past the center after you finish typing your 
password, you should consider changing the password based on the guidelines 
that follow. 

Related topics:

For password guidelines, see the next section, “Choosing a Good Password” 
(page 217). 

For information on preventing other people with access to your computer from 
using AOL Communicator, see “Turning on Your Master Password” (page 214). 

For information about controlling the frequency with which passwords are 
requested, see “Controlling Your Passwords” (page 217). 
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Choosing a Good Password
To create a good password, don’t use: 

• Any part of your name - first, last, or middle

• Your initials

• Your social security number

• Names of people, pets, or places

• Birthdays

• Phone numbers or addresses

• Any other personal information that could be guessed

• Words in any dictionary of any language

• Your user name or login name

• Your computer's name

• Repetition of the same letter

• Sequences of keyboard keys, such as "12345" or "qwerty"

• Any minor variation of the above, such as spelling backwards or appending a 
character to the end of your name

To create a good password, do use:

• Special characters (*!$+) mixed with letters and numbers

• Mixed uppercase and lowercase letters—putting capitals in random locations 
throughout a password is effective

• Punctuation characters mixed with letters and numbers

• Nonsense words that are easy to pronounce but aren't in any dictionary

• Six or more characters

Controlling Your Passwords
By default, AOL Communicator Mail “remembers” the passwords that control 
access to your mail account servers. This feature can be convenient, since the 
software keeps track of the passwords for you and enters them for you 
automatically whenever it sends or receives new mail.
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However, remembered passwords can also be used by anyone who has access to 
your computer and can launch AOL Communicator. If you are concerned about 
other people using your AOL Communicator accounts, you can set a Master 
Password that’s requested each time you launch the program. 

Whether you set a Master Password or not, you can also turn off the Remember 
Password setting for individual accounts. Turning this option off means that you’ll 
have to enter your account password whenever you launch AOL Communicator. 

If other people can access your computer easily and you don’t want them to be able 
to use your email accounts, you should consider setting a Master Password, 
turning off the Remember Password setting for sensitive accounts, or taking both 
of these precautions.

Security note: Neither your mail server passwords nor your Master Password 
protect mail messages that you may have stored locally on your own computer. For 
details, see the How It Works section listed below.

Related topics:

Changing Remember Password Settings (page 218) 
HOW IT WORKS: Passwords & Local Mail (page 220) 
Turning on Your Master Password (page 214) 
Turn Off Master Password (page 226) 
What to Do If You Forget Your Master Password (page 221) 

Changing Remember Password Settings
Before you change the Remember Password setting for an account, be sure to read 
about related settings in “Controlling Your Passwords” (page 217). 

Note: If the “Remember Password” setting is selected, other people with physical 
access to your computer may be able to access your account.

To change the Remember Password setting for an AOL account:

1. From the main Mail window, open the Edit menu and choose Account 
Settings.

2. Double-click the name of the AOL account whose Remember Password setting 
you want to view or change.

3. In the Mail Settings tab, click to select or deselect the checkbox labeled 
“Remember password.” 

4. Click OK to confirm your choice.
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5. Click OK in the Account Settings window.

To change the Remember Password setting for an ISP account:

Each ISP account has two separate Remember Password settings: one for the 
outgoing server and one for the incoming server. Follow these steps:

1. From the main Mail window, open the Edit menu and choose Account 
Settings.

2. Double-click the name of the ISP account for which you want to turn off your 
“remember password” option.

3. In the Sending Mail tab, click the Edit Server button.

4. In the Edit Server window, click to select or deselect the checkbox labeled 
“Remember SMTP password,” which controls the password for the outgoing 
mail server.

5. Click OK to confirm your choice.

6. Click the Receiving Mail tab.

7. Click to select or deselect the checkbox labeled “Remember password,” which 
controls the password for the incoming mail server.

8. If you have deselected the Remember Password option, look at the two “Check 
for new mail” options near the bottom of the window and make sure they are 
set the way you want:

Check for new mail on startup: If this option is selected, you will need to type 
your password every time you launch AOL Communicator.

Check for new mail every __ minutes: If this option is selected, you will need 
to type your password the first time AOL Communicator Mail checks mail 
after launching (unless your Internet connection is interrupted, in which case 
you'll need to enter it again when service is restored). You can change the 
number of minutes if you want.

9. Click OK to confirm your choices.

10. Click OK in the Account Settings window.

Related topics:

Controlling Your Passwords (page 217) 
Storing Messages for Offline Use (page 70) 
HOW IT WORKS: Passwords & Local Mail (page 220) 
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HOW IT WORKS: Passwords & Local Mail

Each password associated with one of your mail accounts control access to a 
mail server—that is, to a separate computer somewhere on the Internet that 
manages your incoming mail, outgoing mail, or both for that account. This is 
also true for your AOL accounts.

The Master Password, if you decide to set one, is required to launch the AOL 
Communicator software on your own computer. 

However, neither your server passwords nor the Master Password protect mail 
that you have stored locally on your own computer. 

As with most other email programs, mail stored locally can easily be read by 
anyone who has access to your computer and knows where to look on your 
hard drive.

Mail stored locally includes messages in any of the following folders that you 
can view from within AOL Communicator Mail:

Folders in Local Mail (including archived AOL mail, if you use this feature)

Folders in POP accounts

Folders in IMAP accounts for which the “Store messages locally for offline 
computing” option has been selected.

If you are storing messages in any of these locations that you don’t want people 
with access to your computer to read, you should create a separate Windows 
system profile for your own use, and protect that profile with a password that’s 
difficult to guess. Note that not all Windows systems support this capability.

Related topics:

Archiving Messages (page 72) 
Storing Messages for Offline Use (page 70) 
Controlling Your Passwords (page 217) 
Turning on Your Master Password (page 214)
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What to Do If You Forget Your Master Password
If you can’t remember your Master Password and you are still viewing the Sign On 
to AOL Communicator window, click the link “Need a password hint?” The hint 
you set when you first set your Master Password (if any) will be displayed.

If you didn’t set a hint, or if you still can’t remember your Master Password, you 
must follow the procedure described below to back up your local mail, uninstall 
both AOL Communicator and your AOL Communicator user profile information, 
reinstall AOL Communicator from scratch, and set up all your accounts again.

Before going through this lengthy process, try again to remember and retype your 
Master Password. It’s possible that you may simply have typed it incorrectly the 
first time.

If you are absolutely certain that you can’t remember your Master Password, 
follow these steps:

1. If the Sign On to AOL Communicator window is still showing, click Cancel. 

2. If the AOL Communicator Help window is still showing, close it. 

To print these instructions before closing the Help window: click the Print 
button. 

3. Open the My Computer icon on your desktop and navigate to the Application 
Data directory for your system user profile:

Windows 2000/XP: C:\Documents and Settings\Windows_Profile_Name\
Application Data\

Windows 98, single user: C:\Windows\Application Data\

Windows 98, multiple users: C:\Windows\Profiles\ 
Windows_Profile_Name\Application Data\

Note: If you cannot see the Application Data directory inside your profile 
directory, open the Tools menu, choose Folder Options, click the View tab, and 
select the option labeled “Show hidden files and folders”.

4. Inside the Application Data directory, open the directory AOL 
Communicator, which contains your user profile information (such as account 
settings and preferences).

5. Inside the directory AOL Communicator, find the local and pop directories, 
and drag them out onto your desktop or any other convenient location.
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6. Click the Start Menu, choose Programs, then AOL Communicator, then Tools, 
then Uninstall AOL Communicator.

If the uninstall program asks whether you want to delete your previous user 
profile for AOL Communicator, click Yes. The instructions that follow describe 
how to move the local and pop directories (which you moved in Step 5) to 
your new profile directory.

7. Open this directory on your computer: C:/Program Files/ 

8. If the directory AOL Communicator is still present inside the Program Files 
directory, delete it. 

If you see a message saying that it can’t be deleted, go on to the next step.

9. If you already have the most recent installer file (ac_install.exe) for AOL 
Communicator, go to Step 12.

10. If you haven't got a copy of the AOL Communicator installer on your hard 
disk, launch your AOL® client software, go to Keyword: AOL Communicator 
and click the button labeled Click to Download Now! 

11. Save the file to any convenient location on your hard disk where you can find it 
again.

12. Double-click ac_install.exe.

You should see the AOL Communicator Setup screens described in the steps 
that follow.

If you didn’t delete your previous AOL Communicator user profile in an 
earlier step, you will be asked whether you want to delete it and create a new 
one. Click Yes. 

13. License Agreement. Click “I Agree” if you agree with the terms of the license.

14. Installation Options. Leave all items selected and click Next.

15. Installation Directory. For most people, the default location is fine—just click 
Install to continue with the installation. 

If you want to specify a different location, click Browse, choose the location 
where you want to install AOL Communicator, click OK, and then click Install.

The Installing Files screen displays the progress of the setup program as it 
installs AOL Communicator.
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16. Completed. The setup program closes and the Account Wizard opens. See 
“Setting Up Mail Accounts” (page 11) for instructions on what to do next. 

If you are asked to restart your computer, click OK. In this case, launch AOL 
Communicator after restarting to open the Account Setup Wizard.

You must start by setting up an AOL member account. If you have more than 
one account, you also need to set up any additional accounts after the main 
AOL Communicator Mail window opens. 

For each new account that you need to set up, open the Edit menu and choose 
New Account, then fill in the requested information as appropriate for that 
account.

17. After all your accounts are set up, close every AOL Communicator window 
(including the Help window).

18. Inside the directory Application Data, locate the directory AOL 
Communicator (the location of the new user profile you just created).

19. Inside the AOL Communicator directory, delete these directories: 
local, pop, mcache, scache.

20. Move your old local and pop directories (which you moved in Step 5) into the 
directory AOL Communicator. 

21. Double-click the AOL Communicator icon on the desktop, or open the Start 
menu and choose Programs, then AOL Communicator, then AOL 
Communicator.

22. When the AOL Communicator Mail window opens, click the Local Mail folder, 
open the File menu, and choose Refresh Folder List. Then select each top-level 
POP account folder and refresh it in the same manner.

All the Local Mail folders from your old profile should now be present, as well 
as any local POP mail you may have stored for your POP accounts.

23. If you want to set a new Master Password, open the Tools menu and choose 
Manage Master Password. 

Warning: Make sure you memorize the password you type, and supply a 
hint in case you forget it again.

Related topics:

Set Master Password (page 224) 
Turn Off Master Password (page 226) 



Managing Passwords

224 AOL Communicator Help • 25 July 2003

Manage Master Password
If you’re not already viewing the Manage Master Password window, open the 
Tools menu in AOL Communicator Mail and choose Manage Master Password. 

Depending on whether your Master Password is currently set, you can perform 
these actions:

• Set Password: If your Master Password isn’t currently set, this is the only 
button available. Click it to define and turn on your Master Password

• Change Password: If your Master Password is currently set, click this button to 
change it. 

• Turn Off Password: Click this button to turn off your Master Password.

Related topics:

Controlling Your Passwords (page 217) 
What to Do If You Forget Your Master Password (page 221) 
HOW IT WORKS: Passwords & Local Mail (page 220) 

Set Master Password
If you’re not already viewing the Set Master Password window, open the Tools 
menu in AOL Communicator Mail, choose Manage Master Password, and click Set 
Password.

• Enter new password: Type your new password here. Check the password 
quality meter as you type. 

Passwords that can be easily guessed have little value. The password quality 
meter gives you a rough idea of the relative quality of your password as you 
type it based on factors such as length and the use of uppercase letters, 
lowercase letters, numbers, and symbols. 

For more information, see “Using the Password Quality Meter” (page 216).

• Confirm new password: Type your new password again. You must type it 
exactly as you did the first time.

• Password hint: Type a word or phrase that only you can associate with your 
Master Password.
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Related topics:

Turn Off Master Password (page 226) 
HOW IT WORKS: Passwords & Local Mail (page 220) 

Change Master Password
If you’re not already viewing the Change Master Password window, open the 
Tools menu in AOL Communicator Mail, choose Manage Master Password, and 
click Change Password.

• Enter current password: Type the current password. If you can’t remember it, 
you can’t use AOL Communicator unless you reinstall it from scratch.

• Enter new password: Type your new password here. Check the password 
quality meter as you type. 

Passwords that can be easily guessed have little value. The password quality 
meter gives you a rough idea of the relative quality of your password as you 
type it based on factors such as length and the use of uppercase letters, 
lowercase letters, numbers, and symbols. 

For more information, see “Using the Password Quality Meter” (page 216).

• Confirm new password: Type your new password again. You must type it 
exactly as you did the first time.

• Password hint: Type a word or phrase that only you can associate with your 
Master Password.

Related topics:

Controlling Your Passwords (page 217) 
What to Do If You Forget Your Master Password (page 221) 
HOW IT WORKS: Passwords & Local Mail (page 220) 
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Turn Off Master Password
If you’re not already viewing the Turn Off Master Password window, open the 
Tools menu in AOL Communicator Mail, choose Manage Master Password, and 
click Turn Off Password.

Your Master Password prevents other people with access to your computer from 
using AOL Communicator. If you turn it off, anyone with access to your computer 
can use AOL Communicator to send and receive mail or log onto your Instant 
Messenger accounts. 

You must enter the current Master Password before you can turn off your Master 
Password. If you can’t remember it, the only alternative is to uninstall AOL 
Communicator, delete your user profile information, and reinstall the program.

Related topics:

Set Master Password (page 224) 
What to Do If You Forget Your Master Password (page 221) 

Change Device Password
The Device Password protects external security devices such as smart cards. You 
normally don’t need such as password unless you have such a device connected to 
your computer.

If you’re not already viewing the Change Device Password window, follow these 
steps:

1. Click the Start Menu, choose Programs, then AOL Communicator, then Tools, 
then AOL Communicator Identity Manager. 

2. Open the Edit menu and choose Security Preferences.

3. Click Password Management.

4. Click Change Password.

Provide the requested information:

• Security Device: Choose the security device whose password you want to 
change. 

The Software Security Device is the default security device provided by AOL 
Communicator. The password for the Software Security Device is identical to 
your Master Password.
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• Enter current password: Type your current device password here.

• Enter new password: Type your new device password here. Check the 
password quality meter as you type. 

Passwords that can be easily guessed have little value. The password quality 
meter gives you a rough idea of the relative quality of your password as you 
type it based on factors such as length and the use of uppercase letters, 
lowercase letters, numbers, and symbols. 

For more information, see “Using the Password Quality Meter” (page 216).

• Confirm new password: Type your new device password again. You must 
type it exactly as you did the first time.

Related topics:

Change Master Password (page 225) 

Master Password Request
Your Master Password prevents other people with access to your computer from 
launching AOL Communicator. 

If you have previously set your Master Password, the Sign On to AOL 
Communicator window appears when you first launch AOL Communicator.

To use the program, you must enter your Master Password and click Sign On.

When you first set your master Password, you can also set a hint to help you 
remember it. If you can’t remember your password, click the link that says “Need a 
password hint?” to see the hint you specified, if any. 

Related topics:

Turn Off Master Password (page 226) 
What to Do If You Forget Your Master Password (page 221) 



Managing Passwords

228 AOL Communicator Help • 25 July 2003

Mail Server Password Request
Depending on your password settings, AOL Communicator Mail may request a 
mail server password to verify your identity when it collects or sends your email 
messages.

Because Instant Messenger for AOL Communicator tracks the status of email from 
your buddies, you may also be asked for one or more mail server passwords when 
you first sign on.

The password request window includes the following information:

Mail Account: The name of this account as it appears in the list of accounts on the 
left side of the main Mail window.

Username: The name shown here is the user name assigned by your ISP for use 
with the server whose host name is shown in parentheses.

Password: Type the password for the user name and server shown above.

If you’re not sure what the password for this user name and server is, ask your ISP 
or system administrator. 

Remember Password: Select this option if you want AOL Communicator Mail to 
remember the password for this screen name, so you don’t have to type it every 
time you launch AOL Communicator.

Note: If you select the Remember Password option, other people with physical 
access to your computer may be able to access your account.

Password quality: Check the password quality meter as you type. 

Passwords that can be easily guessed have little value. The password quality meter 
gives you a rough idea of the relative quality of your password as you type it based 
on factors such as length and the use of uppercase letters, lowercase letters, 
numbers, and symbols. 

Related topics:

Using the Password Quality Meter (page 216) 
Controlling Your Passwords (page 217) 
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AOL Password Request
Depending on your password settings, AOL Communicator Mail may request 
your AOL password to verify your identity when it collects or sends email 
messages from your AOL account.

Because Instant Messenger for AOL Communicator tracks the status of email from 
your buddies, you may also be asked for your AOL password when you first sign 
on.

The password request window includes the following information:

Mail Account: The name of this account as it appears in the list of accounts on the 
left side of the main Mail window.

Username: For an AOL account, the name shown here is your screen name.

Password: Type the password for the user name (screen name) shown above.

Each AOL screen name has its own password. If you’re not sure what the 
password for your screen name is, you can reset it by contacting AOL Customer 
Service. 

Remember Password: Select this option if you want AOL Communicator Mail to 
remember the password for this screen name, so you don’t have to type it every 
time you launch AOL Communicator.

Note: If you select the Remember Password option, other people with physical 
access to your computer may be able to access your AOL account.

Password quality: Check the password quality meter as you type. 

Passwords that can be easily guessed have little value. The password quality meter 
gives you a rough idea of the relative quality of your password as you type it based 
on factors such as length and the use of uppercase letters, lowercase letters, 
numbers, and symbols. 

Related topics:

Using the Password Quality Meter (page 216) 
Controlling Your Passwords (page 217) 
Contacting AOL Customer Service (page 55) 
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Private Key Password Request
The Private Key Password (also known as the Device Password) protects external 
security devices such as smart cards. You normally don’t need this password 
unless you have a security device connected to your computer.

In general, you won’t see this password request unless you have a smart card or 
similar device connected to your computer. Different smart cards have different 
passwords. You must provide the password associated with the smart card that is 
currently connected to your computer. 

Related topics:

Change Device Password (page 226) 

SecurID Password Request
A SecurID card generates passwords at regular intervals. Many organizations use 
these cards to provide extra security—or example, for employee email accounts.

When you are asked for a SecurID password, you must enter the number currently 
displayed on your own SecurID card.

Password Management Preferences
The Password Management preferences panel allows you to change the password 
that protects a security device, such as a smart card, that is currently connected to 
your computer.

If you are not already viewing your Password Management preferences, open the 
Edit menu in Identity Manager, choose Security Preferences, and click Password 
Management.

Change Password. Click this button to change the password for a security device, 
such as a smart card, that is currently connected to your computer.

Related topics:

Change Device Password (page 226)
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Getting Started With Identity Manager
This section is intended for advanced users who already have one or more digital 
certificates and want to use them to send signed and encrypted IM or email 
messages with AOL Communicator. If you don’t currently have a certificate, see 
“Getting Your Own Certificate” (page 235).

If your certificates are stored by Windows for use with Internet Explorer, you can 
synchronize the certificates used by AOL Communicator with those stored by 
Windows. For instructions, see “Synchronize Windows Certificates with AOL 
Communicator” (page 231). 

If your certificates are stored in Netscape® 6.x or Netscape® 7.x, you can export 
them from Netscape and then import them into AOL Communicator. To do so, 
follow the directions in “Export Netscape 6.x/7.x Certificates” (page 232).

Synchronize Windows Certificates with AOL Communicator (page 231) 
Export Netscape 6.x/7.x Certificates (page 232) 
Import Your Certificates (page 233) 
Configure Mail to Use Your Certificates (page 234) 
Configure Instant Messenger Software to Use Your Certificates (page 234) 

Related topic:

Managing Passwords (page 214) 

Synchronize Windows Certificates with AOL 
Communicator
Some Windows certificates may not be exportable: Windows has an option that 
marks new certificates as nonexportable. By default, this option is turned on. 
Certificates that have been marked as nonexportable cannot be exported to any 
other certificate database, and therefore can’t be synchronized as described here.

To synchronize AOL Communicator certificates with the exportable certificates 
stored by Windows for use with Internet Explorer:

1. Click Start, then Programs, then AOL Communicator, then Tools, and choose 
AOL Communicator Identity Manager.

2. In the Personal tab, click Synchronize.

The Synchronize Personal Certificates dialog box appears.
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3. Select the direction in which you want to synchronize:

❍ Both directions. Export AOL Communicator certificates to Windows and 
import Windows certificates to AOL Communicator, so that both sets of 
certificates are identical.

❍ Import into Identity Manager only. Import Windows certificates to AOL 
Communicator. Any certificates already present in AOL Communicator 
but not in Windows will not be exported to Windows.

❍ Export from Identity Manager only. Export AOL Communicator 
certificates to Windows. Any certificates already present in Windows but 
not in AOL Communicator will not be imported to AOL Communicator.

If you haven’t yet imported any certificates into AOL Communicator, either the 
first or second options will work.

Note re Windows 2000: If you have a smart card reader set up, you may have to 
insert the smart card during certificate synchronization, even though the smart 
card isn’t involved in the synchronization process.

Related topics:

You may need to adjust the trust settings for the newly imported certificates before 
using them. For details, see Trust Tab under Certificate Properties (page 255).

To set up your newly imported certificates for signing and encrypting email and 
instant messages, see “Configure Mail to Use Your Certificates” (page 234) and 
“Configure Instant Messenger Software to Use Your Certificates.” (page 234).

Export Netscape 6.x/7.x Certificates
To export your certificates from Netscape 6.x or Netscape 7.x in a .p12 file that you 
can then import into AOL Communicator, follow these steps:

1. Launch the Netscape program.

2. Open the Edit menu and choose Preferences.

3. Under the Privacy & Security category, click Certificates. (If no subcategories 
are visible, double-click Privacy & Security to expand the list.)

4. Click Manage Certificates.

5. In the Your Certificates tab, Shift-click to select the certificates you want to 
export, then click Backup.
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6. Navigate to the location where you want to store your exported certificates file, 
type a name for the file, and click Save.

7. Enter your Master Password for the security device on which the certificates 
are stored, then click OK.

8. Type a password to protect the file you are exporting. You must type exactly 
the same password twice, once in each field. Then click OK.

You’ll see a message confirming that you have successfully backed up your 
certificates. To import them into AOL Communicator, follow the directions in 
the next section.

Import Your Certificates
To import certificates saved as a .p12 file on your hard disk, follow these steps:

1. Click Start, then Programs, then AOL Communicator, then Tools, and choose 
AOL Communicator Identity Manager.

2. Click Import.

3. Select the .p12 file that contains your certificates and click Open.

4. If necessary, enter a new password for the Software Security Device, which is 
where AOL Communicator stores your certificates internally. Type the same 
password in each field, then click OK.

5. Enter the password used to protect your the .p12 file you want to import.

If the importing is successful, the imported certificates appear in the list of your 
personal certificates.

You can now configure AOL Communicator Mail and Instant Messenger for AOL 
Communicator to use these certificates for signing and encrypting messages. The 
next two sections describe how.

Related topic:

You may need to adjust the trust settings for the newly imported certificates before 
using them. For details, see Trust Tab under Certificate Properties (page 255).
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Configure Mail to Use Your Certificates
To configure Mail to use your imported certificates for signing and encrypting 
email messages, follow these steps:

1. In Mail, open the Edit menu and choose Account Settings.

2. Double-click the name of the account with which you want to use your 
certificates. (You can’t use certificates with AOL accounts.)

3. Click the Security tab.

4. Select your certificates from the two drop-down lists:

❍ Use this certificate to digitally sign messages sent from this account.

❍ Use this certificate to encrypt and decrypt messages for this account

5. If you wish to sign and/or encrypt all messages by default (unless you indicate 
otherwise in the Write Mail window), select one or both of these checkboxes:

❍ Digitally sign messages by default

❍ Encrypt messages by default

6. Click OK to confirm your changes and return to the Account Settings dialog 
box.

7. Click OK to return to the main Mail window.

You can now send signed email messages and use encryption.

Configure Instant Messenger Software to Use 
Your Certificates
To configure Instant Messenger for AOL Communicator to use your imported 
certificates for signing and encrypting instant messages, follow these steps:

1. From your Buddy List® window, open the MyIM menu and choose 
Preferences.

The Instant Messenger Preferences window appears.

2. Click Security in the left column.
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3. Select your certificates from the two drop-down lists:

❍ Encryption Certificate

❍ Signing Certificate

4. Click OK.

5. If you are asked to provide your password, type the password you created 
earlier for the Software Security Device and click OK.

You can now send signed and encrypted instant messages to buddies who are also 
using Instant Messenger for AOL Communicator or any other version of AIM 
software that supports encryption, as long as they have also configured their 
certificates correctly.

Related topics:

Import Your Certificates (page 233) 

Getting Your Own Certificate
Much like a credit card or a driver's license, a certificate is a form of identification 
you can use to identify yourself over the Internet and other networks. Like other 
commonly used personal IDs, a certificate is typically issued by an organization 
with recognized authority to issue such identification. An organization that issues 
certificates is called a certificate authority (CA).

You can obtain certificates that identify you from public CAs, from system 
administrators or special CAs within your organization, or from web sites offering 
specialized services that require a means of identification more reliable that your 
name and password.

Just as the requirements for a driver's license vary depending on the type of vehicle 
you want to drive, the requirements for obtaining a certificate vary depending on 
what you want to use it for. In some cases getting a certificate may be as easy as 
going to a web site, entering some personal information, and automatically 
downloading the certificate into AOL Communicator. In other cases you may have 
to go through more complicated procedures.

You can obtain a certificate today by visiting the URL for a certificate authority and 
following the on-screen instructions. For a list of certificate authorities, see the 
online document available at https://certs.netscape.com
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Once you obtain a certificate, it is automatically stored in a security device. AOL 
Communicator comes with its own built-in Software Security Device. A security 
device can also be a piece of hardware, such as a smart card.

Like a driver's license or a credit card, a certificate is a valuable form of 
identification that can be abused if it falls into the wrong hands. Once you've 
obtained a certificate that identifies you, you should protect it in two ways: by 
backing it up and by setting your Master Password.

For detailed information about backing up a certificate and setting your Master 
Password, see “Personal Certificates” (page 237). 

Managing Certificates
You can use Identity Manager to manage the certificates you have available. 
Certificates may be stored on your computer's hard disk or on smart cards or other 
security devices attached to your computer.

To open Identity Manager, click Start, then Programs, then AOL Communicator, 
then Tools, and choose AOL Communicator Identity Manager.

Personal Certificates (page 237) 
Export Certificate (page 238) 
Import Certificate (page 239) 

Certification Authorities (page 239) 
Other People's Certificates (page 241) 
Web Site Certificates (page 242) 
Miscellaneous Certificates (page 243) 

Certificate Selection Settings (page 243) 
Server Certificate Problem (page 244) 
User Identification Request (page 246) 
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Personal Certificates
Identity Manager has several tabs. The first is labeled Personal and displays the 
certificates on file that identify you. Your personal certificates are listed under the 
names of the organizations that issued them.

• If you can't see certificate names under an organization's name, double-click 
the name.

• To select a certificate, click its name.

• To select more than one certificate, hold down the Control key and click their 
names.

To perform the following actions, select one or more certificates and click the 
corresponding buttons

• Properties: Display detailed information about the selected certificates. 

The Properties button is available only if a single certificate is selected. You 
can’t open Properties for multiple certificates at the same time.

• Delete: Delete the selected certificates.

Before deleting a personal certificate that has expired, make sure you won't 
need it again for reading old email messages that you may have encrypted 
with the corresponding private key.

• Export: Initiate the process of saving the selected certificates. A window 
appears that allows you to choose a password to protect the exported file. You 
can then save it in a directory of your choice.

Note: Certificates on smart cards cannot be exported. You can only export 
certificates that are stored on the built-in Software Security Device.

These actions do not require a certificate to be selected:

• Import: Import a file containing one or more certificates that were previously 
exported. 

When you click Import, Identity Manager first asks you to locate the file that 
contains the backup. The names of certificate backup files typically end in 
.p12; for example, MyCert.p12. After you select the file to be imported, 
Identity Manager asks you to enter the password that you set when you 
exported the certificate.

• Synchronize. Synchronize AOL Communicator certificates with the certificates 
stored by Windows for use with Internet Explorer.
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Related Topic:

Synchronize Windows Certificates with AOL Communicator (page 231)

Export Certificate
When you click Export in the Personal Certificates tab of the Identity Manager, you 
will be asked to create a private key password. 

This password protects the file into which you are exporting personal certificates. 
Identity Manager requests this password when you attempt to import certificates 
that have previously been exported.

• Enter new password: Type the new password for your export file into this 
field. Check the password quality meter as you type.

• Confirm new password: Type your backup password again. If you don't type 
it the second time exactly as you did the first time, you’ll see an error message 
when you click OK. If this happens, try typing the new password again.

If someone obtains the file containing a certificate that you have backed up and 
successfully imports the certificate, that person can send messages or access web 
sites while pretending to be you. This can be a problem, for example, if you 
digitally sign important email messages or manage your bank or investment 
accounts over the Internet.

Therefore, it's important to select a password that is difficult to guess. The 
password quality meter gives you a rough idea of the quality of your password as 
you type it based on factors such as length and the use of uppercase letters, 
lowercase letters, numbers, and symbols. It does not guarantee that your password 
cannot be guessed, however.

For more information, see “Using the Password Quality Meter” (page 216).

It's also important to record the password in a safe place—and not anywhere that's 
easily accessible to someone else. If you forget this password, you can't import the 
exported certificates.
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Import Certificate
When you click Import in the Personal Certificates tab of the Identity Manager, you 
will be asked to enter the private key password that was used to encrypt the 
certificate backup file you are attempting to import. 

You must enter the same password that was used to protect the backup file when it 
was created. If you didn’t create the backup file yourself, check with your system 
administrator. 

You can’t import the certificates in the backup file without entering this password.

The password quality meter gives you a rough idea of the relative quality of your 
password as you type it based on factors such as length and the use of uppercase 
letters, lowercase letters, numbers, and symbols. 

Related topic:

Using the Password Quality Meter (page 216)

Certification Authorities
The Certification Authorities tab in Identity Manager displays the certificates you 
have on file that identify certificate authorities (CAs). (If you’re not sure how to 
open Identity Manager, see Managing Certificates on page 236.)

CA certificates are grouped under the names of the organizations that issued them:

• If you can't see CA certificate names under an organization's name, 
double-click the name.

• To select a CA certificate, click its name.

• To select more than one CA certificate, hold down the Control key and click 
their names.
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To perform the following actions, select one or more certificates and click the 
corresponding buttons

• Properties: Display and edit detailed information about the selected 
certificates. 

The Properties button is available only if a single certificate is selected. 

Click this button to designate a CA certificate as one that you trust or don't 
trust for identification purposes.

To ensure that an entire certificate chain of CAs are all trusted, you need to edit 
the root CA certificate only.

The root and intermediate CAs all appear under the same organization. The 
root certificate is the one that lists itself as the issuer.

• Delete: Delete the selected certificates.

Before deleting a CA certificate, make sure that you won't need it again to 
validate certificates issued by that CA. If you delete the only valid certificate 
you have for a CA, Identity Manager will no longer trust any certificates issued 
by that CA. 

• Export: Initiate the process of saving the selected certificates. You can save the 
exported file in a directory of your choice.

Note: Certificates on smart cards cannot be exported. You can only export 
certificates that are stored on the built-in Software Security Device.

This action does not require a certificate to be selected:

• Import: Import a file containing a CA certificate or a chain of CA certificates. 

After you click Import, you can either provide an URL or import the certificate 
from a file.

When you click Import, Identity Manager first asks you to locate the file that 
contains the backup. The names of CA certificate backup files typically end in 
.p7b; for example, CACertBackup.p7b. 
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Other People's Certificates
The Other People tab in Identity Manager displays email certificates you have on 
file that identify other people. (If you’re not sure how to open Identity Manager, 
see Managing Certificates on page 236.)

When people send you digitally signed email messages, Identity Manager imports 
their certificates automatically. You can use these certificates to send encrypted 
messages to those people.

Other people's certificates are listed under the names of the organizations that 
issued them:

• If you can't see certificate names under an organization's name, double-click 
the name.

• To select a certificate, click its name.

• To select more than one certificate, hold down the Control key and click their 
names.

To perform the following actions, select one or more certificates and click the 
corresponding buttons

• Properties: Display and edit detailed information about the selected 
certificates. Click this button to designate another person’s certificate as one 
that you trust or don't trust for identification purposes.

The Properties button is available only if a single certificate is selected. 

• Delete: Delete the selected certificates.

Before deleting someone else's certificate, make sure you won't need it again to 
send encrypted email to that person.

• Export: Initiate the process of saving the selected certificates. You can save the 
exported certificate in a directory of your choice.

Note: Certificates on smart cards cannot be exported. You can only export 
certificates that are stored on the built-in Software Security Device.
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This action does not require a certificate to be selected:

• Import: Import a file containing one or more certificates identifying other 
people.

After you click Import, you can either provide an URL or import the certificate 
from a file.

When you click Import, Identity Manager first asks you to locate the file that 
contains the backup. The names of backup files for other people’s typically end 
in .p7b; for example, CertBackup.p7b. 

Web Site Certificates
The Websites tab in Identity Manager displays email certificates you have on file 
that identify web sites. (If you’re not sure how to open Identity Manager, see 
Managing Certificates on page 236.)

Web site certificates are grouped under the names of the organizations that issued 
them:

• If you can't see certificate names under an organization's name, double-click 
the name.

• To select a certificate, click its name.

• To select more than one certificate, hold down the Control key and click their 
names.

To perform the following actions, select one or more certificates and click one of the 
following buttons:

• Properties: Display and edit detailed information about the selected 
certificates. Click this button to designate a web site certificate as one that you 
trust or don't trust for identification purposes.

The Properties button is available only if a single certificate is selected. 

• Delete: Delete the selected certificates.

Before deleting a web site certificate from the Websites tab in the Certificate 
Manager, make sure that you won't need it again for the purposes of 
identifying a web site and setting up an encrypted connection.
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• Export: Initiate the process of saving the selected certificates. A window 
appears that allows you to choose a password to protect the exported file. You 
can then save it in a directory of your choice.

Note: Certificates on smart cards cannot be exported. You can only export 
certificates that are stored on the built-in Software Security Device.

This action does not require a certificate to be selected:

• Import: Import a file containing one or more certificates that were previously 
exported. 

After you click Import, you can either provide an URL or import the certificate 
from a file.

When you click Import, Identity Manager first asks you to locate the file that 
contains the backup. The names of backup files for web site certificates 
typically end in .p7b; for example, WebSiteCertBackup.p7b. 

Miscellaneous Certificates
The Miscellaneous tab in Identity Manager displays certificates that don’t fit in any 
of the other available categories. (If you’re not sure how to open Identity Manager, 
see Managing Certificates on page 236.)

In general, certificates stored in this tab are either incorrectly configured or 
configured for special purposes. Consult your system administrator or certificate 
issuer for more information. 

Certificate Selection Settings
Some mail servers require you to identify yourself with a certificate. The Certificate 
Settings preference panel allows you to determine how AOL Communicator 
identifies the certificate to present among those you may have on file.

If you are not already viewing Certificate Settings, open the Edit menu in Identity 
Manager and choose Security Preferences. 

You can choose one of these options:

• Choose automatically from the available certificates: Click this option if you 
want AOL Communicator to select a certificate without asking you. This is the 
default setting.
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• Prompt me to choose a certificate every time: Click this option if you want 
AOL Communicator to ask you which certificate to use each time a server 
requests one. 

Server Certificate Problem
If there is a problem with the certificate used to identify one of your mail servers, 
you’ll see a Security Error window that describes the problem.

For example, you might see an error message if you attempt to send a message to a 
server that has a certificate problem.

When you’re alerted of a problem with a server certificate, you have three options:

• To view the certificate that has the problem, click View Certificate. 

This button opens the Certificate Properties window while the Security Error 
window remains open. You can view the certificate’s properties before making 
a decision about whether to continue with the connection.

• To connect to the server anyway, click OK. 

• To cancel whatever operation you were attempting to perform, click Cancel.

Some problems related to server certificates are potentially serious. Unless you are 
familiar with the problem listed and know exactly how to handle it, you should 
consult your ISP or system administrator before attempting to connect to the 
server.

Here’s some further information about problems that this window may describe:

Domain name mismatch: The domain name in the server’s certificate doesn’t 
match the server’s actual domain name. This may be a sign that someone is 
attempting to intercept your communication with the web site.

Most commercial server administrators make sure that the host name for a web site 
certificate matches the web site's actual host name. In some cases, the server 
administrator may be aware of the problem but has decided not to fix it.

The certificate was issued by an unknown certificate authority: AOL 
Communicator doesn’t recognize the certificate authority (CA) that issued the 
server’s certificate. The most likely explanation is that the certificate identifying the 
CA is not included in Identity Manager’s list of CA certificates.

If you are sure that you’ve entered your server information correctly, you can 
choose to trust the certificate itself even if the CA certificate isn’t available. For 
details, see the Trust Tab section of “Certificate Properties.” (page 255). 
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The certificate was issued by a certificate authority that you do not trust. AOL 
Communicator has a copy of the certificate identifying the certificate authority 
(CA) that issued the server’s certificate. However, there is a problem with the trust 
settings for the CA certificate. 

If you are sure that the server certificate is valid, you can choose to trust the server 
certificate itself and/or the CA that issued the certificate. For details, see the Trust 
Tab section of “Certificate Properties.” (page 255). 

The security certificate is not trusted by you: There is a problem with the trust 
settings for your copy of the server certificate. 

If you are sure that the certificate is valid, you can choose to trust the server 
certificate itself. For details, see the Trust Tab section of “Certificate Properties.” 
(page 255).

The CA certificate that issued the site’s certificate has expired or is not yet valid; 
OR the server certificate has expired or is not yet valid: Make sure the time and 
date displayed by your computer is correct. If your computer's clock is set to a date 
that is before or after the validity period for a certificate, AOL Communicator treats 
the certificate as expired.

If your computer's clock is set correctly, you need to make a decision about 
whether to trust the server. Most commercial sites will make sure that they replace 
their certificates before they expire. 

There should be a more recent CRL available: Certificate Revocation Lists (CRLs) 
identify certificates that the issuer has declared invalid. 

For more information. about CRLs, see “Controlling Certificate Validation” 
(page 252). 

The certificate has been revoked: The issuer of the server certificate has declared it 
invalid.
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User Identification Request
Some servers require that you identify yourself with a certificate rather than a 
name and password. A certificate is the digital equivalent of an ID card.

However, AOL Communicator may have more than one certificate on file that can 
be used to identify you to the server. In this case, you’ll see the User Identification 
Request window, which displays the following information:

This site has requested that you identify yourself with a certificate: 

• The name of the server requesting identification, used as part of its URL. For 
example, the host name for the Netscape web site is home.netscape.com.

• Organization: The name of the organization that runs the server.

• Issued under: The name of the certificate authority (CA) that issued the 
certificate.

Choose a certificate to present as identification: The drop-down list in this section 
includes all the certificates you have available that can identify you to a server. 

Details of selected certificate: To help you decide which certificate to use, you can 
check this information about the selected certificate:

Issued to: Lists information about the person identified by the certificate (for 
example, your name and email address) and the certificate's serial number and 
validity dates.

Issued by: Summarizes information about the CA that issued the certificate, such 
as its name, location, and state.
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Managing SSL Settings and Warnings
The Secure Sockets Layer (SSL) protocol allows your computer to exchange 
information with other computers on the Internet in encrypted form—that is, the 
information is scrambled while in transit so that it is harder to read and make sense 
of. SSL is also used to identify computers on the Internet by means of certificates.

You shouldn't adjust your SSL settings unless you know what you're doing or have 
the assistance of someone else who does. If you do need to adjust them for some 
reason, follow the directions in the next section.

SSL Settings
The SSL Settings preference panel allows you to control the protocols used by AOL 
Communicator for SSL and the warnings it displays to keep you informed of the 
encryption status of connections AOL Communicator makes with servers.

If you are not already viewing SSL Settings, open the Edit menu in Identity 
Manager, choose Security Preferences, and click SSL Settings.

SSL Protocol Versions 

The Secure Sockets Layer (SSL) protocol defines rules governing mutual 
authentication between a web site and client software and the encryption of 
information that flows between them. The Transport Layer Security (TLS) protocol 
is an IETF standard based on SSL. TLS 1.0 can be thought of as SSL 3.1.

You should normally leave these three checkboxes selected to ensure that both 
older and newer web servers can work with AOL Communicator:

• Enable SSL version 2: Allows older web servers to work with AOL 
Communicator.

• Enable SSL version 3: Allows newer web servers to work with AOL 
Communicator.

• Enable TLS: Allows web servers that support TLS to take advantage of it.

To turn individual ciphers on or off, click the Edit Ciphers button:

• Edit Ciphers: Don't attempt to edit ciphers individually unless you know 
exactly what you are doing and have cleared the changes with your system 
administrator. 
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Important note re TLS: Some servers that do not implement SSL correctly cannot 
negotiate the SSL handshake with client software (such as AOL Communicator) 
that supports TLS. Such servers are known as "TLS intolerant."

When the Enable TLS option in the SSL preferences panel is selected, AOL 
Communicator attempts to use the TLS protocol when making secure connections 
with a server. If that connection fails because the server is TLS intolerant, AOL 
Communicator falls back to using SSL 3.0.

SSL Warnings

To activate any of these warnings, select the corresponding checkbox:

• Connecting to a server that supports encryption: Select this warning if you 
want to be reminded whenever you are connecting to a server that supports 
encryption.

• Connecting to a server that uses low-grade encryption: Select this warning if 
you want to be reminded whenever you are connecting to a server that 
supports low-grade encryption. (Low-grade encryption is the weakest 
encryption available, using 40-bit keys.)

Managing Smart Cards and Other Security 
Devices

A smart card is a small device, typically about the size of a credit card, that contains 
a microprocessor and is capable of storing information about your identity (such as 
your private keys and certificates) and performing cryptographic operations.

To use a smart card, you typically need to have a smart card reader (a piece of 
hardware) attached to your computer, as well as software on your computer that 
controls the reader.

A smart card is just one kind of security device. A security device (sometimes 
called a token) is a hardware or software device that provides cryptographic 
services and stores information about your identity. 
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You use the Security Devices window to work with smart cards and other security 
devices. To open the Security Devices window from Identity Manager, open the 
Edit menu and choose Security Devices.

About Security Devices and Modules (page 249) 
Loading Security Modules (page 250) 
Enabling FIPS Mode (page 250) 
Security Devices (page 251) 

About Security Devices and Modules
The Security Devices window lists the available security devices. You can use this 
window to manage any security devices, including smart cards, that support the 
Public Key Cryptography Standard (PKCS) #11.

A PKCS #11 module (sometimes called a security module) controls one or more 
security devices in much the same way that a software driver controls an external 
device such as a printer or modem. If you are installing a smart card, you must 
install the PKCS #11 module for the smart card on your computer as well as 
connecting the smart card reader.

By default, Identity Manager controls two internal PKCS #11 modules that manage 
three security devices:

• Netscape Internal PKCS #11 Module: Controls two security devices:

❍ Generic Crypto Services: A special security device that performs all 
cryptographic operations required by the Netscape Internal PKCS #11 
Module.

❍ Software Security Device: Stores your certificates and keys that aren't 
stored on external security devices, including any CA certificates that you 
may have installed in addition to those that come with AOL 
Communicator.

• Builtin Roots Module: Controls a special security device called the Builtin 
Object Token. This security device stores the default CA certificates that come 
with AOL Communicator.

You use the Security Devices window to work with smart cards and other security 
devices. To open the Security Devices window from Identity Manager, open the 
Edit menu and choose Security Devices.
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Loading Security Modules
If you want to use a smart card or other external security device, you must first 
install the module software on your computer and, if necessary, connect any 
associated hardware. Follow the instructions that come with the hardware.

After a new module is installed on your computer, follow these steps to load its 
software:

1. From Identity Manager, open the Edit menu and choose Security Devices.

2. Click Load.

3. In the Load Device dialog box, enter the following:

❍ Device Name: The name you want the Security Devices window to display 
for this device.

❍ Device File: The complete pathname to the name of the file. For example: 

C:\software\new_module_file 

4. Click OK. 

The new module shows up in the list of modules with the name you assigned 
to it.

To unload a PKCS #11 module, select its name and click Unload. 

Enabling FIPS Mode
Federal Information Processing Standards Publications (FIPS PUBS) 140-1 is a US 
government standard for implementations of cryptographic modules—that is, 
hardware or software that encrypts and decrypts data or performs other 
cryptographic operations (such as creating or verifying digital signatures). Many 
products sold to the US government must comply with one or more of the FIPS 
standards.

To enable FIPS mode for AOL Communicator, follow these steps:

1. From Identity Manager, open the Edit menu and choose Security Devices.

2. Click the Enable FIPS button. 

When FIPS is enabled, the name NSS Internal PKCS #11 Module changes to 
NSS Internal FIPS PKCS #11 Module and the Enable FIPS button changes to 
Disable FIPS. 
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To disable FIPS-mode, click Disable FIPS.

Security Devices
This section describes the options available in the Security Devices window. If you 
are not already viewing it, open the Edit menu in Identity Manager and choose 
Security Devices.

The Security Devices window lists each available PKCS #11 module and the 
security devices managed by each module below its name.

When you select a security device, information about it appears on the right side of 
the Security Devices window, and some of the buttons at the bottom of the window 
become available. 

In general, you perform an action on a module or device by selecting its name and 
clicking the appropriate button:

• Login: Log into the selected security device.

You will be asked to enter the private key password for the device. 

• Logout: Log out of the selected security device. After you have logged out of 
the device, the device and the certificates it contains will not be available until 
you log in again.

• Change Password: Change the private key password for the selected security 
device.

• Load: Displays a dialog box that allows you to specify the name and location of 
a new PKCS #11 module. Before adding a new module, you should first install 
the module software on your computer and if necessary connect any associated 
hardware device. Follow the instructions provided by the vendor.

• Unload: Unload the selected module. If you unload a module, both the module 
and its security devices are no longer available for use by AOL Communicator.

• Enable FIPS: Turns the FIPS mode on and off. For more information, see 
Enabling FIPS Mode (page 250). 

You can perform these actions on most security devices. However, you cannot 
perform them on the Builtin Object Token or Generic Crypto Services, which are 
special devices that must be available at all times.
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Controlling Certificate Validation
Certificate validation is an advanced feature available only to users who use digital 
certificates. 

You shouldn’t adjust your validation preferences unless you have one or more of 
your own certificates and have discussed the appropriate settings with your 
system administrator or certificate issuer.

Settings & Preferences: 
Certificate Validation Preferences (page 252) 
Manage CRLs (page 253) 

Certificate Validation Preferences
Certificate Validation Preferences control the way AOL Communicator validates 
certificates, or digital IDs. 

You shouldn’t adjust these preferences unless you have one or more of your own 
certificates and have discussed the appropriate settings with your system 
administrator or certificate issuer.

If you are not already viewing your Certificate Validation preferences, open the 
Edit menu in Identity Manager, choose Security Preferences, and click Certificate 
Validation.

CRL

A certificate revocation list (CRL) is a list of revoked certificates that is generated 
and signed by a certificate authority (CA). It's possible to download a CRL for use 
by AOL Communicator to check that certificates are still valid before permitting 
their use for authentication.

Manage CRLs: Click this button to see a list of the CRLs currently available to AOL 
Communicator.

OCSP

The Online Certificate Status Protocol (OCSP) makes it possible for AOL 
Communicator to perform an online check of a certificate's validity each time the 
certificate is viewed or used. This process involves checking the certificate against a 
certificate revocation list (CRL) maintained at a specified web site. Your computer 
must be online for OCSP to work.
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To specify how AOL Communicator uses OCSP, choose one of these settings in the 
OCSP section of Certificate Validation Preferences:

• Do not use OCSP for certificate verification: Select this setting if you don't 
want AOL Communicator to perform an online status check each time it 
verifies a certificate. Instead, whenever AOL Communicator performs 
certificate verification, it only confirms the certificate's validity period and that 
it is correctly signed by a CA whose own CA certificate is both listed under the 
Certificate Authorities tab (in the main Identity Manager window) and marked 
as trusted for issuing that kind of certificate.

• Use OCSP to verify only certificates that specify an OCSP service URL: 
Select this setting if you want AOL Communicator to perform an online status 
check each time it verifies a certificate that specifies a URL for the purpose of 
performing such a check. If a URL is specified by the certificate, AOL 
Communicator makes sure that the certificate is listed there as valid and checks 
the validity period and trust settings.

• Use OCSP to verify all certificates, using the URL and signer specified here: 
Select this setting if you want AOL Communicator to perform an online status 
check each time it verifies any certificate. If you select this setting, you should 
also choose the certificate from the Response Signer pop-up menu that 
identifies the signer of the OCSP responses. With this setting, the only 
certificates Certificate Manager recognizes are those that can be verified by an 
OCSP response signed with the Response Signer certificate (or signed using a 
certificate that chains to it).

When you choose a Response Signer certificate, Certificate Manager fills in the 
Service URL (if available) for that signer automatically. If the Service URL is 
not filled in automatically, you must provide it yourself; ask your system 
administrator for details. 

Related topics:

Getting Started With Identity Manager (page 231) 
Getting Your Own Certificate (page 235) 

Manage CRLs
The Manage CRLs window displays a list of the CRLs that you have installed for 
use by AOL Communicator. 

You shouldn’t adjust your CRL settings unless you have discussed them with your 
system administrator or certificate issuer. 
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If you are not already viewing the Manage CRLs window, open the Edit menu in 
Identity Manager, choose Security Preferences, click Certificate Validation, and 
click Manage CRLs. 

To select a CRL, click it. You can then perform any of these actions: 

• Import: Allows you to specify (as a URL or file) and import a CRL 

• Delete: Deletes the CRL permanently from your hard disk. Don't do this unless 
you're sure you no longer need the CRL for validating certificates. If in doubt, 
consult your system administrator. 

• Update: Immediately updates the selected CRL (if possible). 

• Edit Prefs: Opens a window that allows you to activate automatic CRL 
updates for the selected CRL and specify how frequently they should be 
performed. 

The Manage CRLs window provides the following information about each CRL:

• Organization (O): The name of the organization that issued the CRL.

• Organizational Unit (OU): The name of the organizational unit that issued the 
CRL (such as the root CA for a particular kind of certificate).

• Last Update: The date on which AOL Communicator's copy of this CRL was 
last updated.

• Next Update: The next date on which an updated version of this CRL will be 
published by the CRL issuer.

• Auto Update: Indicates whether Auto Update has been enabled for this CRL. 
To view the settings that control auto updating, select the CRL and click 
Settings.

• Status: 

If Auto Update has not been enabled, or if it has been enabled but the next 
scheduled update has not yet occurred, this field will be blank.

After at least one auto update has occurred, this field shows "failed" if the most 
recent auto update failed, or "OK" if the most recent auto update was 
successful. 
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Certificate Properties
The Certificate Properties dialog box displays information about a certificate and 
allows you to edit the certificate’s trust settings.

To view the properties or edit the trust settings for any certificate listed in Identity 
Manager, select the certificate and click Properties.

General Tab (page 255) 
Details Tab (page 256) 
Trust Tab (page 257) 

General Tab
When you first open Certificate Properties, the General tab displays several kinds 
of information about the selected certificate:

Certificate Verification: See Controlling Certificate Validation (page 252) for a 
discussion of how AOL Communicator verifies certificates. “Verified Purposes” 
can include any of the following:

• SSL Client Certificate: Certificate used to identify you to web sites.

• SSL Server Certificate: Certificate used to identify a web site server to Email 
Signer Certificate: Certificate used to identify you for the purposes of digitally 
signing email messages.

• Email Recipient Certificate: Certificate used to identify someone else, for 
example so you can send that person encrypted email.

• Email Signer Certificate: Certificate used to identify you, for example when 
you send someone else encrypted email.

• Status Responder Certificate: Certificate used to identify an online status 
responder that uses the Online Certificate Status Protocol (OCSP) to check the 
validity of certificates. For more information about OCSP, see “Certificate 
Validation Preferences” (page 252). 

• SSL Certificate Authority: Certificate used to identify a certificate 
authority—that is, a service that issues certificates for use as identification over 
computer networks.
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Certificate Summary: This section of the General Tab summarizes the following 
information about the certificate. To examine the certificate contents in more 
details, click the Details tab:

• Issued By: Summarizes information (similar to that provided under "Issued 
To"; see above) about the certificate authority (CA) that issued the certificate.

• Issued To: Summarizes the following information about the certificate:

❍ Common Name: The name of the person or other entity that the certificate 
identifies.

❍ Organization: The name of the organization to which the entity belongs 
(such as the name of a company).

❍ Organizational Unit: The name of the organizational unit to which the 
entity belongs (such as Accounting Department).

❍ Serial Number: The certificate's serial number.

• Validity: Indicates the period during which the certificate is valid.

• Fingerprints: Lists the certificate's fingerprints. A fingerprint is a unique 
number produced by applying a mathematical function to the certificate 
contents. A certificate's fingerprint can be used to verify that the certificate has 
not been tampered with.

Details Tab
Click the Details tab at the top of Certificate Properties to see more detailed 
information about the selected certificate. To examine information for any 
certificate in the Certificate Hierarchy area, select its name, select the field under 
Certificate Fields that you want to examine, and read the field's value under Field 
Value.

Certificate Hierarchy: Displays the certificate chain, with the certificate you 
originally selected at the bottom. A certificate chain is a hierarchical series of 
certificates signed by successive certificate authorities (CAs). A CA certificate 
identifies a certificate authority and is used to sign certificates issued by that 
authority. A CA certificate can in turn be signed by the CA certificate of a parent 
CA and so on up to a root CA.

Certificate Fields: Displays the fields of the certificate selected under Certificate 
Hierarchy.

Field Value: Displays the value of the field selected under Certificate Fields.
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The Certificate Viewer displays basic ANSI types in human-readable form 
wherever possible. For fields whose contents the Certificate Manager cannot 
interpret, it displays the actual values contained in the certificate.

Trust Tab
The Trust tab allows you to view and edit the trust settings for the certificate whose 
properties you are viewing and all the related certificates in its certificate chain. If 
you make any changes to trust settings shown in this tab, you must click OK to 
confirm them.

A certificate chain is a hierarchical series of certificates signed by successive 
certificate authorities. A CA certificate identifies a certificate authority (CA) and is 
used to sign certificates issued by that authority. A CA certificate can in turn be 
signed by the CA certificate of a parent CA and so on up to a root CA. 

Certificate Hierarchy and Trust Settings: This portion of the Trust tab displays the 
certificate chain. 

To make sure all the certificates in the chain are visible, make sure all the triangles 
beside the issuer names are pointing downward. If a triangle is pointing sideways, 
click it once to display the certificate from that issuer.

The checkboxes beside each certificate indicate what purposes it is trusted for. The 
effect of selecting a checkbox in one of the three columns depends on the type of 
certificate and its position in the certificate chain:

• Email: If this checkbox is selected for the bottom certificate, AOL 
Communicator trusts the certificate when it is used to sign or encrypt email 
messages or instant messages. 

If this checkbox is not selected for the bottom certificate, AOL Communicator 
does not trust the certificate for this purpose.

If this checkbox is selected for any CA certificate in the chain, AOL 
Communicator trusts all certificates issued by the corresponding CA for the 
purpose of signing or encrypting email. 

If this checkbox is not selected for a CA certificate, AOL Communicator does 
not trust any email certificates issued by the corresponding CA.
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• SSL: If this checkbox is selected for the bottom certificate, AOL Communicator 
trusts the certificate when it is used to identify web sites or encrypt web site 
connections. (This may be helpful, for example, when you have specified a 
secure connection for mail account server.) 

If this checkbox is not selected for the bottom certificate, AOL Communicator 
does not trust the certificate for this purpose.

If this checkbox is selected for any CA certificate in the chain, AOL 
Communicator trusts all certificates issued by the corresponding CA for the 
purpose of identifying web sites and encrypting web site connections. 

If this checkbox is not selected for a CA certificate, AOL Communicator does 
not trust any web site certificates issued by the corresponding CA.

• Software: If this checkbox is selected for the bottom certificate, AOL 
Communicator trusts the certificate when it is used to identify software 
developers or publishers.

If this checkbox is not selected, AOL Communicator does not trust the 
certificate for this purpose.

If this checkbox is selected for any CA certificate in the chain, AOL 
Communicator trusts all certificates issued by the corresponding CA for the 
purpose of identifying software developers or publishers.

If this checkbox is not selected for a CA certificate, AOL Communicator does 
not trust any certificates issued by this CA for this purpose

Trust details for the selected certificate: When you select a certificate in 
“Certificate Hierarchy and Trust Settings” area near the top of the tab, more 
detailed trust information appears in this area.
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Appendix A

Technical Appendix

The information provided in this appendix is for advanced users only. You don’t 
need it for normal operation of AOL® Communicator.

Location of Installed Files (page 259) 
Updating a Previous Installation (page 260) 
Changing Your Regional Options (page 262) 

Location of Installed Files
This information is provided for advanced users only. You don’t need to know 
these details for normal use of AOL Communicator.

Unless you changed the default location during installation, the AOL 
Communicator installation directory is located here:

C:\Program Files\AOL Communicator

Your preferences and other personal settings are stored here:

Windows 2000/XP: C:\Documents and Settings\Windows_Profile_Name\
Application Data\AOL Communicator

Windows 98, single user: C:\Windows\Application Data\
AOL Communicator

Windows 98, multiple users: C:\Windows\Profiles\ 
Windows_Profile_Name\Application Data\
AOL Communicator

where Windows_profile_name is the name of the Windows profile you are using 
when you install AOL Communicator. 
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In addition to AOL Communicator, the Application Data directory includes the 
directory NSS PKI Store, which stores your passwords, certificates, and other 
security-related information.

Updating a Previous Installation
Updating AOL Communicator is easy—just follow the regular installation 
instructions in “Installing AOL Communicator” (page 8). If you’re asked whether 
you want to keep your existing profile information, click Yes.

AOL Communicator can detect that an upgrade is available and ask you whether 
to download it. If you see such a message, click Upgrade Now to download the 
software.

If you are updating a beta release older than AOL Communicator Preview Release, 
follow these steps to update it with AOL Communicator while preserving your 
Address Book entries and local mail:

1. Close every AOL Communicator window.

2. Open the My Computer icon on your desktop and navigate to the Application 
Data directory for your system user profile:

Windows 2000/XP: C:\Documents and Settings\Windows_Profile_Name\
Application Data\

Windows 98, single user: C:\Windows\Application Data\

Windows 98, multiple users: C:\Windows\Profiles\ 
Windows_Profile_Name\Application Data\

Note: If you cannot see the Application Data directory inside your profile 
directory, open the Tools menu, choose Folder Options, click the View tab, and 
select the option labeled “Show hidden files and folders”.

3. Inside the Application Data directory, open the directory AOL 
Communicator, which contains your user profile information (such as account 
settings and preferences).

4. Inside the directory AOL Communicator, find the local and pop directories, 
and drag them out onto your desktop or any other convenient location.

5. Click the Start Menu, choose Programs, then AOL Communicator, then Tools, 
then Uninstall AOL Communicator.

When asked whether you want to delete your previous user profile for AOL 
Communicator, click Yes.
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6. Open this directory on your computer: C:\Program Files\

7. If the directory AOL Communicator is still present inside the Program Files 
directory, delete it.

If you see a message saying that it can’t be deleted, go on to the next step.

8. Download and install the software as described in “Running the Setup 
Program” (page 8). 

9. Use the Account Wizard to set up your mail accounts again (as you did for the 
previous release).

10. Close every AOL Communicator window.

11. Inside the directory Application Data, locate the directory AOL 
Communicator (the location of the new user profile you just created).

12. Inside the AOL Communicator directory, delete these directories: 
local, pop, mcache, scache.

13. Move your old local and pop directories (which you moved in Step 4) into the 
directory AOL Communicator. 

14. Double-click the AOL Communicator icon on the desktop, or open the Start 
menu and choose Programs, then AOL Communicator, then AOL 
Communicator.

15. When the AOL Communicator Mail window opens, click the Local Mail folder, 
open the File menu, and choose Refresh Folder List. Then select each top-level 
POP account folder and refresh it in the same manner.

All the Local Mail folders from your old profile should now be present, as well 
as any local POP mail you may have stored for your POP accounts.

The procedure described above is the most reliable way to install AOL 
Communicator and preserve local mail information. If you run into problems after 
installation, follow Steps 3 through 15 again.

Upgrading without creating a new user profile: Not recommended for this 
release. If you are updating a previous installation and you attempt to retain all 
your old user profile information rather than creating a new profile as described 
above, Communicator Mail opens without first launching the Account Setup 
Wizard. Your original accounts will all be preserved, but you may run into 
problems.
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Changing Your Regional Options
New versions of AOL Communicator will soon be available in other languages. To 
display buttons, menus, Help, and other elements of the software correctly in a 
given language, you must do two things:

• Download and install the version of AOL Communicator for the language you 
want to use.

• Make sure your Regional Options have been configured correctly for that 
language.

To change your Regional Options for Windows 2000:

1. Click the Start Menu and choose Settings, then Control Panel, then Regional 
Options.

2. Under Language settings for the system:

Make sure the writing system for the language you want to use has a 
checkmark beside it.

Click Set Default, choose the appropriate locale for the language you want to 
use (for example, Japanese if you are trying to use Japanese), and click OK.

Click Apply. If the files required for your selection aren’t available on your 
hard disk, you’ll be asked to insert the Windows CD so that the system can 
copy them to your computer. You may also be asked to restart your computer.

3. Under Settings for the current user, choose the name of the language you 
want to use from the drop-down list.

4. Click OK.

To change your Regional Options for Windows XP:

Note: These instructions assume you are using the default Windows XP control 
panel interface—not the “classic” interface.

1. Click the Start Menu and choose Settings, then Control Panel.

2. Click Date, Time, Language and Regional Options.

3. Under Pick a Control Panel icon, click Regional and Language Options. 

4. Click the Advanced tab.

5. Under Language for non-Unicode programs, select the language you want to 
use from the drop-down list. 
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6. Select the checkbox near the bottom labeled “Apply all settings to the current 
user account and to the default user profile.”

If the language you want isn’t available: If you can’t see the language you 
want, you may need to install supplemental language files:

a. Click the Languages tab.

b. Select the appropriate checkbox under “Supplemental Language Support.” 

c. Click Apply.

If the files required for your selection aren’t available on your hard disk, you’ll 
be asked to insert the Windows CD so that the system can copy them to your 
computer. You may also be asked to restart your computer.

After you install the files, be sure to open the Regional and Language Options 
control panel again and change the settings in the Advanced tab as described 
above.

7. In the Regional and Language Options control panel, click the Regional 
Options tab. Select the language you want to use from the drop-down list 
under Standards and Formats. 

8. Click OK.

When you’re finished adjusting your Regional Options, launch the version of AOL 
Communicator that supports the language you just set up. The interface should be 
displayed in the correct language.
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